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1.  Before you start
1.1.   Which documentation comes along with your software?

1. Before you start
1.1. Which documentation comes along with your software?

The documentation for your software consists of several parts: the installationmanual,
the online help, and PDFmanuals which were installed together with your software.

Where do you find which information?
A quick setup guide describing the software activation is delivered with your software.

On the setup-DVD, several PDFmanuals are provided.

l In the installationmanual, you can find the system requirements. Additionally, you
can find out how to install and configure your software.

l In the user manual, you will find both an introduction to the product and an
explanation of the user interface. By using the extensive step-by-step instructions
you can quickly learn themost important procedures for using this software.

l The database is explained in its own user manual.

In the online help, you can find detailed help for all elements of your software. An
individual help topic is available for every command, every toolbar, every tool window
and every dialog box.

New users are advised to use themanual to introduce themselves to the product and
to use the online help for more detailed questions at a later date.

Writing convention used in the documentation
In this documentation, the term "your software" will be used for OLYMPUS Stream.

00018

Example images
TheDVD that comeswith your software contains, among a lot of other data, also
images that show different examples of use for your software. You can load these so-
called example images from the DVD. However, in many cases, installing the example
images on your local hard disk or on a network drive ismore helpful. Then the example
imageswill always be available, nomatter where the DVD with the software currently
is.

Note: Your software's user documentation often refers to these example images. You
can directly follow some step-by-step instructionswhen you load the corresponding
example image.

You can open and view the example imageswith your software. Additionally, you can
use the example images to test some of your software's functions, for example, the
automatic image analysis, the image processing or the report creation.

Due to the fact that the example images also contain multi-dimensional images like Z-
stacks or time stacks, making use of them enables you to quickly load images that
requiremore complex acquisition settings.

OLYMPUS Stream UserManual 6
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1.1.   Which documentation comes along with your software?

Installing example images
You can install the example images after you've installed the software, or at any later
point in time.

To do so, insert the DVD that contains the software into the DVD drive. If the
installation wizard starts, browse to the directory that contains the example images
and install them.

07005 04072013
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1.  Before you start
1.2.   Online help for your software

1.2. Online help for your software
In the online help, you can find detailed help for all elements of your software. An
individual help topic is available for every command, every toolbar, every tool window
and every dialog box.

When you use the helpmode, you'll have access tomost online topics. As soon as you
use the context help, you will find yourself in the helpmode. In the helpmode, a
questionmark will be attached to themouse pointer. Then you will be able to call for
help on almost all of your software's functions.

Switching to the help mode
There are variousways of switching to the helpmode.

l Click theContext Help button. You can find this button on theStandard toolbar.
l Use theHelp > Context Helpmenu command.
l Use the [Shift + F1] shortcut.

00087

1.3. About your software
Note: Not every software package contains all of the features!

To support the different requirements on the software optimally, a variety of packages
are available for your software. The larger software packages contain more features
than the smaller packages. For example, the smaller packages contain only restricted
database functionality.
Some of the functions described are, therefore, of no relevance to users of smaller
packages.

Acquiring images
You can use your system to acquire high resolution images of a sample in a few steps.
Your system is comprised of your software and the hardware, e.g., microscope and
camera. During image acquisition, the data from the camera which ismounted on your
microscope will be read out and displayed on your computer'smonitor.

You can first examine the live-image and adjust it optimally. The live-image will be
constantly updated, i.e., when you, for example, move the stage to a different position,
the live-image will be changed accordingly. You can switch the live-image on and off
and acquire a photo of the parts of the sample that interest you.When you do this, you
will create a digital image that you can save and process or analyze with a variety of
your software's functions.

Acquiring and viewing multi-dimensional images
Amulti-dimensional image is alwaysmade up of several frames. These have, for
example, been acquired at different times, or in different focus positions. With your
software you can, e.g., acquire a time stack or a Z-stack. For optimum viewing of multi-
dimensional images, use the separate navigation bar that is shown directly in the
image window when amulti-dimensional image is loaded.

OLYMPUS Stream UserManual 8
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Acquiring an EFI image
With your software, you can acquire imageswhich have a practically unlimited depth
of focus. These images are called EFI images. EFI is the abbreviation for "Extended
Focal Imaging". For the creation of an EFI image, the software determineswhich of
the pixels from the differently focused frames in a Z-stack are the sharpest, and
calculates an image that is sharply focused in all areas from them.

Acquiring stitched images
When your system is equipped with amotorized XY-stage: Use theXY-Positions/MIA
acquisition process to acquire a stitched image of a larger part of the sample. MIA
stands for Multiple Image Alignment. During the acquisition, this acquisition process
directly combines all of the images that are acquired, into a stitched image, just like a
puzzle.

When your system is not equipped with amotorized XY-stage: Use theManual MIA
acquisition process andmanuallymove the stage to have the different, adjoining parts
of the sample put on display one after the other. By using this acquisition process
directly during the acquisition, you combine all of the images that are acquired into a
stitched image, just like a puzzle.

Saving documents in a database
You can insert not only images, but also documents which have another file format into
a database. That enables you to store all manner of data that belongs together in one
location. Search and filter functionsmake it quick and easy to locate documents.

Imageswill, by default, be saved in the TIF or VSI file format. When you save an
acquired image in TIF format, a lot of important image information will be automatically
saved with it, for example, data concerning the camera used, the exposure time, the
resolution, the time of creation, and so on. You can later view this data again
whenever you want, simply by opening the image with your software. You do not need
to collect this data separately.

A PDFmanual for your database is installed together with your software.

Measuring images
You canmake variousmeasurements on images, and, e.g., measure the length of a
line, the perimeter of an ellipse or an angle in degrees. Themeasurement objects will
be displayed in the image's drawing layer, and can be faded in and out. The
measurement results will be shown in a sheet and can be differently sorted by a click of
your mouse. You can export measurement results, for example, to the XLS format (for
further editing in theMS-Excel application program).

You canmeasure an image, or several images at the same time, according to different
material science analysis processes.
TheMaterials Solutions tool window works similarly to a software wizard. As soon as
you've started an analysis process you'll be guided step by step through the
measurement.
The followingmaterial science analysis processes are available:

l Chart Comparison
l Grains Intercept
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l Grains Planimetric
l Layer Thickness
l Cast Iron
l InclusionsWorst Field
l Inclusion Content
l Throwing Power
l Porosity
l Phase Analysis
l Particle Distribution
l AutomaticMeasurement
l Coating Thickness
l Dendrite ArmSpacing

Processing images
You can process the acquired images and retroactively optimize the image quality
according to your requirements. Numerous filters and functions are available for this
purpose, e.g., various smoothing or sharpness filters, and functions to optimize the
contrast. Aswell as this, you canmirror the images and also rotate them through an
arbitrary number of degrees.

Analyzing images automatically
With an automatic image analysis, your software searches for areas in an image that
have the same intensity, or color. All of the areas that have the same intensity, or color
will be assigned to a phase, and evaluated. Thismakes it possible to automate typical
measurement tasks. You can, for example, determine the area ratios of the different
phases in an image.

Creating reports
You can document the results of your work in a report. To do this, select the required
page templates and images in theReport Composer tool window, for example, and
generate anMS-Word report.

Alternatively, you can create a report in theMS-Excel format straight from your
software, containing the last image to bemeasured and all of themeasurement
results, for example. MS-Excel reports are particularly useful for users who want to
analyze the data andmeasurement results gained in the image analysis program
further in MS-Excel.

In case you want to insert images, workbooks or charts from your software into new or
existingMS-Word, MS-Excel, or MS-PowerPoint documents, use a special Olympus
add-in for this. With the help of this add-in, you can access all documents and data that
you created with your image analysis program fromMS-Word, MS-Excel, or MS-
PowerPoint. You can apply different settings to all the report's images, detail zooms,
for example. It's sufficient for your image analysis program to be open in the
background.

Controlling the microscope
You can control your microscope'smotorized parts via the software. For example, you
can change an objective, load an ND filter, or open and close a shutter, with your
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software. Tomake this communication function, the componentsmust not only be
motorized, but also have been configured in the software.

00017
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2. User interface
1.3.   About your software

2. User interface
The graphical user interface determines your software's appearance. It specifies
whichmenus there are, how the individual functions can be called up, how and where
data, e.g. images, is displayed, andmuchmore. Here, the basic elements of the user
interface are described.

Note: Your software's user interface can be adapted to suit the requirements of
individual users and tasks. You can, e.g., configure the toolbars, create new layouts,
or modify the document group in such a way that several images can be displayed at
the same time.

Appearance of the user interface

The illustration shows the schematic user interface with its basic elements.

(1) Menu bar
(2) Document group
(3) Toolbars
(4) Tool windows
(5) Status bar

(1) Menu bar
You can call upmany commands by using the correspondingmenu. Your software's
menu bar can be configured to suit your requirements. Use the Tools > Customization
> Start CustomizeMode... command to addmenus, modify, or delete them.

(2) Document group
The document group contains all loaded documents. These can be of all supported
document types.
When you start your software, the document group is empty. While you use your
software it gets filled - e.g., when you load or acquire images, or perform various
image processing operations to change the source image and create a new one.

OLYMPUS Stream UserManual 12
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2.1.   Overview - Layouts

(3) Toolbars
Commands you use frequently are linked to a button providing you with quick and easy
access to these functions. Please note, that there aremany functionswhich are only
accessible via a toolbar, e.g., the drawing functions required for annotating an image.
Use the Tools > Customization > Start CustomizeMode... command tomodify a
toolbar's appearance to suit your requirements.

(4) Tool windows
Tool windows combine functions into groups. Thesemay be very different functions.
For example, in theProperties tool window, you can find all the information available
on the active document.

In contrast to dialog boxes, tool windows remain visible on the user interface as long
as they are switched on. That gives you access to the settings in the tool windows at all
times.

(5) Status bar
The status bar shows, e.g., a brief description of each function. Simplymove the
mouse pointer over the command or button for this information.
You can also find additional information in the status bar.

00108

2.1. Overview - Layouts

What is a layout?
Your software's user interface is to a great extent configurable, so that it can easily be
adapted tomeet the requirements of individual users or of different tasks. You can
define a so-called "layout" that is suitable for the task on hand. A "layout" is an
arrangement of the control elements on your monitor that is optimal for the task on
hand. In any layout, only the software functions that are important in respect to this
layout will be available.

Example: TheCamera Control tool window is only of importance when you acquire
images.When instead of that, you want to measure images, you don't need that tool
window.
That's why the “Acquisition” layout contains theCamera Control tool window,
whereas in the “Processing” layout it's hidden.

OLYMPUS Stream UserManual 13
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2.1.   Overview - Layouts

Which elements of the user interface belong to the layout?

The illustration shows you the elements of the user interface that belong to the layout.
The layout saves the element's size and position, regardless of whether they have
been shown or hidden.When, for example, you have brought theWindows toolbar
into a layout, it will only be available for this one layout.

(1) Toolbars
(2) Tool windows
(3) Status bar
(4) Menu bar

Switching to a layout
To switch backwards and forwards between different layouts, click on the right-hand
side in themenu bar on the name of the layout you want, or use theView > Layout
command.

Which predefined layouts are there?
For important tasks several layouts have already been defined. The following layouts
are available:

Working with a database ("Database" layout )
Acquiring images ("Acquisition" layout)
Viewing and processing images ("Processing" layout)
Generating a report ("Reporting" layout )
Analyzing images using deep learning (layout "Deep Learning")

In contrast to your own layouts, predefined layouts can't be deleted. Therefore, you
can always restore a predefined layout back to its originally defined form. To do this,
select the predefined layout, and use theView > Layout > Reset Current Layout
command.

00013 25022021
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2. User interface
2.2.   Document group

2.2. Document group
The document group contains all loaded documents. As a rule, imageswill be loaded.
You can also find other types of documents in the document group, charts for
example.

Appearance of the document group

(1) Document group in the user interface
(2) Document bar in the document group
(3) Buttons in the document bar
(4) Toolbar in the image window

(1) Document group in the user interface
Youwill find the document group in themiddle of the user interface. In it you will find all
of the documents that have been loaded, and of course also all of the images that have
been acquired. The live-image and the images resulting from any image processing
function are also displayed there.

Note: At the same time, up to 150 documents can be loaded in the document group.

(2) Document bar in the document group
The document bar is the document group's header.

For every loaded document, an individual tab showing the document namewill be set
up in the document group. Click the name of a document in the document bar to have
this document displayed in the document group. The name of the active document will
be shown in color. Each type of document is identified by its own icon.

At the top right of each tab, a small [ x ] button is located. Click the button with the cross
to close the document. If it has not yet been saved, theUnsaved Documents dialog
boxwill open. You can then decide whether or not you still need the data.

(3) Buttons in the document bar
The document bar contains several buttons, on the left and on the right.

OLYMPUS Stream UserManual 15
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2.2.   Document group

Hand button
Click the button with a hand on it to extract the document group from the user
interface. In this way you will create a document window that you can freely position or
change in size.

If you would like tomerge two document groups, click the button with the hand in one
of the two document groups.With the left mouse button depressed, drag the
document group with all the files loaded in it, onto an existing one.

Prerequisite: You can only position document groups as you wish when you are in the
expert mode. In standardmode the button with the hand is not available.

Arrow buttons
You can find two arrow buttons at the top left and the top right of the document group.

When your software starts, the arrow buttons are inactive. The arrow buttonswill only
become active when you have loaded somany documents that all of their names can
no longer be displayed in the document group.

If you have loaded somany images that all of their names can no longer be displayed
in the document group, click one of the two arrows. This scrolls the fields with the
document names to the left or to the right. That will enable you to see the documents
that were previously not shown.

List of loaded documents
Click the small arrow on the right to open a list of all of the loaded documents. If you
are usingmore than one document group, the loaded documents are sorted by
document group. A horizontal line divides the document groups from each other.

Left click the document that you want to have displayed on your monitor.

Alternatively, you can use theDocuments tool window or theGallery tool window to
get an overview of the documents that have been loaded.

(4) Toolbar in the image window

Navigation bar in the image window
Multi-dimensional images, time stacks for example, have their own navigation bar
directly in the image window. Use this navigation bar to set or to change how amulti-
dimensional image is to be displayed on your monitor.

There are some other document typeswith their own navigation bar directly in the
image window. One example is a report instruction.

Selecting image window views
There can bemore than one view for the same image. For example, with an image
series you can display in the image window either an individual image or an overview
of all of the individual images. There is amenuwith all of the image window view
options for the active image on the image window’s toolbar.

00139
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2.3. Tool Windows

What is a tool window?
Tool windows combine functions into groups. Thesemay be very different functions.
For example, in theProperties tool window, you can find all the information available
on the active document.

In contrast to dialog boxes, tool windows keep visible on the user interface as long as
they are switched on. That gives you access to the settings in the tool windows at all
times.

Showing and hiding tool windows
Which tool windows are shown by default depends on the layout you have chosen.
You can, at any time, make specific tool windows appear and disappear manually. To
do so, use theView > ToolWindows command.

Position of the tool windows
The user interface is to a large degree configurable. For this reason, tool windows can
be docked, freely positioned, or integrated in document groups.

Docked tool windows
Tool windows can be docked to the left or right of the document window, or below it.
To save space, several tool windowsmay lie on top of each other. They are then
arranged as tabs. In this case, activate the required tool window by clicking the title of
the corresponding tab below the window.

Freely positioned tool windows
You can only position tool windows as you wish when you are in the expert mode.

You can at any time float a tool window. The tool window then behaves exactly the
way a dialog box does. To release a tool window from its docked position, click on its
header with your left mouse button. Then, while pressing the left mouse button, drag
the tool window to wherever you want it.

Saving the tool window's position
Tool windows and their positions are saved together with the layout and are available
at the same position the next time you start your software. A return to the original
layout using theView > Layout > Reset Current Layout commandwill have the result
that only the tool windows that are defined by default for this layout will be displayed.

OLYMPUS Stream UserManual 17



2. User interface
2.3.   ToolWindows

Buttons in the header
In the header of every tool window, you will find the three buttonsHelp, Enable Auto
Hide, andClose.

Click theHelp button to open the online help for the tool window.
Click theEnable Auto Hide button tominimize the tool window.
Click theClose button to hide the tool window. You canmake it reappear at any time,
for example, with theView > ToolWindows command.

Context menu of the header
To open a context menu, right click a tool window's header. The context menu can
contain theAuto Hide and Transparency commands.

Additionally, the context menu contains a list of all of the tool windows that are
available. Every tool window is identified by its own icon. The icons of the currently
displayed tool windowswill appear clicked. You can recognize this status by the icon's
background color.
Use this list to make tool windows appear.

00037
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2.4. Working with documents
You can choose from a number of possibilities when you want to open, save, or close
documents. As a rule, these documents will be images. In addition, your software
supports other document types aswell.

Saving documents
You should always save important documents immediately following their acquisition.
You can recognize documents that have not been saved by the star icon after the
document's name.

There are a number of ways in which you can save documents.

1. To save a single document, activate the document in the document group. Then
use the File > Save As... command or press [Ctrl + S] on your keyboard.

2. Use theDocuments tool window.
Select the desired document and use theSave command in the context menu.
For the selection of documents, the standardMS-Windows conventions for
multiple selection are valid.

3. Use theGallery tool window.
Select the desired document and use theSave command in the context menu.
For the selection of documents, the standardMS-Windows conventions for
multiple selection are valid.

4. Save your documents in a database. That enables you to store all manner of data
that belongs together in one location. Search and filter functionsmake it quick and
easy to locate saved documents.

Automatic save
1. When you exit your software, all data that has not yet been saved will be listed in

theUnsaved Documents dialog box. This gives you the chance to decide which
document you still want to save.

2. You can also configure your software in such a way that all images are saved
automatically after image acquisition. To do so, use theAcquisition Settings >
Saving dialog box.
Here, you can also configure your software in such a way that all images are
automatically saved in a database after the image acquisition.

Closing documents
There are a number of ways in which you can close documents.

1. Use theDocuments tool window.
Select the document you want and use theClose command in the context menu.
For the selection of documents, the standardMS-Windows conventions for
multiple selection are valid.
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2. To close a single document, activate the document in the document group and
use the File > Close command. Alternatively, you can click the button with the
cross [ x ]. You can find this button at the top right of the document tab next to the
document name.

3. Use theGallery tool window.
Select the document you want and use theClose command in the context menu.
For the selection of documents, the standardMS-Windows conventions for
multiple selection are valid.

Closing all documents
To close all loaded documents use theClose All command or press [Ctrl + Alt + W] on
your keyboard. You will find this command in the Filemenu, and in both the
Documents and theGallery tool windows' context menu.

Closing a document immediately
To close a document immediately without a query, close it with the [Shift] key
depressed. Data you have not saved will be lost.

Opening documents
There are a number of ways in which you can open or load documents.

1. Use the File > Open... command.
2. Use the File Explorer tool window.

To load a single image, double click on the image file in the File Explorer tool
window.
To load several images simultaneously, select the images and with the left mouse
button depressed, drag them into the document group. For the selection of
images the standardMS-Windows conventions for multiple selection are valid.

3. Drag the document you want, directly out of theMS-WindowsExplorer, onto your
software's document group.

4. To load documents from a database into the document group, use theDatabase >
Load Documents... command.

Note: At the same time, up to 150 documents can be loaded in the document group.

Generating a test image
If you want to get used to your software, then sometimes any image suffices to try out
a function.
Press [Ctrl + Shift + Alt + T] to generate a color test image.
With the [Ctrl + Alt + T] shortcut, you can generate a test image that ismade up of 256
gray values.

Activating documents in the document group
There are several ways to activate one of the documents that has been loaded into the
document group and thus display it on your monitor.

1. Use theDocuments tool window. Click the desired document there.
2. Use theGallery tool window. Click the desired document there.
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3. Click the title of the desired document in the document group.

4. Click the small arrow at the top right of the document group to open a list of all
of the loaded documents. Left click the document that you want to have displayed
on your monitor.

5. In theWindowmenu, you will find a list of all of the documents that have been
loaded. Select the document you want from this list.

Document group and database
Please note that in theDatabase layout the document group will not be shown. Select
one of the other layouts, e.g., theProcessing layout, to have the document group
displayed.

Attaching a document to an e-mail
1. Load the documents you want to attach to your e-mail.
2. Use the File > Send E-mail... command.
3. Checkwhether all documents you want to attach are selected.
4. Click theSend button to generate an e-mail with the selected documents included

as attachments.
l Youwill receive a warningmessage if the sum of file sizes of all documents
exceeds themaximumpermitted size.

l A new e-mail formwill be opened by your e-mail program. Your e-mail program
does not have to be already running for this to happen. The e-mail contains all
of the selected image and document files as attachments.
As long as the e-mail form remains open, you cannot use your software or your
e-mail program. The e-mail form cannot beminimized, no can other e-mails be
generated, nor can you read any incoming e-mails. You can't close theSend E-
mail dialog box nor continue working.

5. Enter the recipient’s address and your message and then send off your e-mail.
00143 15022016
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3. System configuration
3.1. Overview - System Configuration

Why do you have to configure the system?
After successfully installing your software you will need to first configure your image
analysis system, then calibrate it. Only when you have done this will you havemade
the preparations that are necessary to ensure that you will be able to acquire high
quality images that are correctly calibrated.When you work with amotorized
microscope, you will also need to configure the existing hardware, to enable the
program to control themotorized parts of your microscope.

3.1.1. Process flow of the configuration
To set up your system, the following steps are necessary:

Specifying which hardware is available

Configuring the interfaces

Configuring the specified hardware

Calibrating the system

Creating a system restore point

Specifying which hardware is available
Your software has to know which hardware components your microscope is equipped
with. Only these hardware components can be configured and subsequently
controlled by the software. In theAcquire > Devices > Device List dialog box, you
select the hardware components that are available on your microscope.

Configuring the interfaces
Use theAcquire > Devices > Interfaces command to configure the interfaces between
your microscope or other motorized components, and the PC onwhich your software
runs. Normally, the interfaceswill automatically be configured properly.

Configuring the specified hardware
Usually, various different devices, such as a camera, amicroscope and/or a stage will
belong to your system. Use theAcquire > Devices > Device Settings... dialog box to
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configure the connected devices so that they can be correctly actuated by your
software.

Additionally, you can find all camera settings in theDevice Settings dialog box.

Calibrating the system
When all of the hardware components have been registered with your software and
have been configured, the functioning of the system is already ensured. However, it's
only really easy to work with the system and to acquire top quality images, when you
have calibrated your software. The detailed information that helps you tomake optimal
acquisitionswill then be available.

Your software offers a wizard that will help you while you go through the individual
calibration processes. Use theAcquire > Calibrations... command to start the software
wizard.

Creating a system restore point
Use theCreate SystemRestore Point... function to create a restore point for your
system. Configurations that were applied to the image analysis system are saved in a
system restore point. You can find the command in theAcquire > Devices > Create
SystemRestore Point...menu.

3.1.2. About the system configuration

When do you have to configure the system?
Youwill only need to completely configure and calibrate your system anew when you
have installed the software on your PC for the first time, and then start it. When you
later change the way your microscope is equipped, you will only need to change the
configuration of certain hardware components, and possibly also recalibrate them.

Necessary user rights for the system configuration
To be able to configure the system, you have to be logged in to your software with
administrator or power user rights. If you have installed the software yourself you will
automatically have been assigned Administrator rights.

In contrast, other users that also want to work with the software are given theUser
role. With this user role, the system configuration cannot be changed or viewed, i.e.,
theDevice List andDevice Settings dialog boxes cannot be opened.

For this reason, the software administrator has to assign the necessary user rights to
those users who did not themselves install the software, but who are to be allowed to
view or change the system configuration. Start the software as administrator and
select the Tools > User Rights... command to open theUser Rights dialog box. In it,
select the required user, then click theProperties... button.

00159

3.2. Configuring the system
In order to acquire correctly calibrated images, the software requires information
about your camera, the objectives and themicroscope camera adaptor's
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magnification. Set up your systemwith this in mind.

Preconditions
Your software is installed and the camera is connected to your PC. The camera driver
is installed in MS-Windows.

Specifying which hardware is available
1. Start your software.

Setting up a new hardware configuration
2. Use theAcquire > Devices > Device List... command.
3. Click theCreate New Device Configuration button.

l TheCreate New Device Configuration dialog box opens.

4. Enter a name for the new hardware configuration in theName field. It is a good
idea to choose a name combining themicroscope and camera names, for
example BX51_DP26.
l Under this name, you can later reload this hardware configuration in theDevice
Settings dialog box.

5. Select theCopy current device configuration option if you have previously chosen
your camera andmicroscope. Otherwise, choose theEmpty device configuration
option.

6. Close theCreate New Device Configuration dialog boxwithOK to return to the
Device List dialog box.
l Youwill then find the new hardware configuration entered in theConfiguration
field.

l Once you have completely set up a new hardware configuration, all entries
from theDevice Listwill be empty. You can now enter a completely new
definition for the hardware configuration.

Defining the hardware configuration
Define the new hardware configuration in theDevice List dialog box. Begin with the
specifications for the camera and themicroscope.

7. Select your camera (e.g. DP26) from theCamera 1 list.
8. Select your microscope (e.g. BX51) from the Frame list. If your microscope isn't

listed, select theManual Microscope entry.
l Once you have chosen amicroscope, the options in theDevice List dialog box
change. For somemicroscopes there are default settings.

Examples of default settings:

l For themanual microscope BX51, theManual Nosepiece entry from the
Nosepiece list is preset.

l For themanual stereomicroscope SZX10, theManual Nosepiece andManual
Zoom / Magnification Changer entries are preset.

9. For somemicroscopes, you need to choose the port on which your camera is
mounted (e.g.Side (left)). You find the list to the right of the camera list.
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10. All other settings, such as nosepiece, observation filter wheel, shutter and
condensor are appropriately preset, independent of your microscope. Check your
settings and, if necessary, adjust them to suit your microscope equipment.

Initializing your devices
11. Close theDevice List dialog boxwithOK.

l Your hardware configuration will be automatically saved.

l You can return to the default configuration whenever you want to. To do so,
use theAcquire > Devices > Device Settings... command. Select theDefault
entry in theConfiguration list.

l As soon as you close theDevice List dialog box, your software will try to set up
the connection to the specified devices. You can see whether the devices can
be successfully controlled in theAcquire > Devices > Device Settings device
box.

Configuring the specified hardware
1. Use theAcquire > Devices > Device Settings... command.

l In the tree view on the left side, you can find all hardware components that you
have chosen in the device list.

2. Select the Lightpath entry in theSort by list.

Configuring your camera
3. In the tree view on the left-hand side, expand theCamera > <camera name>

entry (e.g. DP26).
4. Select theCamera Adapter entry.
5. Select your camera adapter'smagnification on the right-hand side of the

Magnification list. Themagnification is imprinted on your camera adapter.
Common values are 1.00 or 0.63.

Configuring the objective nosepiece
6. In the tree view, select theGeneral > Manual Nosepiece entry if you have a

manual microscope.
In the tree view, select theGeneral > <Name of nosepiece> entry if you have a
motorizedmicroscope.
l On the right hand side of the dialog box, the current configuration of the
nosepiece will be displayed.When you configure the software for the first time,
the fields for the details referring to your objectiveswill be empty.

7. Choose the objectiveswhich are currently fitted to the nosepiece from the right-
hand side of theMagnification lists. Start with the smallest magnification and
increase up through the higher magnifications. You can read themagnification off
of the objective.

8. Choose each corresponding objective from theObjective Type list. The type is
written on the objective.
l In theDescription field, a description of the objective will be suggested. You
may change the description of the objective in theDescription field, if you wish.
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9. If the objectives don't use air as their refractionmedium, select the immersion
medium from theRefraction Index list. In this case, you find an appropriate label
on the objective.

Configuring the mirror turret
10. Select theGeneral > <Name of themirror turret> entry in the tree view.
11. Make a selection for every position, whether it is occupied or not. For occupied

positions, either select a filter or fluorescence cube being used from the Filter list,
or enter the name of your filter module.

12. Select the Free entry for positions that have been purposely left free to keep the
light path free of optical elements.
For example, where themirror turret is concerned, it is especially important that
one position is kept free, in order not to impede the light path for the transmitted
light microscopy.

Finishing system configuration
13. Close theDevice Settings dialog boxwithOK.

l In certain cases, amessage appears telling you to check the calibrations. You
can perform calibration now or later.

14. To have this toolbar displayed, use theView > Toolbars > Microscope Control
command.
l TheMicroscope Control toolbar contains buttonswith all of your objectiveswith
correct color codes.

l For stereomicroscopes or invertedmicroscopes, you find the zoom factors in
the list to the right of the objectives.

Note: Use theCreate SystemRestore Point... function to create a restore point for
your system. Configurations that were applied to the image analysis system are saved
in a system restore point. You can find the command in theAcquire > Devices >
Create SystemRestore Point...menu.
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4. Image Acquisition
4.1. Overview - Acquisition processes

Your software offers a wide range of different acquisition processes.

4.1.1. Basic acquisition processes
Use theCamera Control tool window to acquire images andmovies.

Acquisition process - Snapshot

You can use your software to acquire high resolution images in a very short period of
time.

Acquisition process - Movie

You can use your software to record amovie. When you do this, your camera will
acquire asmany images as it can within an arbitrary period of time. Themovie can be
saved as a file in the AVI or VSI format. You can use your software to play it back.

4.1.2. Complex acquisition processes
Use theProcessManager tool window to handle complex acquisition processes.

Acquisition process - Time Lapse

With the automatic acquisition processTime Lapse you acquire a series of frames one
after the other. This series of individual imagesmakes up a time stack. A time stack
shows you how an area of a sample changeswith time. You can play back a time stack
just as you do amovie.

If your microscope stage is equipped with amotorized Z-drive, when you acquire a
time stack you can use the autofocus. You can find a description of the individual
settings along with the description of the acquisition process.

Acquisition process - Z-stack

Use the automatic acquisition processZ-Stack to acquire a Z-stack. A Z-stack
contains frames acquired at different focus positions. That is to say, themicroscope
stage was located in a different Z-position for the acquisition of each frame.

Alternatively, you can also acquire an EFI image with the Z-Stack acquisition process.
Then a resulting image (EFI image) with a practically unlimited depth of focus is
automatically calculated from the Z-stack that has been acquired. Such an image is
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focused throughout all of its segments. EFI is the abbreviation for Extended Focal
Imaging.

Acquisition process - XY-Positions/MIA

You can only use this acquisition processwhen your microscope is equipped with a
motorized XY-stage.With this acquisition process you can carry out one or more
automatic acquisition processes at different positions on the sample or acquire a
stitched image of a larger sample position.

If your microscope stage is equipped with amotorized Z-drive, you can use the
autofocus for this acquisition process. You can find a description of the individual
settings along with the description of the acquisition process.

Acquisition process - Instant EFI

Use themanual acquisition process Instant EFI to acquire an EFI image at the
camera's current position that is sharply focused all over.

Acquisition process - Manual MIA

When you use theManual MIA acquisition process, youmove the stagemanually in
such a way that different, adjoining sample areas are shown. Every time you click one
of the buttonswith an arrow, an image is acquired.With this acquisition process, you
combine all of the images that are acquired, directly during the acquisition, just like a
puzzle, into a stitched image. The stitched image will display a large sample segment
in a higher X/Y-resolution than would be possible with a single acquisition.

Acquisition process - Instant MIA

For the Instant MIA acquisition process, you slowlymove the stagemanually over all of
the positions on the sample that you want to acquire for theMIA image. Your software
acquires images continuously and automatically assembles them. You just have to
start the acquisition process, the acquisition of the individual images takes place
automatically as youmove the stage.

Acquisition process - MIX Light Source

With theMIX Light Source automatic acquisition process, you acquire a time stack
where every frame shows the sample with different LEDs of theMIX light source
switched on. Therefore, the light hits the sample from different angles and the sample
can be illuminated from a 360° angle.

TheMIX light source is a hardware component that is only available for certain
microscopes (BX53M family, GX53, MX63, MX63L). This is why theMIX Light Source
acquisition process is deactivated if you are using a different microscope or if theMIX
light source wasn't selected in themicroscope's device configuration.
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Acquisition process - VisiLED MC 1500

With theVisiLED MC 1500 automatic acquisition process, you acquire a time stack
where every frame shows the sample with different LEDs of the VisiLED MC 1500
ring illumination. Therefore, the light hits the sample from different angles and the
sample can be illuminated from a 360° angle.

The VisiLED MC 1500 is an optional hardware component for stereomicroscopes (for
example, SZX 7). This is why theVisiLED MC 1500 acquisition process is deactivated
if you are using a different microscope or if theVisiLED MC 1500 light source wasn't
selected in themicroscope's device configuration.

4.1.3. Combination of several acquisition processes
You can combine several automatic acquisition processes. To do so, click the
corresponding button for each acquisition process you require.

Note: Which automatic acquisition processes you can combine with each other,
depends on your software.

Note: In the smaller software packages, the automated acquisition processes are only
available when theAutomation software solution is active.

When you combine the two acquisition processesZ-Stack andXY-Positions/MIA to
acquire a Z-stack at several positions on your sample, to begin with, the complete Z-
stack at the first position will be acquired.When that has been done, your systemwill
move to the next position, and will acquire the next Z-stack etc...
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4.2. Acquiring a snapshot
You can use your software to acquire high resolution images in a very short period of
time. For your first acquisition you should carry out these instructions step for step.
Then, when you later make other acquisitions, you will notice that for similar types of
samplemany of the settings youmade for the first acquisition can be adopted without
change.

1. Switch to theAcquisition layout. To do this, use, e.g., theView > Layout >
Acquisition command.
l You can find theMicroscope Control (1) toolbar at the upper edge of the user
interface, right below themenu bar.
To the right of the document group, you can find theCamera Control (2) tool
window.

Selecting an objective
2. On theMicroscope Control toolbar, click the button with the objective that you use

for the image acquisition.

Switching on the live-image
3. In theCamera Control tool window, click the Live button.

l The live-image (3) will now be shown in the document group. A new image
document will automatically be created for the live-image.

4. Go to the required position on the sample.

Setting the image quality
5. Bring the sample into focus. The Focus Indicator toolbar is there for you to use

when you are focusing on your sample.
Note: For some cameras, the Focus Peaking function is available to help you to focus
on your sample.
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6. Check the color reproduction. If necessary, carry out a white balance.
7. Check the exposure time. You can either use the automatic exposure time

function, or enter the exposure timemanually.
8. Select the resolution you want.

Acquiring and saving an image
9. In theCamera Control tool window, click theSnapshot button.

l The acquired image will be shown in the document group.

10. Use the File > Save As... command to save the image. Use the recommended TIF
or VSI file format.
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4.3. Acquiring HDR images

4.3.1. Overview - HDR images

What are HDR images?
Under themicroscope, certain samples (with very reflectivemetal surfaces, for
example) can have such strong differences in brightness that it is impossible to find an
exposure time that is suitable for all areas of the sample.

For such samples, an HDR image acquisition is recommended.HDR stands forHigh
DynamicRange. Dynamic range relates to the capacity of cameras, or image
processing software, to display both the bright and the dark segments of an image
well.

Before acquiring an HDR image, the necessary exposure range needs to be
determined for the current sample. The exposure range ismade up of aminimumand
maximumexposure time aswell as several exposure times between them. Several
individual images are then taken of the sample with differing exposure times, so that
no image segment is left over or underexposed.

Your software then detects the best exposed pixels in each acquired individual image
andmerges them into one new image. Under correctly defined acquisition conditions,
the HDR imagewill no longer contain any under or overexposed image segments.

Just like with images acquired with Extended Focal Imaging (EFI image), an HDR
image is a rendered image containing information from several images.
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Here, you can see an image acquired of a very reflectivemetal surface. Example 1
shows an image which was not acquired using HDR. The reflective segments of the
surface are correctly exposed, whereas other segments are completely
underexposed. Example 2 shows an image which was acquired using HDR.Without
overexposing the reflective segments of the surface, now the structures in the dark
image segments, which were not recognizable before, are visible.

Determining the exposure range
A recently determined exposure range will continue to be used for all HDR images
until you let your software determine the exposure range anew. It is irrelevant whether
the exposure range had been determined automatically or manually.

If you are acquiring several images of the same or similar parts of a sample, you don't
need to determine the exposure range each time. If you change the sample or adjust
settings on themicroscope, it is recommended to determine the exposure range anew
(either automatically or manually).

HDR images and acquisition processes
You can also insert an HDR image acquisition into an acquisition process, such as
during the acquisition of a time stack or a Z-stack. TheProcessManager tool window
informs you about the status of the HDR image acquisition. If theEnable HDR check
box is selected in theCamera control tool window, theProcessManager tool window
shows theActive entry in theHDR field. If the check box is deselected, theProcess
Manager tool window showsOff in theHDR field.

HDR images and movie recording
It is not possible to recordmovieswith HDR. Because of this, theEnable HDR check
box is ignored while theMovie recording check box is selected.

07510
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4.3.2. Acquiring an HDR image with an automatically set
exposure range

With this procedure, your software automatically determines the exposure range. To
do so, your camera automatically acquires a set of imageswith various exposure times
andmeasures the amount of over and underexposed pixels. The exposure time
continues to change until the amount of over and underexposed pixels is within
defined limits. At this point, the exposure range has been defined. How much the
exposure time is adjusted by is determined by your software with regards to the
minimumandmaximumexposure time.

Preparations
1. Switch to theAcquisition layout. To do this, use theView > Layout > Acquisition

command, for example.
2. On theMicroscope Control toolbar, click the button with the objective that you

want to use for the acquisition of the HDR image.
3. Switch to the livemode, and select the optimal settings for your acquisition in the

Camera Control tool window. Carry out a white balance. Then select an exposure
timemeaning that no part of the sample is overexposed.
l The automatic exposure time detection uses this value as a basis and raises
the exposure time so as to correctly light even the dark parts of the sample.

4. Search for the part of the sample which you want to acquire an HDR image of.
This should be a position which has such significant differences in brightness that
not all segments can be shownwith optimal lighting.

5. Finish the livemode.

Acquiring HDR image
6. In theCamera Control tool window, select theEnable HDR check box.

l In the upper part of the tool window, theSnapshot button changes to theHDR
button.

l If theEnable Halation Removal button in theHalation Removal group was
switched on, this switches it off automatically. This is because theHDR and
Halation Removal acquisitionmodes can't be used simultaneously.

7. In theDetermine exposure range group, click theAutomatic button to have the
exposure range determined automatically.
l The necessary exposure range will now be determined. To do so, the camera
automatically acquires several imageswhich only differ in exposure time. This
acquisition occurs in the background, whichmeans that the images are not
shown in the document group. The exposure range determined in this waywill
continue to be used for all HDR images until you let your software determine
the exposure range anew.

l Determining the exposure range automatically takes about 30 seconds. Pay
attention to the progress bar located in the status bar. When all elements in the
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tool window are active again, the process has finished. In the Total time field,
you can now see how long is needed for the HDR image acquisition.

l If, in theAcquisition Settings > Acquisition > HDR dialog box, theAutomatic
HDR preview check box is selected, the HDR imagewill be acquired and
shown automatically, once the exposure range has been set.

8. If the HDR image has not been acquired automatically, click theHDR button in the
Camera Control tool window to start the image acquisition.
l The image acquisition will begin. Pay attention to the progress bar located in
the status bar.

It shows how long the acquisition has taken so far and the total acquisition time.
The progress bar contains theCancel button, which you can use to stop the
current image acquisition.

l After the acquisition has been completed the HDR imagewill be shown in the
document group.

9. Check the image. If you want to change the settings (to use a different algorithm
for the output rendering, for example), open theAcquisition Settings dialog box.
Select theAcquisition > HDR entry in the tree view.

10. If you don't want to change any settings, use the File > Save As... command to
save the image. Use the recommended TIF or VSI file format.
l These are the only formats which also save all the image information including
the HDR entries together with the image. Thismeans that you can always see
whether or not an image was acquired using HDR. Open theProperties tool
window, and look at the data in theCamera group.
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4.3.3. Acquiring more HDR images without setting the exposure
range anew

If you have just acquired HDR images of the same or a similar sample, as a rule, it is
not necessary to determine the dynamic range anew. In this case, you have already
completed the preparations for acquisition (such as carrying out a white balance) and
set the HDR image acquisition settings correctly (such as choosing the optimal
algorithm used for output rendering) anyway.

In such circumstances, acquiring an HDR image is especially easy. Do the following:

1. In theCamera Control tool window, select theEnable HDR check box.
2. Click theHDR button in theCamera Control tool window to start the image

acquisition.
l The image acquisition will begin. After the acquisition has been completed the
HDR imagewill be shown in the document group.

3. Check the image before saving it.
l This step can be left out if your software is configured to import images into a
database directly after acquisition.
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4.3.4. LiveHDR
If you are using a DP74 camera, the LiveHDR function is available in addition to the
HDR function. This function displays the live-image as an HDR image. You can
acquire HDR images and HDR movies in thismode.

1. In theDP74 group, select theUse LiveHDR check box.
l This displays the LiveHDR group in theCamera Control tool window instead of
theHDR group.

l Different buttons appear in the LiveHDR group depending on what hardware
your PC is equipped with.

2. Activate liveHDR mode in the LiveHDR group.
If your PC has an NVIDIA graphics card that supports CUDA 2.1 or higher, click
the Fast LiveHDR button or the Fine LiveHDR button.
Click the LiveHDR button if your PC isn’t equipped with the recommended
graphics card.
l The Live button changes to the LiveHDR button.

l TheSnapshot button changes to theHDR button.

l If you select theMovie recording check box, theHDR button is replaced with
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theHDRMovie button.

3. Specify whether to adjust the LiveHDR image automatically or manually.
l TheAutomatic adjustment option automatically adjusts the settings for the
LiveHDR image. This option gives you two settings for optimizing the LiveHDR
mode.
Select theRemove halation option to reduce interference from bright reflected
light, thus increasing the image quality.
Select theEnhance texture option to increase the texture in the sample,
making edges and structuresmore pronounced.

l TheManual adjustment option enables you to use the slide controls to adjust
the LiveHDR imagemanually.

4. Click the LiveHDR button at the top of the tool window to activate the LiveHDR
acquisition.
l The live-image is displayed as a LiveHDR image.

5. Use theHDR button or theHDRMovie button to acquire an HDR image or an
HDR movie.
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4.4. Acquiring an image without halation
Prerequisite: You can only acquire imageswithout halation if your microscope is
equipped with a rotational light source.

An image without halation is a computed image fromwhich overexposure or
reflections, that can be caused when light hits the sample from different angles, have
been removed.

For imageswithout halation, your software acquires a time stack in which every frame
shows the sample with different LEDs of the rotational light source switched on. This
makes the light hit the sample from different angles. Your software then takes certain
pixels of the frames of the time stack and combines them into a new image. The
acquisition of the frames takes place in the background. They are not shown in the
document group and are not saved.

Which pixels in the frames are used depends on the projection that has been selected
for the image without halation. For example, if theminimum intensity projection is
selected, the darkest pixels in each of the frameswill be used.

Rotational light source
Your software supports two different rotational light sources:
TheMIX light source is an optional hardware component that is only available for
certain microscopes (BX53M family, GX53, MX63, MX63L).
TheVisiLED MC 1500 light source is an optional hardware component for stereo
microscopes.
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Acquiring an image without halation
Prerequisite: The following step-by-step instructions describe how to acquire an
image using aMIX light source. Acquiring an image using aVisiLED MC 1500 light
source, works in the sameway.

Preparations
1. Switch to theAcquisition layout. To do this, use theView > Layout > Acquisition

command, for example.
2. On theMicroscope Control toolbar, click the button with the objective that you

want to use for the acquisition of the image without halation.
3. Switch to livemode and select optimal settings for your acquisition, in theCamera

Control tool window. Focus on the sample and, if necessary, perform awhite
balance. Set the exposure time automatically or select a suitable exposure time
manually.

Note: The algorithm that is used to compute an image without halation sometimes
delivers the best results when the image is slightly overexposed.
If this is the case for your samples, set the exposure timemanually to achieve a slight
overexposure. Alternatively, you can have the exposure time be determined
automatically and select a positive value in theExposure compensation list.

4. Finish the livemode.

Acquiring an image without halation
1. In theHalation Removal group, select theEnable Halation Removal check box.

l TheMIX light source is switched on as an additional light source. The setting
for the existing illumination components (the reflected light LED for example) is
not changed.

l If theEnable HDR button in theHDR group was switched on, this switches it
off automatically. This is because theHDR andHalation Removal acquisition
modes can't be used simultaneously.

l The appearance of theAcquire a snapshot without halation button at the top of
the tool window changes.

2. Select whether to switch on 1 or 2 segments in theMIX light source at the same
time (corresponding to 4 or 8 LEDs) for the acquisition of each frame. To do this,
click one of these buttons.

3. Set the brightness of the LEDs of theMIX light source.
l You can adjust the intensity of theMIX light source's LEDs continuously from 0
(no light) to 100% (full light strength). Usually a light intensity of 100%works
well.

4. Select the step size. The step size determines how many new LEDs are used for
the acquisition of the next frame. You can select between the 22.5° and 45°
entries. If you select the 45° entry for example, the LEDs being usedmove on by 2
positions each time a frame is acquired.
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l The selection that youmake affects the number of frames that are acquired
and the time it takes to acquire them. You can't, however, see the number of
acquired images because they aren't shown in the document group.

5. Select the projection that is to be used for computing the image without halation.
l For example, if theminimum intensity projection is selected, the darkest pixels
in each of the frameswill be used.

6. Click theAcquire a snapshot without halation button.
l The acquisition begins. Pay attention to the progress bar that is displayed in the
status bar at the bottom left.

l Your camera now automatically acquires several frames, using different LEDs
of theMIX light source for each one. The acquisition of the frames takes place
in the background. They are not shown in the document group and are not
saved.

l Your microscope's handswitch (the BX3M-HS for example) and the graphical
preview of theMIX light source in theMicroscope Control tool window indicate
which LEDs are currently being used.

l After the acquisition has been completed, the image without halation will be
shown in the document group.

7. Use the File > Save As... command to save the image. Use the recommended TIF
or VSI file format.
l These are the only formats which also save all the image information
concerning halation removal together with the image. This allows you to check
at any time whether theEnable Halation Removal check boxwas selected
when the image was acquired. Open theProperties tool window, and look at
the data in theCamera group.

l If you are using TIF or VSI file format you can also read out the saved
acquisition parameters from the currently selected image and reapply them to
your system. You can use theAcquire > Restore Device Status command to
do this.

8. If you want to copy your settings for the selected segment and for the brightness of
theMIX light source to theMicroscope Control tool window: Click theApply
Settings button.

Note: The step size settings aren't transferred because an image without halation can
only be acquired with two step sizes, (22.5° and 45°) and four step sizes are available
in theMicroscope Control tool window.

l In theMicroscope Control tool window, the same settings for the selected
segment and the brightness of theMIX light source are now selected.

00852

4.5. Acquiring movies and time stacks
With your software you can acquiremovies and time stacks.
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4.5.1. Acquiring a movie
You can use your software to record amovie. When you do this, your camera will
acquire asmany images as it can within an arbitrary period of time.

1. Switch to theAcquisition layout. To do this, use theView > Layout > Acquisition
command, for example.

Setting the magnification
2. On theMicroscope Control toolbar, click the button with the objective that you

want to use for themovie acquisition.

Selecting the storage location
3. In theCamera Control tool window's toolbar, click theAcquisition Settings button.

l TheAcquisition Settings dialog box opens.

4. Select theSaving > Movie entry in the tree structure.
5. You have to decide how amovie is to be saved after the acquisition. Select the

File system entry in theAutomatic save > Destination list to automatically save the
movies you have acquired.
l ThePath field located in theDirectory group shows the directory that will
currently be used when your movies are automatically saved.

6. Click the [...] button next to thePath field to alter the directory.
7. In the File type list, select the file format in which you want to save themovie. You

can save themovie either as a VSI image or as an AVI video. You can select the
AVI Video File (*.avi) entry.

Selecting the compression method
8. Click theOptions... button when you want to compress the AVI file in order to

reduce themovie's file size.
9. Select, for example, theMotion JPEG entry from theEncoder list.

Select theMedium entry in theQuality list.
Close theMovie Options dialog boxwithOK.

Note: Compressing themovie is only possible if the selected compressionmethod
(codec) has already been installed on your PC. If the compressionmethod has not
been installed the AVI file will be saved uncompressed.
The selected compressionmethodmust also be available on the PC that is used for
playing back the AVI. Otherwise the quality of the AVI may be considerably worse
when the AVI is played back.

10. Close theAcquisition Settings dialog boxwithOK.

Setting the image quality
11. Switch to the live-mode and select the optimal settings for movie acquisition in the

Camera Control tool window. Pay special attention to setting the correct exposure
time.
l This exposure time will not be changed during themovie recording. Even if you
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have set the exposure time to automatic, the exposure time won’t be adjusted
while themovie is being recorded.

12. Find the segment of the sample that interests you and focus on it.

Switching to movie recording mode
13. Select theMovie recording check box (1). The check box can be found below the

Live button in theCamera Control tool window.

l TheSnapshot button will be replaced by theMovie button.

Starting movie recording

14. Click theMovie button to start themovie recording.
l The live-image will be shown and the recording of themovie will start
immediately.

l In the status bar a progress indicator is displayed. At the left of the slash the
number of already acquired imageswill be indicated. At the right of the slash an
estimation of themaximumpossible number of imageswill be shown. This
number depends on your camera's image size and cannot exceed 2GB.

l This icon on theMovie button will indicate that amovie is being recorded at
themoment.

Stopping movie recording

15. Click theMovie button again to end themovie recording.
l The first image of themovie will be displayed.

l The navigation bar for time stackswill be shown in the document group. Use
this navigation bar to play themovie.

l The software will remain in themovie recordingmode until you clear theMovie
recording check box.

4.5.2. Acquiring a time stack
In a time stack all frames have been acquired at different points of time.With a time
stack you can document the way the position on the sample changeswith time. To
begin with, for the acquisition of a time stackmake the same settings in theCamera
Control tool window as you do for the acquisition of a snapshot. Additionally, in the
ProcessManager tool window, you have to define the time sequence in which the
images are to be acquired.
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Example: You want to acquire a time stack over a period of 10 seconds. One image is
to be acquired every second.

1. Switch to theAcquisition layout. To do this, use theView > Layout > Acquisition
command, for example.

Setting the magnification
2. On theMicroscope Control toolbar, click the button with the objective that you

want to use for themovie acquisition.
If you are using amagnification changer, you will also have to select the
magnification value used.

Setting the image quality
3. Switch to the livemode, and select the optimal settings for your acquisition, in the

Camera Control tool window. Pay special attention to setting the correct exposure
time. This exposure time will be used for all of the frames in the time stack.

4. Choose the resolution you want for the time stack's frames, from theResolution >
Snapshot/Process list.

5. Find the segment of the sample that interests you and focus on it.

Selecting the acquisition process
6. Activate theProcessManager tool window.
7. Select theAutomatic Processes option.
8. Click the Time Lapse button.

l The button will appear clicked. You can recognize this status by the button's
colored background.

l The [ t ] group will be automatically displayed in the tool window.

9. Should another acquisition process be active, e.g., Z-Stack, click the button to
switch off the acquisition process.
l The group with the various acquisition processes could, for example, now look
like this:

Setting the acquisition parameters
10. Clear the check boxesStart delay andAs fast as possible.
11. Specify the time that the complete acquisition is to take, e.g., 10 seconds. Enter

the value 00000:00:10,000 in theRecording time field, to set the recording time to
10 seconds. You can directly edit every number in the field. To do so, simply click
in front of the number you want to edit.

12. Select the radio button on the right-hand side of theRecording time field to specify
that the acquisition time is no longer to be changed.

l The lock icon will automatically appear beside the selected radio button.
13. Specify how many frames are to be acquired.

Enter e.g., 10 in theCycles field.
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l The Interval field will be updated. It shows you the time that will elapse between
two consecutive frames.

Acquiring a time stack
14. Click theStart button.

l The acquisition of the time stackwill start immediately.

l TheStart button changes into thePause button. A click on this button will
interrupt the acquisition process.

l TheStop button will become active. A click on this button will stop the
acquisition process. The images of the time stack acquired until thismoment
will be preserved.

l At the bottom left, in the status bar, the progress bar will appear. It indicates the
number of images that are still to be acquired.

l The acquisition has been completed when you can see theStart button in the
ProcessManager tool window again, and the progress bar is no longer
displayed.

l Youwill see the time stack you've acquired in the image window. Use the
navigation bar located in the image window to view the time stack.

l By default, the time stack that has been acquired will be saved automatically.
The storage directory is shown in theAcquisition Settings > Saving > Process
Manager dialog box. The preset file format is VSI.

Note: When other programs are running on your PC, for instance a virus scanning
program, it can interfere with the performance when a time stack is being acquired.
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4.5.3. Acquiring a time stack using the MIX light source
acquisition process

Use theMIX Light Source acquisition process to acquire a time stackwhere every
frame shows the sample with different LEDs of theMIX light source switched on. The
light hits the sample from different angles. Thismakes the details of the samplemore
distinct than theywould be if the sample was evenly illuminated.

Note: TheMIX light source is an optional hardware component that is only available
for certain microscopes (BX53M family, GX53, MX63, MX63L). This is why theMIX
Light Source acquisition process is deactivated if you are using a different microscope
or if theMIX light source wasn't selected in themicroscope's device configuration.

Prerequisite: In the smaller software packages, theMIX Light Source acquisition
process is only available when theAutomation solution is active.

Before you start the acquisition process
1. Switch to theAcquisition layout. To do this, use theView > Layout > Acquisition

command, for example.
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2. Find the segment of the sample that interests you and focus on it.
3. In theOptions > Images > View dialog box, specify whether to display the angle at

which the light from theMIX light source hits the sample under each frame instead
of displaying the acquisition time there. If you want to display the angle, select the
Display angle instead of time if available check box.

Selecting the acquisition process
4. Activate theProcessManager tool window.
5. Select theAutomatic Processes option.
6. Click theMIX Light Source button.

l The button will appear clicked. You can recognize this status by the button's
colored background.

l TheMIX Light Source group will be automatically displayed in the tool window.

Setting the acquisition parameters
Note: The settings that youmake here are only valid for the duration of theMIX Light
Source acquisition process. If other settingsweremade for theMIX light source in the
Microscope Control tool window, these will not be changed. The settingsmade in the
Halation Removal group in theCamera Control tool window are also not adopted by
theMIX Light Source acquisition process.

7. Select whether to switch on 1 or 2 segments in theMIX light source at the same
time (corresponding to 4 or 8 LEDs) for the acquisition of each frame. To do this,
click one of these buttons.

8. Set the brightness of the LEDs of theMIX light source.
l You can adjust the intensity of theMIX light source's LEDs continuously from 0
(no light) to 100% (full light strength).

9. Select the step size. The step size determines how many new LEDs are used for
the acquisition of the next frame. You can select between the 22.5°, 45°, 90° and
180° entries. If you select the 45° entry for example, the LEDs being usedmove
on by 2 positions each time a frame is acquired.
l The selection that youmake affects the number of frames that are acquired
and the time it takes to acquire them:
at 22.5°, 16 frames are acquired
at 45°, 8 frames are acquired
at 90°, 4 frames are acquired
at 180°, 2 frames are acquired

10. Decide whether you want to keep the current settings for themicroscope's
reflected light LED for the acquisition process. You can specify here, for example,
for themicroscope's reflected light LED to be used at a particular intensity for the
acquisition process.
l The settings that youmake here are displayed in theMicroscope Control tool
window aswell.
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11. Click theStart button.
l The acquisition of the time stackwill start immediately.

l The acquisition has been completed when you can see theStart button in the
ProcessManager tool window again, and the progress bar is no longer
displayed.

l Youwill see the time stack you've acquired in the image window.

l By default, the time stack that has been acquired will be saved automatically.
The storage directory is shown in theAcquisition Settings > Saving > Process
Manager dialog box. The preset file format is VSI.

Viewing the time stack
12. Use the navigation bar located in the image window to view the time stack. You

can switch to tile view to look at the frames that have been acquired. Click thePlay
button to start the animation with the current settings.
l You can calculateminimum intensity, maximum intensity, andmean intensity
projection images from themulti-dimensional image retroactively.
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4.6. Acquiring Z-stacks
A Z-stack contains frames acquired at different focus positions. That is to say, the
microscope stage was located in a different Z-position for the acquisition of each
frame.

Note: You can only use the Z-Stack acquisition processwhen your stage is equipped
with amotorized Z-drive.

Example: You want to acquire a Z-stack. The sample is approximately 50 µm thick.
The Z-distance between two frames is to be 2 µm.

1. Switch to theAcquisition layout. To do this, use, e.g., theView > Layout >
Acquisition command.

Selecting an objective
2. On theMicroscope Control toolbar, click the button with the objective that you

want to use for the image acquisition.

Setting the image quality
3. Switch to the livemode, and select the optimal settings for your acquisition, in the

Camera Control tool window. Pay special attention to setting the correct exposure
time. This exposure time will be used for all of the frames in the Z-stack.

4. Search out the required position in the sample.
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Selecting the acquisition process
5. Activate theProcessManager tool window.
6. Select theAutomatic Processes option.
7. Click the Z-Stack button.

l The button will appear clicked. You can recognize this status by the button's
colored background.

l The [ Z ] group will be automatically displayed in the tool window.

Setting the acquisition parameters
8. Select theRange entry in theDefine list.
9. Enter the Z-range you want, in theRange field. In this example, enter a little more

than the sample's thickness (= 50 µm), e.g., the value 60.
10. In theStep Size field, enter the required Z-distance, e.g., the value 2, for a Z-

distance of 2 µm. The value should roughly correspond to your objective's depth of
focus.
l In the Z-Slices field you will then be shown how many frames are to be
acquired. In this example 31 frameswill be acquired.

11. Find the segment of the sample that interests you and focus on it. To do this, use
the arrow buttons in the [ Z ] group. The buttonswith a double arrow move the
stage in larger steps.

Acquiring an image
12. Click theStart button.

l Your software now moves the Z-drive of themicroscope stage to the start
position. The starting positions lies half of the Z-range deeper than the stage's
current Z-position.

l The acquisition of the Z-stackwill begin as soon as the starting position has
been reached. Themicroscope stagemoves upwards step by step and
acquires an image at each new Z-position.

l The acquisition has been completed when you can see theStart button in the
ProcessManager tool window again, and the progress bar is no longer
displayed.

l You can see the acquired Z-stack in the image window. Use the navigation bar
located in the image window to view the Z-stack.

l The Z-stack that has been acquired will be automatically saved. You can set
the storage directory in theAcquisition Settings > Saving > ProcessManager
dialog box. The preset file format is VSI.

Note: When other programs are running in the background on your PC, for instance a
virus scanning program, it can interfere with the performance when a Z-stack is being
acquired.

00367
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4.7. Acquiring an EFI image

What is EFI?
EFI is the abbreviation for Extended Focal Imaging. By using the "EFI" acquisition
process you can acquire imageswith your microscope which have practically unlimited
depth of focus. To do this, EFI uses a series of differently focused individual images
(focus series) to calculate a resulting image (EFI image) that is focused in all of its
parts.

At the left hand-side, the illustration shows a number of frames that were acquired at
different Z-positions. In each of these frames there are only a few image segments
that are displayed sharply focused. These segments are shown in color. These
sharply focused image segments will be assembled into the EFI image (right).

Creating an EFI image
Your software offers you several ways of creating an EFI image.

Acquiring an EFI image without amotorized Z-drive
Acquiring an EFI image with amotorized Z-drive

4.7.1. Acquiring an EFI image without a motorized Z-drive
Example: You have a thick section in the transmitted light mode, or a sample with a
very rough surface in the reflected light mode, e.g., with holes, grooves, bumps peaks
or slanting planes. In the image it's only possible to bring one layer of the section or
only part of the surface sharply into focus, higher-lying or deeper-lying areas are
outside the depth of focus range. Acquire a Z-stack of the complete thickness or height
of the sample, and have the EFI image calculated for you.

In this case, you can use themanual Instant EFI acquisition process to acquire a
sharply focused image of all of the sample.

Note: You can use the Instant EFI acquisition processwith everymicroscope. a
motorized Z-drive or a Z-encoder aren't required.

Note: If your stage has a Z-drive or a Z-encoder, you can also acquire a height map
with the Instant EFI acquisition process.

Selecting the acquisition process
1. Use theView > ToolWindows > ProcessManager command tomake the

ProcessManager tool window appear.
2. Select theManual Processes option.
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3. Click the Instant EFI button.
l The button will appear clicked. You can recognize this status by the button's
colored background.

l The Instant EFI group will be automatically displayed in the tool window.

Setting the acquisition parameters
4. From theAlgorithm list, select theReflected light entry, when you use your light, or

stereomicroscope in the reflected light mode.
5. If you work with a stereomicroscope, select theAutomatic frame alignment check

box.
If you don't work with a stereomicroscope, clear theAutomatic frame alignment
check box.

Preparing EFI acquisition
6. Use theView > ToolWindows > Camera Control command tomake theCamera

Control tool window appear.
7. In theCamera Control tool window, click the Live button.
8. In the live-image, move themicroscope focus to the Z-position where either the

lowest or the highest position on the sample is only just out of focus.
9. Check the exposure time, and correct it if necessary. When the Instant EFI

acquisition process has been started, the exposure time will be kept constant
during the whole of the acquisition.

Acquiring an EFI image
10. In theProcessManager tool window, click theStart button.

l The live-image in the document group will divide itself into 3 images. On the
bottom right, you'll still see the live-image (3). On the bottom left, you'll see the
sharpnessmap (2). The large image above them is the composite resulting
image (1). The 3 imageswill be continually updated.
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11. Use your microscope's Z-drive tomove your stage slowly through the height
range of the sample's surface.
l Your software will acquire images at the various focal planes, then it will set
them together. While this is being done, the camera will acquire the images as
quickly as possible. The sharpness value of individual pixels will be calculated
for every image. If the sharpness values are higher than in the previous
images, the pixels in the composite EFI image will be adopted. The EFI image
contains the pixels with the highest sharpness values from all of the images
acquired up till then.

l The sharpnessmap at the bottom left will show you which image areaswill be
sharply reproduced in the EFI image. The brighter a pixel is in the sharpness
map, the higher is its sharpness value in the EFI image.

l Once the acquisition process has been started, the sharpnessmap should only
be bright at the deepest or highest parts of the sample, the rest of themap is
dark.

12. Focus on the sample slowly once through all the focal planes.
After each change of the focus position, wait until you see that further areas
become brighter in the sharpnessmap.
l As the process continues, more andmore areas in the sharpnessmap should
become brighter. At the same time the EFI image will also get better and better.

13. Check the EFI image and the sharpnessmap. Are all areas of the image now
sharp? Are there any areas in the sharpnessmap that are still dark?
Focus on these areas and have additional images calculated into the EFI image.
Continue acquiring additional images until the whole sample has been sharply
reproduced.

14. In theProcessManager tool window, click theStop button.
l The resulting image is not a Z-stack, but a standard image.

l The EFI image will be automatically saved. You can set the storage directory in
theAcquisition Settings > Saving > ProcessManager dialog box. The preset
file format is VSI.

15. In theCamera Control tool window, click the Live button again to release it.
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4.7.2. Acquiring an EFI image with a motorized Z-drive
Example: You have a thick section in the transmitted light mode, or a sample with a
very rough surface in the reflected light mode, e.g., with holes, grooves, bumps peaks
or slanting planes. In the image it's only possible to bring one layer of the section or
only part of the surface sharply into focus, higher-lying or deeper-lying areas are
outside the depth of focus range. Acquire a Z-stack of the complete thickness or height
of the sample, and have the EFI image calculated for you.

You can use the automaticZ-stack acquisition process, to acquire a sharply focused
image of all of the sample.

Prerequisite: You can only use the Z-Stack acquisition processwhen your stage is
equipped with amotorized Z-drive.

Setting the EFI parameters
1. Activate theProcessManager tool window.
2. To open theAcquisition Settings dialog box, click theAcquisition Settings button

in the tool window's toolbar.
3. Select theAcquisition > Automatic EFI entry in the tree view.
4. In theAlgorithm list, select the Transmitted light (exponential) entry, if you're

working in transmitted light mode, and theReflected light, entry if you're working
in reflected light mode.

5. Select theAutomatic frame alignment check boxwhen you're working with a
stereomicroscope and acquiring the sample at a viewing angle.
Otherwise, clear this check box.

6. Close theAcquisition Settings dialog boxwithOK.

Preparing Z-stack acquisition
7. Carry out all themicroscope settings.
8. In theMicroscope Control toolbar, click the button corresponding to the objective

you've set.
9. Activate theCamera Control tool window.
10. Switch to the livemode.
11. Optimize the exposure time. The exposure time will be kept constant during the

acquisition of the Z-stack.
12. Click theAutofocus button in theCamera Control tool window's toolbar to focus.

Setting the Z-stack parameters
13. Activate theProcessManager tool window.
14. Select the Z-Stack acquisition process.
15. Select the Top and bottom entry in theDefine list.
16. Use the arrow buttons in the [ Z ] group tomove your stage to the Z-position at

which the lowest-lying position on the sample is sharply focused.
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The arrow buttonsmove the stage either by steps of 2 µm or of 20 µm.
l The stage's current position will be shown to you in thePosition field.

17. Click the topSet button to define the starting position for the Z-stack acquisition.
l The current Z-position will be adopted in theStart field.

18. Use the arrow buttons in the [ Z ] group tomove your stage to the Z-position at
which the highest-lying position on the sample is sharply focused.

19. Click the bottomSet button to define the position at which the Z-stack acquisition
is to end.
l The current Z-position will be adopted in theEnd field.

20. In theStep Size field, enter the distance between two frames in the Z-stack. This
Z-distance should be small enough to ensure that no positions on the sample
between two images remain blurred. The higher your objective's Numerical
Aperture is, the smaller the Z-spacing should be.

21. Use the [Enter] key to confirm the Z-distance that you've set.
l The number of images in the stackwill be automatically calculated on the basis
of the Start and End values, and the Z-distance.

Starting EFI acquisition
22. Select theExtended Focal Imaging (1) check box. You find the check box at the

bottom of the [ Z ] group located in theProcessManager tool window.

23. Finish the livemode.
24. Click theStart button.

l The EFI acquisition begins immediately.

l The acquisition will begin. After the acquisition has been completed the EFI
image will be shown in the document group. This image was calculated from
the variously focused separate images.
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4.8. Creating stitched images

What is a stitched image?
If you acquire a stitched image, move the stage in a way that different, adjoining parts
of the sample are shown. All of the images that are acquired are combined, just like a
puzzle, into a stitched image. The stitched image will display a large part of the sample
in a higher X/Y-resolution than would be possible with a simple snapshot.

The illustration shows left, four separate images. On the right you see the stitched
imagemade up from the four images.

Creating a stitched image
Your software offers you several ways of creating a stitched image.

Acquiring a stitched image bymoving the stage (Instant MIA)
Acquiring a stitched image without amotorized XY-stage (Manual MIA)
Acquiring a stitched image with amotorized XY-stage (XY-Positions/MIA)
Acquiring a stitched image with extended depth of focus
Automatically acquiring several stitched images
Combining individual images into a stitched image

Note: If image defects on the edge of an image decrease the quality of the stitched
image or hinder the assembly of the individual images, you can clip these images
during acquisition withSubarraymode in theCamera Control tool window.

Materials science analysis processes on stitched images
TheMaterials Solutions tool window offers several materials science analysis
processes. Most of these processes can also be applied to stitched images, provided
that you are working with amotorized XY-microscope stage. The acquisition of these
stitched images are defined in theStage path settings step within thematerials
science analysis process. In this case, you won't need the acquisition processes
described in this topic.

4.8.1. Acquiring a stitched image by moving the stage (Instant
MIA)

Preconditions
For the acquisition of stitched images, it's very important that your system has been
correctly set up. If, for example, the shading correction wasn't performed correctly, the
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individual images create a tiled effect in the stitched image. It's also very important that
the camera is aligned parallel to the stage's XY-axes.When the camera is askew in
relation to the stage, the individual images in the stitched image will also be askew in
relation to one another. The angle between camera and stage should be smaller than
1°.

Making settings for the acquisition of an image
1. Switch to theAcquisition layout. To do this, use theView > Layout > Acquisition

command, for example. TheCamera Control tool window and theProcess
Manager tool window are displayed automatically.

2. Use the default acquisition settings for the Instant MIA process. To do so, open
theAcquisition Settings > Acquisition > Instant MIA dialog box. Click theDefault
button and close the dialog box.
l You can open this dialog box, for example, via theProcessManager tool
window. In the tool window's toolbar, click theAcquisition Settings button.
Select theAcquisition > Instant MIA entry in the tree view.

3. Select themicroscope settings you want. In particular, select the required
magnification. If you have defined observationmethods, select the required
observationmethod.
l In this case, the background color of the stitched image depends on the
observationmethod that has been selected. The background is automatically
black for all fluorescence observationmethods and all darkfield observation
methods. The background is white for all other observationmethods.

Selecting, configuring and starting the acquisition process
4. Activate theProcessManager tool window.
5. Select theManual Processes option, and click the Instant MIA button.
6. Check the configuration of this acquisition process.
7. Click theStart button.

l TheAdjust Acquisition Conditions dialog box opens.

l Your software will automatically switch to the livemode.

l The camera resolution is set to the value that is specified in the acquisition
settings.

l You can't use HDR with the Instant MIA acquisition process. If HDR is
activated when you start this acquisition process, you receive an error
message to this effect. Deactivate HDR in theCamera Control tool window
and restart the acquisition process.

l Your software checks how much storage capacity is available. If too little
storage capacity is available, an error message appears.

8. Select the optimal settings for your acquisition in theCamera Control tool window.
You can still adjust the camera resolution aswell.
l The settings are applied to all of the individual images that make up the stitched
image (exposure time, resolution, subarray, the white balance).
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l The focus setting that is now made is, by default, also used for all of the
individual images that make up the stitched image. The autofocus function is
deactivated during the Instant MIA acquisition process. You can, however, still
adjust the focusmanually while the acquisition process is running. This is only
possible in a special focus view.

Note: It's especially important that the sample is well exposed and that the current
exposure time is as short as possible. If the exposure time is too long, you receive an
error message.

9. Find the position on the sample at which you want to start acquiring the stitched
image.

10. In theAdjust Acquisition Conditions dialog box, click theStart button.
l The first image of the stitched image is displayed in the image window.

l Most of the software’s functions are now not available. Camera control is also
locked.

l The software switches to a special MIA image view. This view uses theMIA
cursor. It consists of a square frame that can have different colors (see the
table below).

Acquiring a stitched image
11. Slowlymove the stage to the next position on the sample.

l The camera acquires images continuously as long as youmove the stage. The
individual images are immediately assembled. You can watch how the stitched
image grows, in the image window.

l If required, use themouse wheel to zoom in to or out of the stitched image.
Alternatively, you can also use the Zoom toolbar for this.

Display of the stitched image during the Instant MIA acquisition process. TheMIA
cursor indicates the status of the image acquisition.

12. Pay attention to theMIA cursor. The color of the frame indicates the status of the
image acquisition.
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A light blue framemeans that there are no problems with
assembling the stitched image.

A yellow framemeans that it's still possible to assemble the
images. The settings, however, aren't optimal. It could be that the
stage was moved too quickly, for example.

An orange framemeans that the stitching position was temporarily
lost. It could be that the stage was moved too quickly, for example,
or that the sample has too little image information at the current
stage position for the images to be assembled. However, your
software can often find the stitching position again in this state by
its ownmeans.

A red frame indicates that the stitching position was definitely lost.
Your software can't find the stitching position again in this state by
its ownmeans.

However, in certain cases, you canmanually bring your software
into a state where the stitching position is found again.

Alternatively you can now finish the Instant MIA acquisition
process. The stitched image contains all information that had been
acquired until the stitching position was lost.

Adjusting the focus on the sample
13. If you need to adjust the focus on the sample (for example, if you navigate to a

slightly thicker position on the sample), click the Focus View button. You'll find the
button in the Instant MIA group, located in theProcessManager tool window.
l The Focus View button now becomes theMIA Image View button.

14. Adjust the focus on the image. Either use the focus knob on themicroscope for
this, or if your microscope has amotorized Z-drive, use the slide control in the
Microscope Control tool window. The autofocus function can't be used while the
Instant MIA acquisition process is activated.
l In focus view, the live-image is displayed in a new tab. TheMIA image view
remains on its own tab in the image window. The stitched image, however, is
not refreshed as long as you stay in focus view.

15. When you've adjusted the focus on the sample, click theMIA Image View button.
l Switch back to theMIA image view and you can continue with the image
acquisition.

Note: The Instant MIA acquisition process can’t run indefinitely. The acquisition
process ends automatically after about 30minutes.

Stopping image acquisition
16. Click theStop button when you want to end the acquisition of the stitched image.

l You see the completed stitched image, in the image window. It is usually not
rectangular, but instead contains empty areas on its borders. In the stitched
image, these areas are by default colored in white, or in blackwith dark field
images.
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You can also select any background color you want. To do so, select theSelect
background color check box in the acquisition settings.

l The stitched image will, by default, be automatically saved in a database.
Alternatively, you can select a storage location, or switch off the automatic
saving. To do so, use theAcquisition Settings > Saving > ProcessManager
dialog box. The preset file format is VSI.

l The images composing the stitched image will not be saved separately.

4.8.2. Acquiring a stitched image without a motorized XY-stage
(Manual MIA)

Example: You want to acquire an image of a large sample area. Use theManual MIA
acquisition process to acquire several individual images of adjoining positions on the
sample, and to have them combined into a stitched image. MIA stands for Multiple
Image Alignment.

Prerequisite
The camera is aligned parallel to the XY-stage. The angle between camera and stage
should be smaller than 1°.

1. Switch to theAcquisition layout. To do this, use theView > Layout > Acquisition
command, for example.

Selecting microscope settings
2. Select themicroscope settings you want. In particular, select the required

magnification. To do this, on theMicroscope Control toolbar, click the button with
the objective that you want to use for the acquisition of the stitched image. If you
are using amagnification changer, you will also have to select themagnification
value used.
If you have defined observationmethods, select the required observationmethod
instead.
l In this case, the background color of the stitched image depends on the
observationmethod that has been selected. The background is automatically
black for all fluorescence observationmethods and all darkfield observation
methods. The background is white for all other observationmethods.

Setting the image quality
3. Switch to the livemode, and select the optimal settings for your acquisition, in the

Camera Control tool window. Pay special attention to setting the correct exposure
time. This exposure time will be used for all of the stitched image's individual
images.
l If you are using a DP74 camera, the live-image can be displayed as a LiveHDR
image.

4. Find the position on the sample at which you want to start acquiring the stitched
image.

5. Finish the livemode.
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Selecting the acquisition process
6. Activate theProcessManager tool window.
7. Select theManual Processes option.
8. Click theManual MIA button.

l The button will appear clicked. You can recognize this status by the button's
colored background.

l TheManual MIA group will be automatically displayed in the tool window.

l Should the Instant EFI acquisition process have been active, it will be
automatically switched off. You can, however, use imageswith extended depth
of focus for the stitched image. To do this, before you acquire each of the
individual images, click the Instant EFI button located in theManual MIA group.

Setting the acquisition parameters
9. Make quite certain that theAuto Align button appears clicked. It should then look

like this.
l Then your software will search for the same image structures in neighboring
individual images. The stitched image will be put together in such a way that
image areas that are the samewill be superimposed.

Acquiring a stitched image
10. Click theStart button.

l Your software switches into the livemode.

11. Bring the sample into focus.
12. Click on one of the arrow buttons to set the side of the current image at which the

next image is to be arranged. For example, click this button if the next image is to
be laid to the right of the current image.
l Your system now acquires an image at the current position on the sample. In
the image window you now see on the left (1) the acquired image, and on the
right (2) the live-image is displayed.

Because you haven’t moved the sample, the live-image is still displaying the
current position on the sample. Thismeans that you are now looking at two
displays of the current image.
The two images overlap. Because the live-image is transparent, both images
are displayed in the overlap area.

13. Make a note of a significant structure on the live-image's right border. You will find
the same sample structure in the overlap area. On the illustration, a significant
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structure has been indicated by a circle.
14. Now move the stage very slowly tomake the structure on the live-imagemove to

the left. Keepmoving the stage until the image structures in the overlap area lie as
exactly over each other as possible. The image structures need not lie precisely
over each other, since your software will match the individual imageswith each
other.
l In the overlap area (3), the same image segments are shown now. This
enables your software to seamlessly combine the two images.

l You can reverse the direction in which your stagemoves, in theDevice
Settings > Stage dialog box. Depending on how you can best orient yourself,
the live-image will thenmove to the left or to the right, when youmove your
stage to the right.

15. Checkwhether both images have been correctly combined. Otherwise, you can
undo the last step by using theUndo last frame button. You can thenmove the
stage again, andmatch the structures better.
l During the acquisition, you can change the current stitched image's zoom
factor, e.g., to see certain parts in the overlap area better.

16. Define your way through the sample, with the arrow buttons, and follow that with
the stage.
In thismanner, you can display a sample in any form you like in the stitched image.
The illustration shows a stitched image that ismade up of 9 individual images, and
the stage path.

17. Click theStop button when you want to end the acquisition of the stitched image.
l You see the completed stitched image (4) in the image window.
Since the individual images can lie a little askew of each other, the stitched
image isn't as a rule, rectangular, but contains empty areas on its borders (5).
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These areaswill, as a rule, be cut off in the stitched image.

l The stitched image will, by default, be automatically saved in a database.
Alternatively, you can select a storage location, or switch off the automatic
saving. To do so, use theAcquisition Settings > Saving > ProcessManager
dialog box. The preset file format is VSI.

Properties of the stitched image
l By default, in the overlap area, the intensity values of two adjoining individual
imageswill bematched with each other to make the image's overall impression
homogeneous.

l Stitched images are calibrated. Thismeans that you canmeasure distances
and objects on a stitched image.

4.8.3. Acquiring a stitched image with a motorized XY-stage (XY-
Positions/MIA)

Example: You want to acquire an image of a large sample area. Use the automatic
XY-Positions/MIA acquisition process to scan an area of the sample and to have
adjoining images combined into one stitched image. MIA stands for Multiple Image
Alignment.

Prerequisite: You can only use theXY-Positions/MIA acquisition process if your
microscope is equipped with amotorized XY-stage.

Preconditions
l The stage has been set up and initialized, i.e. its stage limits have been defined.
l The camera is aligned parallel to the XY-stage. The angle between camera and
stage should be smaller than 1°.

l The shading correction has been set up.

1. Switch to theAcquisition layout. To do this, use theView > Layout > Acquisition
command, for example.
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Selecting microscope settings
2. Select themicroscope settings you want. In particular, select the required

magnification. To do this, on theMicroscope Control toolbar, click the button with
the objective that you want to use for the acquisition of the stitched image. If you
are using amagnification changer, you will also have to select themagnification
value used.
If you have defined observationmethods, select the required observationmethod
instead.
l In this case, the background color of the stitched image depends on the
observationmethod that has been selected. The background is automatically
black for all fluorescence observationmethods and all darkfield observation
methods. By default, the background is white for all other observationmethods.

Selecting the acquisition process
3. Activate theProcessManager tool window.
4. Select theAutomatic Processes option.
5. Click theXY-Positions/MIA button.

l The button will appear clicked. You can recognize this status by the button's
colored background.

l TheXY group will be automatically displayed in the tool window.

Using the software autofocus
6. If your microscope is equipped with amotorized Z-drive, you can switch on a

software autofocus.
In theProcessManager tool window, click theAutofocus button.
l TheAutofocus group will be automatically displayed in the tool window.

7. In theAutofocus group, select theMultiposition / MIA autofocus check box.
If the sample surface is not plane or if it is inclined to the objective, choose the
EveryMIA frame option. Now, the software autofocuswill be performed before
every image acquisition.

Putting the stage navigator on display
8. In theProcessManager tool window, click this button .

l TheStage Navigator tool window will be shown.When you have acquired an
overview image of your sample, you will see this area of the image in the stage
navigator's image segment.

9. Set themagnification for the image segment in theStage Navigator tool window.
To do this, use the zoom buttons at the bottom left of the tool window (2).
The current stage position will be shown by a yellow rectangle in the image
segment (1). You should choose amagnification that enables you to see this
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rectangle clearly.

Defining the MIA scan area
10. In theProcessManager tool window, click this button .

l The systemwill automatically switch into the livemode.

l TheDefineMIA Scanning Area dialog box opens.

11. Move the XY-stage to the top left-hand corner of theMIA scan area you want (3).
12. Focus, then select the optimal settings for your acquisition in theCamera Control

tool window. Pay special attention to setting the correct exposure time. This
exposure time will be used for all of the stitched image's individual images.

13. Confirm the starting position in theDefineMIA Scanning Area dialog box, with
OK.

14. Move the XY-stage to the bottom right-hand corner of theMIA scan area (4).
Confirm this position in theDefineMIA Scanning Area dialog box, withOK.
l In theStage Navigator tool window, theMIA scan areas that have been
defined are displayed. Here, you can immediately see how many individual
images are required for the acquisition of the stitched image, when the current
magnification is used.
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Acquiring a stitched image
15. Click theStart button.

l The acquisition begins immediately. The individual images are acquired, then
immediately assembled. You can watch how the stitched image grows, in the
image window.

l In the status bar at the bottom left of the user interface, you can find a progress
bar, the number of images already acquired, and the total number of frames
(e.g., 3/9).

l The acquisition has been completed when you can see theStart button in the
ProcessManager tool window again, and the progress bar is no longer
displayed.

l You see the completed stitched image, in the image window. The individual
imageswon't be saved separately.

l The stitched image will, by default, be automatically saved in a database.
Alternatively, you can select a storage location, or switch off the automatic
saving. To do so, use theAcquisition Settings > Saving > ProcessManager
dialog box. The preset file format is VSI.

4.8.4. Acquiring a stitched image with extended depth of focus
When you acquire a stitched image of a thick section or an uneven surface, in some
cases not all of the areas of the sample will be sharply displayed. In this case, you can
combine the acquisition of a stitched image with theEFI (Extended Focal Imaging)
acquisition process. By doing this, you'll make sure that the stitched image is sharply
focused everywhere.

Note: The acquisition of a stitched image with extended depth of focus, is both with
and without, a motorized XY-stage, possible.

Without a motorized XY-stage
1. Start theManual MIA acquisition process.
2. Click the Instant EFI button, in theManual MIA group.

l The Instant EFI acquisition processwill start at once. Instead of the live-image,
you now see the EFI image.

3. Now move your microscope's Z-drive slowly and change the focusing of the
image. Observe how the EFI image builds itself up.
l For each image that is acquired, the sharpest image segment is adopted in the
EFI image.

4. When all of the image structures are sharply displayed, click one of the direction
arrows in theManual MIA group to continue with the acquisition of the stitched
image.

Note: You now see the live-image with the last focus settings. That means that
normally, the live-image won't be in focus.
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5. Bring the image into focus.
6. Repeat the last steps for each of the stitched image's individual images for which

you want to use the Instant EFI acquisition process.
7. Click theStop button when you want to end the acquisition of the stitched image.

l You see the completed stitched image, in the image window.

With a motorized XY-stage
Prerequisite: You can only use theEFI acquisition processwhen your stage is
equipped with amotorized Z-drive.

1. Select theXY-Positions/MIA acquisition process.
2. Define anMIA scan area.

You can find a step-by-step instruction for doing this further above.
3. Additionally, select the Z-Stack acquisition process.

l In the group with the different acquisition processes, two of them are now
active:

4. Define all of the parameters for the Z-stack's acquisition.
5. In the [ Z ] group, select theExtended Focal Imaging check box.
6. Click theStart button to begin the acquisition of the stitched image.

l At each of theMIA scan area's stage positions, a Z-stackwill first be acquired,
then the EFI image calculated from it. The EFI imageswill be combined into a
stitched image.

l When the acquisition process has been completed, you'll see the finished
stitched image in the image window.

4.8.5. Automatically acquiring several stitched images
You can define several MIA scan areas on the sample. When the acquisition has
started, all of theMIA scan areaswill bemoved to, one after the other, and a stitched
image will be acquired at every position.

1. Select theXY-Positions/MIA acquisition process.
2. Define several MIA scan areas. You can find a step-by-step instruction on how to

define anMIA scan area further above.
Begin with the area of the sample that is to be scanned first.

Putting the stage navigator on display
3. In theProcessManager tool window, click this button .

l TheStage Navigator tool window will be shown.When you have acquired an
overview image of your sample, you will see this area of the image in the stage
navigator's image segment.
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l In theStage Navigator tool window, theMIA scan areas that have been
defined are displayed. They are numbered serially in the order in which they
were defined.

Acquiring stitched images
4. Click theStart button to begin the acquisition of the stitched image.

l Each of theMIA scan areaswill now be scanned, and the stitched image
created. The scan areaswill be scanned in the order that is predefined by the
numbering.

l All of the stitched imageswill be acquired with the current camera, and current
acquisition settings.

l When the acquisition process has been completed, you'll find a stitched image
for each of theMIA scan areas, in the document group.
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4.8.6. Combining individual images into a stitched image
Use theProcess > Multiple Image Alignmentmenu command to have several
separate images combined, aswith a puzzle, into a stitched image. The individual
imageswill be combined in their full X/Y-resolution. The stitched image will thus
display a large sample segment in a higher X/Y-resolution than would be possible with
a single acquisition.

Acquiring images
1. Load the images you want to combine or acquire a suitable set of images.

l All of the images you want to combinemust be of the same image type. You
can't, e.g., have a gray-value image combined with a true-color image.

l When you acquire the images, number their names sequentially, e.g.,
"Image001", "Image002" and so on. In many cases, the imageswill then
already be arranged in the right order in theMultiple Image Alignment dialog
box.

Selecting images
2. Open theGallery tool window. To do this, you can use theView > ToolWindows >

Gallery command.
3. Select all of the images you want to combine, in theGallery tool window.

Assembling images
4. Use theProcess > Multiple Image Alignment command. This command is only

active whenmore than one image of the same image type has been selected.
l The dialog box's stitching area will display a preview of the individual images.

5. If necessary, while keeping your left mouse button depressed, drag on the bottom
left-hand corner of the dialog window to enlarge it. Alternatively, double click the
header of the dialog box to enlarge the dialog box to full-screen size.

6. Checkwhether the images' positions are correct. You can change the
arrangement of the individual images, e.g., by exchanging two images in the
stitching area using Drag&Drop.
l The illustration shows the stitching area with four individual images. On the left,
the images 1 and 2 are not in the correct position. Image 1 (green frame) will
therefore be dragged onto image 2 (red frame). On the right, you see the
stitching area after the two images have been interchanged.
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7. When the individual images overlap, select theCorrelation entry in theOutput >
Alignment list.
Then your software will search for the same image structures in neighboring
individual images. The stitched image will be put together in such a way that
image areas that are the samewill be superimposed.

8. Click theOK button to carry out the automatic image alignment.
l TheMultiple Image Alignment - Manual Align dialog box opens.

l The stitched image will be displayed.

Checking a stitched image
9. Check the stitched image on display.

Use the zoom buttons in the dialog box to zoom in the stitched image in the dialog
box.

10. Should individual images have been incorrectly assembled, you canmanually shift
one or more of them, in respect to one another.
To do this, click in the image you want to shift, then drag it with your left mouse
button depressed, in the required direction.
l The currently selected image will be displayed semi-transparently to make it
easier for you to find the point of contact with the neighboring image.

l Two imageswere not correctly aligned with each other. There is a
misalignment. When themanual alignment has beenmade, the two images fit
together seamlessly.

11. Select theCut Edges check box to clip the image in such a way that there are no
longer any empty areas visible on its borders.
l In the preview, the image edges that are to be clipped will be displayed semi-
transparently.

12. Select theEqualize check box if the images aren't homogeneously illuminated.
Then the intensity values of the individual imageswill bematched with one
another, which will make the background appear more homogeneous.

13. Click theOK button.
l A new image with the name Image_<consecutive No.> will be created.
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5. Image processing
5.1. Commenting on images

There are several different ways of adding notes to an image.

Using drawing objects
TheDrawing toolbar makes a variety of drawing functions (line, rectangle, ellipse, text)
available to you, aswell as options for color selection and line styles.

Using annotations
You can use theAnnotations tool window tomark interesting positions in an image, to
name them and to save them. You can give each position a text or audio annotation. In
this way you will be able to jump to the position in the image that you want with one
mouse click, and this will be immediately shown in themagnification you want.

Use this possibility especially when you are commenting on very large images.

Entering an image comment
TheProperties tool window will show you all of the available information from the
document group on the active image.

You can also supplement this information with a text annotation of your own on the
image. Enter your comment in theNote field.

00121

5.2. Processing images
TheProcessmenu offers numerous image processing functionswith which you can
change an acquired image (for example increase the image contrast or the image
sharpness).

1. Load the image you want to process, or activate the image in the document group.
l Please note that theProcessmenuwill only be visible when an image is loaded
and active in the document group.

2. Use one of the commands in theProcessmenu, e.g.,Process > Enhancements >
Adjust Intensity .
l The image processing dialog box opens. The image processing operation that
is active will be shown in the dialog boxes header.

3. Click the small arrow next to thePreview button to open a list of all of the preview
functions. Select theOriginal and Preview entry.
l This preview function displays the same image segment twice in the dialog box.
The first one shown is the source image. The second is the image that results
when the current parameters are used.

l Most of the image processing operations need one or two of the parameters
that are shown in theSettings group.
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4. Select theCreate new document as output check box to create a new image.
When you do this, the source image remains unchanged.
Clear the check box if you want the image processing function to change the
source image. Now no new image document will be created. As long as you have
not yet saved the image, you can use theEdit > Undo command to restore the
source image.

5. Change the image processing operation's parameters. You can decrease the
gamma value and increase the brightness, for example.
l Every time you change a parameter, the new resulting image will be displayed
in the preview window.

6. Click theDefault button, to readopt the preset parameters in theSettings group,
when the current parameter doesn't make sense to you.

7. When you have found the optimal parameters, click theOK button to have the
active image processing operation applied to the image with the active
parameters.
l The image processing dialog box closes.

l By default, the image processing function doesn't change the source image. A
new image document is created instead.

l The new image document will not be saved automatically. This is indicated by
the asterisk after the image name in the document group.

The source image (left) has low contrast. Adjust the intensity to get significantly better
contrast in the resulting image (right).
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6. Analyzing images using deep learning
What is Deep Learning?

Many tasks require your software to detect objects in an image. One example of this is
dyeing cells with fluorescingmarkers in order to observe and to analyze biological
processes. For this to work, the cellsmust be automatically detected in the
microscopic image acquisitions.

Deep learning can solvemany of these detection tasks. Deep learning is one of the
methods that machine learning uses. Deep learning uses artificial neural networks that
belong to a class of algorithm that ismore or less inspired by the human brain. The
successful detection of images of cats in an image database containingmillions of
animal images is themost well known example of a detection task solved with deep
learning.

To be able to use deep learning, two phases are required.
In the training phase the neural network is trained using images of objects. These
are the same objects that you later want the neural network to detect in other images,
the inference images. The interesting thing is that no parameters whatsoever that
characterize the objectsmust be specified, their size or a description of their
appearance for example. All that is required is for an expert to label the objects clearly.
In the example with catsmentioned above, the neural network was trained using
images of animals but a person was required to specify for each of the training images
whether it contained a cat or not.

The second phase is the inference phase. The inference phase analyzes an
unknown image, the inference image, using a neural network. In the example with the
images of cats, a system can use a neural network to decide whether any image of an
animal contains a cat or not.

The illustration shows the training phase (I) and the inference phase (II). The input
data (1), the computation (2) and the output data (3) are shown.

The input data (1) in training phase (I) ismicroscopic images and the ground truth. In
this case, the ground truth consists of the labels that indicate the objects you want to
identify.In this example, the objects you want to identify are cell nuclei. However, you
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can also search for something else.
During the training process (2), your software computes appropriate parameters for
the neural network. The computation runs in the background andmay take a long time
depending on the task and the computer being used.

After a successful training process, the objects you want to identify will be correctly
detected. The training process results in a neural network with particular parameters.
You save the neural network as a parameter set in a file (3). So the output data of the
training phase is a parameter set that you can now use in your software.

In the inference phase (II) you use the saved neural network to perform an analysis
on an inference image (1). The inference image is amicroscopic image with similar
objects to those in the training images. The result of the analysis using the neural
network (2) is a probabilitymap that informs about the likelihood for each pixel in the
inference image that it belongs to one of the objects you want to identify.

Deep learning in your software
You can use theDeep Learning software solution to create training images, and to
train neural networks. You use your own images for the training process. As a rule,
you will need to train and save an individual neural network for each task that you want
to solve with the help of a neural network. For the training process you require a
powerful computer and an expert who can clearly label the objects you want to identify
in the image.

You don’t require theDeep Learning software solution to use a neural network in your
software. You can import a neural network that was created at a different workstation.

Note: Both the training phase and the inference phase take place exclusively with your
own data and on your own computer.

The difference between an analysis using a neural network, and an
object analysis based on thresholds.
In theCount andMeasure tool window, your software offers an alternativemethod to
detect and tomeasure objects in images. Thismethod of object analysis uses
thresholds that are set on the distribution of color or gray intensity values in the image.
This object analysis based on thresholds has a number of limitations.

It requires that the objects you want to identify are distinct from the background either
in color or in intensity. Objects that touch or overlap can also not be easily detected
with thismethod. A neural network enables you to find objects that could not be found
using a standard object analysis based on thresholds.
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General process flow of an analysis using a neural network
The following steps are required to train and apply a neural network using your
software.

Perform the training phase
Step 1: Acquiring training images

Acquire the training images. Use similar acquisition conditions (exposure, magnification) for
the training images to those you will later use to acquire the inference images that you want

to analyze with the neural network.

Step 2: Creating training labels
On the training images, define the objects that you want the neural network to detect. You
can define the objects either automatically or manually. If you want to define the objects
automatically, use theCount andMeasure tool window to perform an automatic object

analysis using thresholds. If you want to define objects manually, use the Training Labels
tool window.

Step 3: Training and saving a neural network
Select the training configuration for the neural network and a training duration. Start the

training process.

Follow the progress of the training process. During the training process, you can check the
results on validation images at different points in time.

When your training process has been successful, save a new neural network as a parameter
set.

Use theDeep Learning layout to train and save a neural network.

Performing the inference phase
In your software, there are several ways of performing an analysis using a saved
neural network.

Option 1: Performing an object analysis on a probability map
This option first performs an analysis using a neural network. Then an object analysis is

performed on the probability map.

To perform the analysis using a neural network, use theProcess > Deep Learning > Neural
Network Processing command. The neural network will identifies object in the inference

image. The result is a probability map. For each pixel of the inference image, the probability
map indicates the likelihood that the pixel belongs to an object.

Then use theProbability Layer Segmentation software function in theCount andMeasure
tool window to perform an object analysis on the probability map. This will detect and

measure the objects in the probability map.
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Option 2: Performing an object analysis using a neural network
This option combines the analysis using a neural network, and the object analysis into one

step.

Use theNeural network Segmentation software function in theCount andMeasure tool
window to perform an analysis using a neural network on the inference image. The neural
network will identify objects in the inference image. Then the objects will then be detected
andmeasured immediately. You can view themeasurement results in theCount and

Measure Results tool window.

Software and hardware requirements

Software requirements
Youmust purchase theDeep Learning software solution to train a neural network.

Which graphics cards are supported?
A large amount of datamust be processed to train a neural network. This demands a
lot of the PC’s hardware equipment and requires a fast graphics card. To be suitable,
a graphics cardmust support CUDA technology.

The two graphics cards listed below were successfully tested. However, due to
technical progress, this list can change frequently. Contact your Olympus sales
representative if you have any questions about suitable graphics cards.

NVIDIA Quadro P4000
NVIDIA Quadro RTX 4000

What are training images?
The neural networks that you train with your software should be able to identify very
specific types of objects in an image. The software requires training images to perform
a training. The number of training images required to train the neural network very
much depends on the task.

Requirements for the training images
The training imagesmust meet the following requirements:

Images
with
training
labels

All training images must contain training labels. The training labels form the ground
truth for the training of the neural network.

You can automatically create the training labels using an object analysis. However,
this will only be successful if the objects to be found have a color or intensity that is
distinct from the background. Use theCount andMeasure tool window to perform an
automatic object analysis.

If the training images aren’t suitable for an automatic object analysis, you can create
the required training labels manually. Use the Training Labels tool window tomanually
draw the training labels.

The training labels are displayed on their own image layer. This image layer is called
User Labels.

Training With your software, you can create neural networks that search for different classes of
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label
classes

objects simultaneously in images. The training images for these types of neural
networks will then contain different training label classes. A separate class is defined
for each object type.

Image
size

Theminimum size for training images is 1024x1024 pixels. The training images don’t
have to be of the same size. As long as a training image has the required size, youmay
use it.

If you are using a very large image with very many objects as a training image, a single
imagemay suffice to train the neural network.

Please note that this requirement only applies for the training images. You can later
also apply the neural network to images that have a different image size.

XY-
calibration

All of the training images must have approximately the same calibration. If you
acquired all the training images with the same objectivemagnification, this requirement
will be fulfilled.

Image
format

Training images must be in one of the following image file formats: VSI, TIF, TIFF,
BTF.

The probability map
A deep learning analysis produces a probabilitymap. For each pixel of the inference
image, the probabilitymap indicates the likelihood that the pixel belongs to an object.
You can define the color that the probabilitymapwill use in the Training Labels tool
window. The probabilitymap isn't a binary image. It has varying intensity values. The
intensity corresponds to the probability that an object that was predicted is actually
present in the inference image. If an object on the probabilitymap is only very lightly
colored, there is a small probability that an object actually exists at that position. If the
object is heavily colored, there is a high probability that the prediction is accurate.

The probabilitymap is a separate image layer that is superimposed on the inference
image. Use the Layers tool window to show or hide the probabilitymap. You can also
extract the probability layer.

When the neural network was trained using several training label classes, a separate
probabilitymap is calculated for all defined training label classes. In this case, use the
Dimension Selector tool window to show or hide the probabilitymaps for the individual
training label classes.
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6.1. Working with deep learning
Example: Let’s say you want to examine samples that have been exposed to heat, due
to welding for example, and this has created a second phase. You want to measure
the area covered by each phase. Scratches and tearsmake it difficult to automatically
identify the phases on the basis of color or intensity.
Use theDeep Learning software solution to train a neural network that can detect the
phases in the images. You can then perform a phase analysis on the images.
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The illustration show the image of a sample with two phases, (1) and (2). The dark
areas (3) don’t belong to either phase. You are going tomeasure the area covered by
phases (1) and (2).

The following step-by-step instructions take you through the whole process of a deep
learning analysis using this example.

Step 1: Creating training labels manually
Use the Training Labels tool window tomanually define training labels on the training

images.

Step 2: Training and saving a neural network

Step 3: Performing a phase analysis using the neural network

Preparations
To train a neural network you need suitable training images.

1. Acquire images of typical areas on the sample. Use acquisition conditions that are
as similar as possible to those for the images that you will later analyze. For
example, select the same objectivemagnification and similar exposure conditions.
The number of training images required to train the neural network verymuch
depends on your use case. If you want to check the results during the training
process, acquire enough images so that one of the images can be reserved as a
validation image. This will give you a visual way of checking the results of the
training while it is in progress.

2. Load the images that you want to use as training images in your software.
l During the installation of your software some sample images have been
installed, too. You can follow these step-by-step instructions using the example
images.

Step 1: Creating training labels
All of the images that you want to use to train a neural networkmust have at least two
image layers. One image layer contains the image that was acquired of the objects you
want to identify. The other image layer contains the training labels that clearly define
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for the software the objects that you want to identify. You canmanually draw the
training labels on the image.

1. Activate the first image on which you want to define the training labels.
2. If the Training Labels tool window isn’t displayed, use theView > ToolWindows >

Training Labels command to show it.
3. In the Trainings Labels tool window, click theNew Training Label Class button.

l The last used training label classeswill be overwritten.

l A new training label class is created. The training label class is calledClass1
and the color of the first training label class is red.

l When you create a training label class, theUser Labels image layer is added to
the active image. All training labels will be defined on this image layer.

4. Enter a name for the training label class. To do this, double click theName name
cell in the table in the Training Label Classes group. For this example, name the
training label classBrightPhase.

5. If necessary, select theBrightPhase training label class in the Training label
Classes group. Click one of the buttons in the Training Labels group to switch to
the corresponding edit mode.
For example, click theCreate Training Labels - Fill button to automatically fill the
training label that you draw.
l The button becomes active, indicating which edit mode is active.

l The edit mode remains active until you explicitly end it.

6. While pressing the left mouse button, outline all of the segments in the image that
belong to the bright phase. You don’t have to be completely exact when you do
this. If the bright areas are not touching each other, you will need to define several
training labels.
l In this drawingmode, the training labels are automatically filled as soon as the
ends of the linemeet.

l The training label is drawn in theUser Labels image layer.

l The color of the training label corresponds to the color of the class to which it
belongs.

l The training labels are transparent when they are drawn. This ensures that the
objects under the training label remain visible.

The bright phase is indicated with a red training label.
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7. You can at any time correct the training labels that have been drawn. You can
delete whole training labels or just parts of them. You can expand training labels
and you can draw new training labels. To do this, select the training label class
and use the buttons in the Training Labels group.

8. Now define the second training label class,DarkPhase.
To do this, in the Trainings Labels tool window click theNew Training Label Class
button again.

9. Outline the second phase in the image. It’s ok for the training labels to overlap a
little.
If the training labels that have already been drawn are in the way, click the eye
icon in the row for theBrightPhase training label class. This will hide the
training labels that define the bright phase. Click in theVisible cell to show the
training labels again.

The required training labels have been defined on this training image. The training
labels belong to two different training label classes, one for the bright phase and one
for the dark phase. The image background is not allocated to either of the training label
classes.

10. Save the training label classes that have been defined. To do this, click this button
in the Training Label Classes group. Save the parameter set using the name
Phase Analysis.

11. Save the training image with the training labels that have been defined. To do so,
use the File > Save As command.

12. Load the next training image.
13. Click this button in the Training Label Classes group and load thePhase Analysis

parameter set.
14. Select one of the training label classes and draw the appropriate training labels in

the image.
When you train a neural network, the same training label classesmust be defined
in all of the training images. You don’t have to define a training label for every
training label class. The number of training labels in this training label class will
then be 0. This enables you to include in the training images images that only have
one of the phases you want to identify.

15. Load somemore images that you want to use as training images. For each image,
load thePhase Analysis parameter set again and draw the appropriate training
labels on the image.
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16. Release theCreate Training Labels - Fill button in the Training Labels tool window
to leave edit mode.

17. Save the training images.
l You can now use the training images to train a neural network.

Step 2: Training and saving a neural network
Use the training images from step 1 to train a neural network. You want the neural
network to detect bright and dark phases in an image.

1. Switch to theDeep Learning layout. To do this, click theDeep Learning tab at the
top right of the user interface.
l TheDeep Learning layout has been designed especially for training neural
networks. TheDeep Learning layout always has the same structure and fills
the whole user interface. You are not able to display any additional tool
windows or toolbars. You are also not able to hide any of the functions that are
displayed in the layout.

2. Click theNew Training button. You can find the button at the top left of theDeep
Learning layout.
l TheNew Training: Input andOutput dialog box opens.

Specifying the input and output for the training
Make the necessary settings in theNew Training: Input andOutput dialog box.

1. In theName field (1), enter a descriptive name for the neural network that you
want to create. For this example, you can name the trainingPhase Analysis.
In theDescription field, enter a good description of the new neural network.
l Your software continually checks the settings in theNew Training dialog box. If
a setting has not yet beenmade or if a settings is incorrect, a message appears
at the bottom right of the dialog box.
Before you have selected the images, amessage appears stating that no input
images have been specified yet. Thismessage disappears as soon as you add
the training images.

2. Click the [+] button in the Images group (3).
Navigate to the directory in which your training images are saved and select the
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training images.
Click theOpen button to load the training images.
l The imported training images are displayed in the Images group.

l The Training label classes group lists the training label classes that have been
defined for the training images.

4. Make sure that the check boxes next to classes 1 and 2 aremarked in the Training
Label Classes (3) group. This way both classeswill be taken into account by the
training process.

5. With phase analyses, a pixel can’t belong to two different phases at the same
time. For this reason, select themulticlass classification option in the Training label
classes group. The neural network will now allocate each pixel to the phase for
which its probability is the highest.

6. Keep the default settings in the Input channels group.
7. Click theNext button (4) to select themodel for the neural network.

l TheNew Trainings: Parameters dialog box opens.

8. TheDeep Learning software solution uses pre-configuredmodels for the neural
network. From theAvailable training configurations list, select themodel that you
want to use for the training process. To the right of the selectedmodel, you can
find a detailed technical description.
Which parameter set delivers the best results depends strongly on the application.
TheStandard Network parameter set is suggested for most standard tasks.
For this example, select theStandard Network parameter set.

9. The phases are easily recognizable in the training images. In this example, you
can reduce the duration of the training process. In the Training duration list, select
the Iteration limit entry.
Enter the required number of iterations in the field to the right of the Training
duration list. For this particular example, select 5000 iterations.

10. Click theStart button to start the training process.
l TheNew Training dialog box closes.

l You can follow the progress of the training in theDeep Learning layout.
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Observing the training of the neural network

TheDeep Learning layout will look similar to this while the training is in progress.

1. You can follow the progress of the training in theDeep Learning layout.
l The trainings that your have defined or already performed are listed in the
training list. When a new training begins, it is inserted into the top position in the
training list (1). The training that is in progress has theRunning status.

l The progress bar (2) showswhen the training is expected to finish. The
progress bar tells you the total number of iterations that have already been
performed, and how many are yet to come. The time remaining in the training
process is displayed next to it.

l Your software provides several quality indicators. These enable you to check
the quality of the neural network. TheSimilarity quality indicator is displayed by
default in the diagram (3). The diagram is refreshed constantly while the
training is in progress.
TheSimilarity value is between 0 and 1. The closer the value is to 1, the better
the prediction of the neural network is. In this example, the curve climbs and
approaches the value of 1. This curve shows that the neural network that is
being trained is finding the phases increasingly well.

l The neural network consists of a parameter set. This parameter set is varied
during the training and adapted to the training images. Your software saves the
current parameter set at regular intervals and uses it to create
checkpoints. You can use these to check the quality of the neural network. The
checkpoints are listed in theAvailable checkpoints (4) list.
In this example, checkpoint 1 is created after 1000 iterations. This checkpoint
reflects the development of the neural network's parameter set at 1000
iterations.

l The validation image (5) shows the result that belongs to the selected
checkpoint. Thismeans that, at checkpoint 1, the neural network analyzes the
validation image with the parameters that were calculated after 1000 iterations.
For the first checkpoint in the list, the calculation has not yet started. No neural
network has yet been calculated. The validation image shows one of the
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training imageswithout a probabilitymap. For each pixel, the probabilitymap
indicates the degree of probability that the pixel belongs to a class.

2. Take a look at the probabilitymap for one of the checkpoints that has already been
computed. You can select checkpoint 3 in theAvailable checkpoints list for
example.
l The preview window in theDeep Learning layout displays all of the image
layers in the validation image superimposed on top of each other. Use the
buttons over and under the validation image to show and hide the different
image layers.
The Training label classes (1) buttons under the validation image correspond to
the training label classes that have been defined. In this example, two training
label classes are active for the training job. The red training label class contains
the training labels for the bright phase. The green training label class contains
the training labels for the dark phase.
When you analyze an image using a neural network, the result is a probability
map. TheProbability (2) buttons correspond to the probabilitymaps for the
individual training label classes. A separate probabilitymap is created for each
training label class. Additionally, a probabilitymap is always created for the
background.

3. Click on one of the buttons to show or hide the corresponding image layer. You
can repeatedly click on the grayTraining label classes button under the validation
image.
l The training labels appear and disappear. This allows you to judge whether the
neural network belonging to the selected checkpoint is finding the phases as
wanted.

The illustrations show a validation image in theDeep Learning layout. In the image on
the left, the training labels and the probabilitymap are not displayed. In themiddle, the
training labels (1) are shown. On the right, the probabilitymap (2) is shown. The
probabilitymap largely correspondswith the training labels. Because the probability
maps for the two phases overlap, some areas in the probabilitymap are yellow
(overlap of red and green).

Saving a neural network
1. Wait until the neural network training is finished.
Note: You can continue to use your software while a training process is running. You
can also define additional training processes. The trainingswill then automatically be
performed one after the other.
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l After the training is finished, its status changes fromRunning toDone.

l The progress bar shows you that the training is finished.

2. Select the checkpoint at which the similarity is the highest. As a rule, it will be the
last checkpoint.

3. Click theSave Neural Network button. You can find the button above the
Available checkpoints list.
l TheSave Neural Network As dialog box opens.

4. Enter a descriptive name for the neural network in theName field. For this
example, use the namePhase Analysis.
Use theDescription field to describe the task and the training images being used.
If you want other users of your software to be able to use the neural network,
select thePublic option. Select thePrivate option if you want the neural network to
be available only to yourself.
Click theSave button.

5. You can now use thePhase Analysis neural network to detect andmeasure bright
and dark phases in images.

Step 3: Performing a phase analysis using the neural network
1. Acquire the images that you want to analyze. Select acquisition conditions that are

as similar as possible to those used to acquire the training images. For example,
select the same objectivemagnification and similar exposure conditions.

Note: You can of course apply the neural network to existing images. In this case, load
the image that you want to analyze.

2. Open theOptions dialog box by clicking theCount andMeasure Options button,
located in theCount andMeasure tool window.

3. Click theCount andMeasure > Classification entry in the tree view. Select the
Phase classification scheme. Now, all image segments that belong to one phase
also belong to one object class.

4. Click theCount andMeasure > Detection entry in the tree view. Select the
Borders - frame > Truncate option.

5. Select themeasurement parameters for the phase analysis.
In the tree view, click theCount andMeasure > Measurements entry.
Click theSelect Object Measurements button to select suitablemeasurement
parameters for the object measurement. Select theAreameasurement
parameter and close the dialog box.
Click theSelect ClassMeasurements button to select suitablemeasurement
parameters for the classmeasurement. Select theObject Class, Sum (Area) and
Area Fraction Objectsmeasurement parameters. Close the dialog box.
Close theOptions dialog box.

6. In theCount andMeasure tool window, click the small arrow next to the threshold
setting button. The button displays the number . Select theNeural Network
Segmentation
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command in themenu to open theNeural Network Segmentation dialog box.
7. In theNeural Network list (1) select thePhase Analysis neural network.

l In theNeural Network Segmentation dialog box, the training label classes are
listed in thePhases (2) group. In this example there are two training label
classes,BrightPhase andDarkPhase.

l Your software starts the analysis as soon as a suitable neural network has
been selected. This can take several minutes. Pay attention to the progress bar
located in the status bar.

l In the preview area (3) you can see which parts of the sample are defined as
first phase and which parts of the sample are defined as second phase. For the
display, the colors that are currently selected in theColor field are used.

Note: You can accelerate the computation of the preview image by reducing the size
of the preview area in the image window. To do this, drag one of the preview area’s
handles towards the center.

The illustration shows theNeural Network Segmentation dialog box and the preview
window.

8. Click theCount andMeasure button to get the results.
l The results are displayed in theCount andMeasure Results tool window in the
ClassMeasurements results view. For each phase, you see the area that this
phase takes up in the image.

The result of a phase analysis: The image that was analyzed (1) now has theDetected
Objects image layer (2) which contains the phases that were detected. The area
fraction of each phase is displayed in the results table (3). The class histogram (4)
shows the area distribution in a bar chart.
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Note: The phase analysis is also available in the analysis processes in theMaterials
Solutions tool window. TheDeep Learning solution can’t be used together with phase
analysis in theMaterials Solutions tool window.

00572 25022021
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7. Interactive measurements
7.1. Overview

Your software offers a wide range of measurement functions. They enable you to
quickly count objects andmeasure segments and areas. All the results will be saved
together with the image and can also be output as a sheet.

Prerequisite
For makingmeasurements, correctly calibrated images are an essential prerequisite.

Images that you have acquired with your software will have been automatically
correctly calibrated when you have specified the objective you used. If your system
has amotorized nosepiece or an encoder for the nosepiece, the correct magnification
is automatically read-out before the image acquisition.

Should the image not yet have been calibrated, use the Image > Calibrate Image...
command to carry out a calibration.

Additional measurement functions in your software
In addition to the interactivemeasurement functions, your software offers you a further
range of measurement functions.

Line Profile Use the Line Profile tool window tomeasure the intensity
profile along a line on an image.

3D Profile Use the 3D Profile tool window tomakemeasurements
on a height map.

Automatic
image analysis

You can detect and analyze objects in images with your
software.

Materials
Solutions

Use theMaterials Solutions tool window tomeasure an
image, or several images at the same time, according to
different material science analysis processes.

Selecting the measurement environment

Measuring with help of the tool window
Switch to theProcessing layout when you want to measure images. You can find the
Measurement and ROI tool window in the bottom section of this layout. In this tool
window you have fast access to all measurement functions and settingswhich effect
measurements. This tool window is at the same time themeasurement display and
contains all of the values that have beenmeasured on the active image.

Note: Should, right at the bottom of the user interface, several tool windows lie one
over the other, activate theMeasurement and ROI tool window, by clicking on the
header of the Measurement and ROI tab. The tabs can be found under the tool
windows.
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Starting a measurement
Begin ameasurement by selecting themeasurement function you want. You can find
themeasurement function in theMeasurement and ROI tool window, on the
Measurement and ROI toolbar, or in theMeasuremenu.

Working in the measurement mode
As soon as you have clicked ameasurement function, your software will automatically
switch to ameasurement mode. In themeasurement mode, your mouse pointer will
take on the shape of a cross on the image. A small icon indicating the selected
measurement function attaches itself to the bottom right of themouse pointer.

You canmake asmanymeasurements on the active image as you like using the
measurement function that has been selected. The continuousmeasurement mode is
valid for all loaded images. You can, therefore, easilymeasure numerous images one
after the other.

The selectedmeasurement function's button will keep its clicked appearance and in
this way show you the current measurement function. You can recognize this status by
the button's background color.

Finishing the measurement mode
You can explicitly switch off themeasurement mode. To do this, click on the active
measurement function's button again.

You automatically turn off themeasurement mode when you switch to a different
mouse pointer mode. For example, click theSelect Measurement Objects button to
switch to the selectionmode. You can find the button either in theMeasurement and
ROI tool window or on the toolbar. You can select and edit measurement objects in
thismouse pointer mode.

Changing the default measurement mode
The continuousmeasurement mode described above is preset by default. You can
change this default setting. To do this, use the Tools > Options... command. Select the
Measurement and ROI > General entry in the tree view. Select theSwitch to 'Select
Measurement Objects' mode after creating ameasurement object check box. Then,
when you have completed ameasurement, you will automatically leave the
measurement mode again. Thismeans you have to select themeasurement function
again before you start each interactivemeasurement.

Displaying and saving measurement results
Themeasurement results will be displayed directly on the image and in the
Measurement and ROI tool window. Should this tool window not be visible, use the
View > ToolWindows > Measurement and ROI command to display the tool window.

Saving the measurement results
Themeasurements will be saved along with the image, if you save the image in the
TIF or VSI file format. You can, however, also export themeasurement results in a
results sheet, and save this as a file.
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Showing and hiding measurement results in an image
Themeasurement results will be shown on the image in a special data layer, the
measurement layer. On your monitor, image andmeasurement layer are shown
together. The data of each, however, is individually stored if you use the TIF or VSI
image file format. Try and picture themeasurement layer as a transparencywhich is
placed over the image.When youmeasure an image, the image data will not be
changed by having themeasurement results displayed on it.

You can, at any time, hide or show themeasurement layers.
To do so, use the Layers tool window. There you have access to all of an image's
layers. The eye icon identifies all of the layers that are currently on display on your
monitor.
Click the eye icon in front of theMeasurement and ROI layer to hide the
measurements. Click an empty cell without an eye icon tomake the corresponding
layer reappear.

Creating an Excel report that displays the measurement results
You can create an Excel report that contains the image that wasmeasured aswell as
its themeasurement results. To do, click theCreate Excel Report button located on
theMeasurement and ROI tool window's toolbar. TheCreate Excel Report dialog box
opens. In this dialog box you select the Excel template and the data that you want the
Excel report to use.When you confirm your selection, theMS-Excel application
program opens and the report is displayed.

Editing measurements
You can edit existingmeasurement objects at any time. Themeasurement values in
theMeasurement and ROI tool window will be correspondingly updated.

Note: When you load an image file with measurement objects, it is only possible to edit
themeasurement objects if the image file has been saved in the TIF or VSI image file
format.

Selecting measurement objects
Before you can edit measurement objects, you have to select them. To do so, click the
Select Measurement Objects button, and then select themeasurement object(s). You
can find the button either in theMeasurement and ROI tool window or on the toolbar.

If the image is very large andmanymeasurement objects have been defined, it can be
difficult to find a particular measurement object in the image. In this case, select the
measurement object that you are searching for in theMeasurement and ROI tool
window. Click your right mouse button and select theNavigate toMeasurement
Object command in the context menu. Themeasurement object you are looking for is
then displayed in the image window.

Changing the position and size of measurement objects
You canmove a wholemeasurement object while keeping the left mouse button
pressed.
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You can also change the size of ameasurement object. Move the pointer onto a
marker. By dragging themarker with themouse button depressed, you can adjust the
frame's size aswished.

Change themeasurement object bymoving the handles.

Deleting measurement objects
Click the [Del] key on your keyboard in order to delete the selectedmeasurement
object. You can select measurement objects that you want to delete in the image and
also in the sheet in theMeasurement and ROI tool window.

Changing the color, font, and line thickness of individual measurement
objects
You can, at any time, change the color, font, and line thickness, of individual
measurement objects. Select one or moremeasurement objects in an image and click
your right mouse button to open a context menu. In the context menu you'll find the
following commands. You can use them to change the appearance of the selected
measurement objects.

Change Color
Helper Lines
Change Line Thickness
Change Font

Measuring in the live mode
All of themeasurement functions are also available in the live-image. You can
therefore, e.g., quicklymeasure a segment in the live-image.

When you finish the livemodewith theAcquire > Snapshot command, the
measurements that you carried out in the live-image are applied to the image that was
acquired.

Measuring on different image and document types

Measuring on image series
You can combine a series of individual images into one image.What results is a time
stack in which all of the frames have been acquired at different times, for example.

You canmakemeasurements on every frame. Display the required frame on your
monitor. To do this, use the navigation bar in the image window. Then carry out the
measurement on this frame. Themeasurement will be permanently linked to this
frame, i.e., themeasurement will only be displayed on your monitor when the frame on
which youmade thismeasurement is also on display.
Themeasurement results will be shown in theMeasurement and ROI tool window.
You can give everymeasurement the number of the frame on which it wasmade. For
time stacks, for example, you can do this using the Index (t)measurement parameter.
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Measuring on multi-layer images
With some functions, e.g., with the Image > Combine Color Images... function, amulti-
layer image will be created. Thismulti-layer image ismade up of several layers.

Measurements always apply to one image layer. For this purpose, show the image
layer on your monitor, on which you want to makemeasurements. To do so, use the
Layers tool window. Then carry out themeasurement on this image layer. The
measurement will be permanently linked to this image layer, i.e., themeasurement will
only be displayed on your monitor when the image layer on which youmade this
measurement is also on display.
Themeasurement results will be shown in theMeasurement and ROI tool window.
You can give everymeasurement the name of the image layer on which it wasmade.
To do this, use the Layermeasurement parameter.

Measuring on charts
Your software has its own chart document. A chart can be saved, edited and also
measured.
Use the Line Profile tool window tomeasure the intensity profile along a line on an
image, for example. In the tool window, click theExport to Chart button to export the
line profile to a chart.

As soon as a chart has become active in the document group, theMeasurement and
ROI tool window changes its appearance. From then on, only themeasurement
functions that you can use for charts are available.

Name of the
button Description

Horizontal Line In a chart, measure the horizontal distance between two
interactively determined points.

Multiple
Horizontal Lines

In a chart, measure the horizontal distance between a
reference line and an interactively determined point.

Measuring on images that contain height information
Your software supports images that contain height information. Use the 3D Profile tool
window to define a height profile on one of these height maps. You canmeasure the
height difference between two points on the height profile, for example. To do this,
define themeasurement object in the3D Profile tool window. Themeasurement
results will be shown in theMeasurement and ROI tool window. You can use all of the
measurement parameters that are of the 3D Line object type.
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The 3D profile line is shown in white in the image on the left. The 3D Profile tool
window displays the corresponding 3D profile (1). In theMeasurement and ROI tool
window, ameasurement object (2) has been created for the 3D line.

00150 22062017

7.2. Measuring images
Your software offers a wide range of measurement functions. They enable you to
quickly count objects, andmeasure distances and areas on an image.

The following step-by-step instructions present themeasurement functions to you by
way of several examples.

Measuring image objects interactively
Outputting variousmeasurement parameters
Measuring several images

Measuring image objects interactively
Example: You want to measure the filaments in a supraconductor.
To do this, load a suitable image, or acquire one. Measure the diameter of several of
the hexagonal filaments, in each case between the opposing vertices.
Subsequently edit themeasurement. Delete some of themeasurements you'vemade.
Enter the results in aMS-Excel sheet.

1. Use theView > ToolWindows > Measurement and ROI command to display the
Measurement and ROI tool window.
l You'll find the tool window at the lower edge of the user interface. It's possible
that it may be covered by theCount andMeasure Results tool window. Click
theMeasurement and ROI tab at the bottom of the user interface to bring the
tool window into the foreground.

Loading an image
2. Acquire an image or load one.
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l During the installation of your software some sample images have been
installed, too. You can follow these step-by-step instructions for measuring
images if you use the SupraConductor.tif example image.

Setting the labeling color
Themeasurement results will, in accord with the default settings, be written in red in
the image, without a background. This can be hard to read on some images. Change
the labeling settings.

3. Use the Tools > Options... command.
4. Click theMeasurement and ROI > Measurement Display entry in the tree view.
5. Click in theBackground Color field and choose a color, black for example.
6. Select the Text color > Fixed colors option and select a suitable color from the

palette. Select the color white to display themeasurements in white and the labels
in white on a black background.

7. Close the dialog boxwithOK.

Measuring lengths
8. Click theArbitrary Line button, located on the toolbar at the top of the tool

window.
9. Click with your left mouse button at the starting point and end point of the

reference distance.
10. If you havemeasured a reference distance, you can immediately proceed with the

next measurement.
11. Click the Arbitrary Line button again to end the lengthmeasurement.
12. Take a look at the results in the tool window and in the image.

l The illustration shows the image with three executedmeasurements.
Measurement 2 has been selected.
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Deleting measurements
13. Click one of themeasurement results in theMeasurement and ROI tool window.

l The corresponding line will be selected in the image.

14. Press the [Del] key.
l Themeasurement will be deleted both in the image and in the tool window.

l When ameasurement has been deleted, the image and the tool window
contain onemeasurement less. The IDs of the remainingmeasurements won't
be changed by the deletion of ameasurement.

Note: When you've finishedmaking themeasurement, you should switch off the
measurement mode, since you could otherwise accidentally select your
measurements andmove them.

15. Checkwhether one of the buttons on theMeasurement and ROI tool window's
toolbar appears clicked. Release this button

Exporting results to MS-Excel
16. Click theExport to Excel button.
17. In the In/Output dialog box you set up the directory in which the data is to be

saved, and enter the name of theMS-Excel sheet. Adopt theExcel-Sheet (*.xls)
file type.

18. Click theSave button to have theMS-Excel sheet with themeasurement results
saved.

Closing the image
19. Click the small button showing a cross [ x ], located at the right of the image name

in the document group.
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l You have changed the image because you've added interactive
measurements. For this reason, you'll receive a query whether you wish to
save the image or not.

20. Save the image in the TIF or VSI file format. Themeasurements will then also be
saved in the image file. They can at any time, be edited deleted or augmented.

Outputting various measurement parameters
Example: You want to measure the filaments in a supraconductor.
Measure the hexagonal structure as a circular surface. Have a variety of
measurement parameters, such as the area, the perimeter and the diameter, output.
Have the diameter shown in the image.

1. Acquire an image or load an image, the Supraconductor.tif example image, for
example.

Measuring areas
2. In theMeasurement and ROI tool window, click the 2 Point Circle button.
3. Left click the center point of the hexagonal structure that you want to measure.
4. Move your mouse, and in the process drag out the circle. Match the circular object

as well as possible to the hexagonal structure. Click the left mouse button.
5. Click the 2 Point Circle button again, and switch off themeasurement mode.
6. Take a look at the result in theMeasurement and ROI tool window.

l The illustration shows the image with a circle measured.

Viewing the list of measurement parameters
7. In theMeasurement and ROI tool window, click theSelect Measurements button.

l In the dialog box you'll see a list with all of the availablemeasurement
parameters. At the bottom of the dialog box you'll see a list of themeasurement
parameters that are currently calculated for all objects.
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Outputting additional measurement parameters
8. Go to the list of all of the available parameters, then click theDiameter

measurement parameter.
l On the right, an illustration shows you how the parameter is calculated.

You can see that there are different ways in which the diameter of a 2D object
can be calculated.

9. Click theMean entry in the list under the illustration, to select theMean (Diameter)
measurement parameter. When you do this, themean value of all of the possible
diameters is determined.

10. Click theAdd 'Mean (Diameter)' button.
l Thismeasurement parameter will be added to the list of measurement
parameters to be calculated. All of thesemeasurement parameters will be
displayed in the tool window.

11. Close the dialog boxwithOK.
12. Take a look at the result for the circle's diameter in theMeasurement and ROI tool

window.

Outputting measurement parameters in the image
13. Open theSelect Measurements dialog box.
14. At the bottom of the list of all of the calculatedmeasurement parameters, click the

Mean (Diameter)measurement parameter.
15. To the right of this list you'll see a button with a blue arrow . Click this button to

move themeasurement parameter to the top of the list.
16. Close the dialog boxwithOK.
17. Take a look at the result for the circle's diameter in the image.
Note: Themeasurement display in the image has to be updated once, so that the
settings that have been changed are also taken into account. You update the
measurement display, for instance, by adding another measurement, or by once
selecting an existingmeasurement in the image.

Measuring several images
Example: You want to measure the thickness of a spray coating. To do so, you acquire
several images of the coating. Have the results from all images displayed
simultaneously. Take a look at themean value for all of themeasurements.
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Loading images
1. Acquire or load some images.

l During the installation of your software some sample images have been
installed, too. You can carry these step-by-step instructions out directly with the
example images SprayCoating2.tif and SprayCoating4.tif.

Measuring the layer thickness
2. Activate the first image in the document group.
3. Click theArbitrary Line button, located on the toolbar at the top of the

Measurement and ROI tool window. Measure the thickness of the layer at several
different places.

4. Activate the next image. Measure the thickness of the layer at several different
places, here also.

5. Click theArbitrary Line button again, and switch off the lengthmeasurement.
l The layer's thickness has beenmeasured on both images.

Displaying the measurement results of all of the images
6. In theMeasurement and ROI tool window, click theMeasurement and ROI

Options button.
7. In the tree view, select theMeasurement > Results entry.
8. Clear theShow measurement objects > Only of the active image check box.
9. Close the dialog boxwithOK.

l Now, the results for both imageswill be shown simultaneously in the tool
window.

l Use theDocumentmeasurement parameter to display the name of the image
with which themeasurement results are associated in the results sheet. Now
you canmatch themeasurement results unambiguously to an image, even if all
measurement results are displayed together in the tool window.
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Viewing statistical parameters
10. In theMeasurement and ROI tool window, click theMeasurement and ROI

Options button.
11. Select theMeasurement and ROI > Results entry in the tree view.

l In theStatistics group, you can find various statistical parameters.

12. Select theMean check box.
13. Close the dialog boxwithOK.

l Now, in theMeasurement and ROI tool window under themeasurement
results, the chosen statistical parameter (1) will by shown. You can see there
themean value of the layer thickness for all of themeasured images.

00154

7.3. Measuring welds
Measuring the cross section of a weld is amethod commonly used for judging a weld's
quality. With theWeldMeasurement solution you can interactivelymeasure
microscope images of weld cross-sections and can output the results on the image
and in a table. The followingmeasurement functions are available:

Multiple perpendicular
lines

Use this measurement function, to determine the
distance from several measurement points to a
reference line.

Asymmetry Lines

Use this measurement function, to construct the
perpendicular bisector of the connection between two
reference points, and to determine the distance of a
measurement point from the perpendicular bisector.

Throat thickness Use this measurement function, to determine the
thickness of a fillet weld's throat.

Starting a measurement
Youwill find the weldmeasurement functions in theMeasuremenu, or as a button on
theMeasurement and ROI tool window or toolbar. Start a measurement, e.g., by
clicking the corresponding button.
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Interactive measurement functions and weld measurements
The functionswhich you can use tomeasure welds, behave just like the other
interactivemeasurement functions offered by your software, e.g. theArbitrary Line
measurement function. All of the information on the interactivemeasurement functions
also applies for themeasurement of welds.

10802

7.3.1. Measuring a throat thickness
Use the Throat thicknessmeasurement function to determine the thickness of a fillet
weld's throat. You will find themeasurement function in theMeasuremenu, or as a
button on theMeasurement and ROI tool window or toolbar.

Prerequisite: The Throat Thicknessmeasurement function will only be available if you
purchased theWeldMeasurement solution together with your software.

Measuring a throat thickness
1. If necessary, use theView > ToolWindows > Measurement and ROI command to

have theMeasurement and ROI tool window displayed.

Loading an image
2. Acquire an image or load one.

The illustration shows a cross section of two welded pieces of metal. The weld is
circled.
How thick is the weld's throat?

3. Set a zoom factor for your image window that will make the image segment that is
to bemeasured clearly visible. You will achieve themost precisemeasurements if
you set the zoom factor at 100%.

Measuring the throat thickness (with a welded root)
4. Start themeasurement. To do so, click the Throat Thickness button, on the

toolbar at the top of the tool window.
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With four mouse clicks (1-4), define two lines along the inner surfaces of themetal
pieceswhich are welded together.

5. Click on a point on the inner surface of the first piece of metal (1). This point should
be a far as possible from the weld's root. You can put themeasurement point
before or after the weld.
l The point which you define will be shown in the image with a handle.

l Themouse pointer's shape on the image window showswhichmeasurement
mode you are in.

6. With threemoremouse clicks (2-4), define two lines along the inner surfaces of
themetal pieceswhich are welded together.
l Your software will now automatically display some lines and handles in the
image window.

l Themouse pointer is now linked to an auxiliary line, which is perpendicular to
the bisector of the angle. When youmove themouse you will move this line at
the same time.

Once the inner surfaces are defined (yellow lines), the position of the root (1) will
automatically be drawn in and your software will calculate the bisector of the angle (2).
Together with the handle (3), move the line (4) which is perpendicular to the bisector of
the angle to determine the throat thickness.

7. Move the auxiliary line (4) to the outer surface of the weld. The part between the
two lines shown in yellow abovemust be just inside the cross-section of the weld
along the entire length.
l Themeasurement of the throat thickness is thus complete. The Throat
Thicknessmeasurement object (an equilateral triangle) is completely defined.
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l The throat thickness (the height of the triangle) will be shown in the image. In
theMeasurement and ROI tool window table, a new measurement value with a
type of Throat Thicknesswill be entered.

Note: If themeasurement results are not shown, check themeasurement parameters
currently displayed. You will find step-by-step instructions tomodify themeasurement
parameters further down.

8. Take a look at the result in theMeasurement and ROI tool window and in the
image.

The illustration shows an enlargement of the weld with themeasurement object (an
equilateral triangle). The result of themeasurement is the throat thickness (1) (the
height of the triangle). The auxiliary line (2) (the base of the triangle) must be
positioned so that it just lies completely within the weld.

Measuring the throat thickness (when the root is exposed)
If the root of the weld is exposed, another step will be required tomeasure the throat
thickness.

9. Select themeasurement object.
To do so, click theSelect Measurement Objects button to switch to a selection
mode and then click on themeasurement object in the image window. You can
find this button, e.g., on theMeasurement and ROI tool window's toolbar.
Directly after a throat thicknessmeasurement, themeasurement object will
automatically be selected.

10. Click on the vertex.
11. Keep the left mouse button pressed and drag the vertex towards the outer seam

of the weld towards the base of the triangle). In this way you aremoving a second
auxiliary line. This auxiliary linemust also lie with its full length just within the
weld's cross section.
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If the root of the weld is exposed, drag another auxiliary line (3) from the vertex (1).
The throat thickness is now the distance (2) between the two auxiliary lineswhich are
perpendicular to the bisector of the angle.

Saving the image
12. Save the image in the TIF or VSI file format. Themeasurements will then also be

saved in the image file. They can at any time, be edited deleted or augmented.

Finishing the measurement
13. You can now measure other images.
14. If the Throat Thickness button is still active, click on the button again to finish

measurement mode.

Changing settings for a throat thickness measurement

Adjusting measurement parameters
During each interactivemeasurement, significantlymore values aremeasured than
can be shown in the image or in theMeasurement and ROI tool window. To alter the
measurement parameters shown, follow these step-by-step instructions.
In particular, ensure that at least the Length andAnglemeasurement parameters are
displayed, as they are both used for the throat thicknessmeasurement.

1. In theMeasurement and ROI tool window, click theSelect Measurements button.
l TheSelect Measurements dialog box opens. In the dialog box, at the top left,
you'll see a list with all of the availablemeasurement parameters. At the bottom
of the dialog box, you'll see a list of themeasurement parameters that are
currently calculated and displayed for all objects.

1. In theAvailablemeasurements list, click on theMeasurement column title to
alphabetically sort all of the parameters.

2. Select the Lengthmeasurement parameter in theAvailablemeasurements list.
Thismeasurement parameter corresponds to the throat thickness.

4. Click theAdd 'Length' button to have the Lengthmeasurement parameter added
to the list of calculatedmeasurement parameters.

5. Also add theAngle parameter to the list of calculatedmeasurement parameters.
6. You can now further modify the display of themeasurement parameters for a

throat thicknessmeasurement. You can for instance delete all other
measurement parameters currently shown, so that the list of themeasurement
results becomes clearer.
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7. Close the dialog boxwithOK.
8. Do a throat thicknessmeasurement and examine the result in theMeasurement

and ROI tool window.

Displaying measured angles in addition to the throat thickness in the
image

By default, for a throat thicknessmeasurement, themeasurement will be shown in the
image. You can also output the angle between the two pieces of metal which have
been welded together in the image.

1. Carry out a throat thicknessmeasurement or load an image which contains a
throat thicknessmeasurement.

2. Select themeasurement object on the image. For example, select the
correspondingmeasurement in theMeasurement and ROI tool window.

3. Click the right mouse button and select theCreate Angle command in the context
menu.
l In addition to the throat thickness, the anglemeasured will also be shown in the
image.

l This command creates another measurement object of typeAngle. In the
Measurement and ROI tool window you will thus see two entries for the
measured weld.

Note: Themeasurements on a screen will automatically be numbered in sequence.
The anglemeasurement will thus always have a different measurement ID from the
associated throat thicknessmeasurement. You can switch off the display of the
measurement IDs, if you find their display distracting. To do so, open the Tools >
Options > Measurement and ROI > Measurement Display dialog box, and clear the
Show ID check box.

4038

7.3.2. Measurement object - Asymmetry Lines
Use theAsymmetry Linesmeasurement function to construct the perpendicular
bisector of the connection between two reference points and to determine the distance
of ameasurement point from the perpendicular bisector. You will find the
measurement function in theMeasuremenu, or as a button on theMeasurement and
ROI tool window or toolbar.

Prerequisite: TheAsymmetry Linesmeasurement function will only be available if you
purchased theWeldMeasurement solution together with your software.

1. If necessary, use theView > ToolWindows > Measurement and ROI command to
have theMeasurement and ROI tool window displayed.

Loading an image
2. Acquire an image or load one.
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3. Set a zoom factor for your image window that will make the image segment that is
to bemeasured clearly visible. You will achieve themost precisemeasurements if
you set the zoom factor at 100%.

Measuring asymmetry
4. Start themeasurement. To do so, click theAsymmetry Lines button, on the

toolbar at the top of the tool window.

The illustration shows a cross section of two welded pieces of metal. How asymmetric
is this weld? Click on the two reference points (1) and (2) in turn. Your software will
automatically calculate the perpendicular bisector as a reference line for the
measurement of the asymmetry (3).

5. With the left mouse button, click on two reference points in turn.
The perpendicular bisector of the connecting line between these two reference
points is the reference line for themeasurement of the asymmetry.
In the example shown, the reference points define the width of a weld. The
reference points in the example shown lie horizontally next to one another. They
could just as well have any orientation in the image.
l The points which you define will each bemarked in the image.

l Themouse pointer's shape on the image window showswhichmeasurement
mode you are in.

l Themouse pointer is now linked to an auxiliary line, parallel to the
perpendicular bisector. When youmove themouse you will move this line at
the same time.

6. Left click ameasurement point to measure its distance from the reference line.
l The result of themeasurement will be shown in the image.
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Define ameasurement point (1). The distance between the point and the reference
line will bemeasured.

7. If required, you can also define other measurement points. For each
measurement point defined, the distance to the reference line will bemeasured.

Undoing measurement points
8. As long as themeasurement is not yet finished, you can undo individual

measurement points, if you havemade amistake in themeasurement. To do that,
press [backspace] on your keyboard.

Note: If themeasurement results are not shown, check themeasurement parameters
currently displayed.

Finishing the measurement
9. Click the right mouse button to end themeasurement.

l In theMeasurement and ROI tool window table, a new entry with a type of
Asymmetry Lineswill be shown.
Please note that all of themeasured distances belong to a singlemeasurement
object. In theMeasurement and ROI tool window table theremay, under
certain circumstances, be several lengthmeasurements assigned to a single
entry in the Type orName column.

10. You can now measure other images.
11. If theAsymmetry Lines button is still active, click on the button again to finish

measurement mode.

Saving the image
12. Save the image in the TIF or VSI file format. Themeasurements will then also be

saved in the image file. They can at any time, be edited deleted or augmented.
4037
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8. Images containing height information
What is a height map?
Your software can use a series of images focused at different depths (Focus series) to
calculate a resulting image (EFI image). This resulting image will be in sharp focus
throughout. In addition to an EFI image, you can also create a height map. The height
map shows you your sample's topography. It shows, for every pixel, fromwhich frame
in the Z-stack the pixel has been taken. The Z-position thereby determines the pixel's
intensity value. A dark pixel comes, e.g., from a framewith a low Z-value. A bright pixel
comes from a framewith a high Z-value.

The image on the left shows an EFI image of diamonds. The image on the right shows
the corresponding height map. Low-lying structures can be recognized by their dark
gray values, structures that lie higher, by their light gray values.

Height maps
l Creating an EFI image and a height map from a Z-stack
l Creating a height mapwhile acquiring an EFI image
l Displaying a height map in the image window

3D-surfaces
l Creating the 3D-surface
l Changing the appearance of the 3D-surface
l Creating an image of the 3D-surface

Measuring heights
l Creating andmeasuring height profiles
l Measuring heights interactively
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8.1. Creating an EFI image and a height map from a Z-stack
Example: From a Z-Stack that shows diamonds at different focus positions, calculate
the EFI-image including a height map.

1. Load the Z-stack fromwhich you want to calculate an EFI image.

The image shows three diamonds, seen through a reflected light microscope. In the
process, imageswere acquired at different focus positions. In the illustration, the Z-
stack is displayed in the tile view. You can easily recognize how the focal plane travels
from the bottom upwards. In image 1 the background is sharply reproduced. In image
6 the surface of the diamonds is sharply reproduced.

2. Use theProcess > Enhancements > EFI Processing… command.
3. Select theApply on > All frames and channels option.
4. From theAlgorithm field select theReflected light entry.
5. Select theHeight map check box.
6. Select theCreate new document as output check box.
7. Close the dialog boxwithOK.

l A new image document will be created in the document window. You can see
the EFI image with the diamond's texture. In the EFI image, the image
background aswell as the upper surface of the diamonds are in focus.

l The resulting image is amulti-layer image and is therefore accompanied by this
icon in the image window's title.

l The height map is a layer of the EFI image. The texture imagemakes up the
second layer. Use the Layers tool window to view the structure of the image.
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The illustration shows, on the left, the EFI image of the diamonds. On the right, you
can see the Layers tool window with both of the image layersHeight map (1) and
Texturemap (2).

8.2. Creating a height map while acquiring an EFI image
Example: Use the Instant EFI acquisition process to acquire a height map together
with the EFI image.

Prerequisite: Your stagemust have amotorized Z-drive or a Z encoder.

Selecting the acquisition process
1. Use theView > ToolWindows > ProcessManager command tomake the

ProcessManager tool window appear.
2. Select theManual Processes option.
3. Click the Instant EFI button.

l The button will appear clicked. You can recognize this status by the button's
colored background.

l The Instant EFI group will be automatically displayed in the tool window.

Setting the acquisition parameters
4. From theAlgorithm list, select theReflected light entry, when you use your light, or

stereomicroscope in the reflected light mode.
5. If you work with a stereomicroscope, select theAutomatic frame alignment check

box.
If you don't work with a stereomicroscope, clear theAutomatic frame alignment
check box.

6. Select theHeight map check box.
l Now a height map is automatically computed together with the EFI image.

Preparing EFI acquisition
7. Use theView > ToolWindows > Camera Control command tomake theCamera

Control tool window appear.
8. In theCamera Control tool window, click the Live button.
9. In the live-image, move themicroscope focus to the Z-position where either the

lowest or the highest position on the sample is only just out of focus.
10. Check the exposure time, and correct it if necessary. When the Instant EFI

acquisition process has been started, the exposure time will be kept constant
during the whole of the acquisition.
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Acquiring an EFI image
11. In theProcessManager tool window, click theStart button.

l The live-image in the document group will divide itself into 3 images. On the
bottom right, you'll still see the live-image (3). On the bottom left, you'll see the
sharpnessmap (2). The large image above them is the composite resulting
image (1). The 3 imageswill be continually updated.

12. Use your microscope's Z-drive tomove your stage slowly through the height
range of the sample's surface.
l Your software will acquire images at the various focal planes, then it will set
them together. While this is being done, the camera will acquire the images as
quickly as possible. The sharpness value of individual pixels will be calculated
for every image. If the sharpness values are higher than in the previous
images, the pixels in the composite EFI image will be adopted. The EFI image
contains the pixels with the highest sharpness values from all of the images
acquired up till then.

l The sharpnessmap at the bottom left will show you which image areaswill be
sharply reproduced in the EFI image. The brighter a pixel is in the sharpness
map, the higher is its sharpness value in the EFI image.

l Once the acquisition process has been started, the sharpnessmap should only
be bright at the deepest or highest parts of the sample, the rest of themap is
dark.

13. Focus on the sample slowly once through all the focal planes.
After each change of the focus position, wait until you see that further areas
become brighter in the sharpnessmap.
l As the process continues, more andmore areas in the sharpnessmap should
become brighter. At the same time the EFI image will also get better and better.

14. Check the EFI image and the sharpnessmap. Are all areas of the image now
sharp? Are there any areas in the sharpnessmap that are still dark?
Focus on these areas and have additional images calculated into the EFI image.
Continue acquiring additional images until the whole sample has been sharply
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reproduced.
15. In theProcessManager tool window, click theStop button.

l The resulting image is amulti-layer image and is therefore accompanied by this
icon in the image window's title.

l The EFI image will be automatically saved. You can set the storage directory in
theAcquisition Settings > Saving > ProcessManager dialog box. The preset
file format is VSI.

16. In theCamera Control tool window, click the Live button again to release it.

8.3. Displaying a height map in the image window

Switching between the EFI image and the height map
Prerequisite: The navigation bar is displayed in the image window. This is the default
setting.

1. Load an EFI image with a height map.
l An additional button is now shown in the image window's navigation bar.

2. In the image window's navigation bar, click theShow texture layer or show height
map layer button to switch between the EFI image and the height map in the
image window.

There is amulti-layer image composed of two layers in the document window. The
image on the left shows the texture image. The image on the right shows the
corresponding height map. Low-lying structures can be recognized by their dark gray
values, structures that lie higher, by their light gray values. Use the button on the
image window's navigation bar to switch between the two images.

Displaying the intensity calibration in the image
The height map is calibrated in Z-direction. You can display a color bar showing the Z-
calibration in the image.

1. Display a height map in the image window.
2. Use the Tools > Options command, and select theColor Bar > General entry in

the tree view.
3. Select theApply intensity calibration check box.

Clear theShow for pseudo color mode only check box.
4. In thePosition group, select where in the image window you want the bar with the

calibrated intensity values to be shown. Click this button to show the bar on the left
of the image, for example.
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5. Close theOptions dialog boxwithOK.
6. Use theView > Color Bar command to display a bar with the intensity calibration

in the image window.

A bar with the intensity calibration is displayed in the height map. The color bar tells
you which height a gray value represents. For example, the white areas in the image
have a height of 300 µm.

Switching between the EFI image and the height map when the
navigation bar isn't shown.
1. Use theView > ToolWindows > Layers command tomake the Layers tool

window appear.
2. In the Layers tool window, click the [+] sign (1) and open the image's layers.

l You can now see the image's individual layers: height map (2) and texture
image (3). The height map can't be seen in the image window, because it's
absolutely transparent at themoment.

3. Select the height map in the Layers tool window.
4. Click theSet Layer Opacity (4) button, located on the toolbar at the top of the tool

window.
5. Drag the slider all the way to the right, to an opacity of 100%, then take a look at

the height map.
6. Activate a layer and click its eye icon tomake it disappear. By doing this, you

can, e.g., view only the height map or the EFI-image.
7. Click an empty cell without an eye icon tomake the corresponding layer reappear.
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8.4. Creating the 3D-surface
Your software enables you to display the height map three-dimensionally. To do so,
use theSurface View image window view.

1. Click the small arrow next to the last button on this navigation bar to open amenu
with commands you can use with image window views.

2. Use theSurface View command to switch to that image window view.
l In the image window, the height map is now displayed as a 3D-surface.

3. Use theView > ToolWindows > Surface View command tomake theSurface
View tool window appear. Use this tool window, to configure the Surface View.

The illustration shows, on the left, the height map, and on the right, the 3D-surface.
Pay attention to the navigation bar in the image window. There, you can find the
buttons for switching between the image window views.When the height map can be
seen in the image window, you'll see the button for switching to the Surface View.
When the Surface View is shown, you'll see the button for switching to the Single
Frame View.

Note: The functions in theSurface View tool window are only available for theSurface
View image window view.When another image window view is active, for example,
the Single Frame View, this tool window will be empty.
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8.5. Changing the appearance of the 3D-surface
There are several ways in which you can change the way a 3D-surface is displayed.
To do so, use theSurface View tool window.

Moving the 3D-surface
1. In theSurface View tool window, you can find theNavigation group. Use the slide

controls in this group to rotate, or tilt the 3D-surface, or to change its size.
Take a look at the diamonds from different angles of vision.

2. Alternatively, you can, while keeping the left mouse button depressed, also tilt and
rotate the 3D-surface in the image window.
To do this, right click on the image window, and use the context menu'sZoomwith
Mouse andRotate with Mouse commands.

Smoothing the 3D-surface
1. Right click on the image window, then use theGlobal Surface View Options...

command.
l TheOptions > Surface View > Filter dialog box opens.

2. Select thePerformGaussian blur filter check box in theSmooth data group.
3. In theRadius field, enter 5. The larger the value entered here is, the greater is the

smoothing effect.
4. Close the dialog boxwithOK.

Changing the appearance of the 3D-surface
TheSurface View tool window offers several possibilities for changing the appearance
of the 3D-surface.

1. In the Intensity Processing group, you can alter the surface's relative height.
Reduce, e.g., the value in theStretch height by factor field. Set the relative height
in such a way that the diamonds look as realistic as possible.

2. You can change the 3D-surface's texture and color. To do so, click this button on
theSurface View tool window's toolbar.
l TheSurface Color Settings dialog box opens.
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3. From theColor mode list, choose, e.g., theSingle color height-shaded entry to
have the surface displayed in one color. In the process, the height-shading takes
care that the surface still has a three-dimensional appearance.
Then select theSingle color selection > Arbitrary color option. Select the color you
want from the color palette.
Watch how the display of the 3D-surface changes in the image window.

4. Close theSurface Color Settings dialog box.
5. Change the background color in the image window. Select the background color

you want, in theColors group, located in theSurface View tool window.

6. You can show and hide the coordinate system and also change the appearance of
the coordinate system. To do so, click this button, located on theSurface View tool
window's toolbar.

l The coordinate system is always displayed behind the 3D-object. When you
rotate 3D-objects, the position of the coordinate system automatically changes
too.

l A small yellow point indicates the origin of the coordinate system,
independently of the current orientation of the coordinate system.

Displaying the color bar on the 3D-surface
1. Click this button on theSurface View tool window's toolbar.

l TheSurface Color Settings dialog box opens.

2. Select the Lookup table entry from theColor mode list to select a pseudo color
scheme for the 3D-surface.

3. Select theColor ramp option in the Lookup table selection group.
4. In the Features group, select theShow color bar check box.

l Every value on the height map is now allocated a color value.

l The color bar tells you which colors represent which heights. The color bar is
automatically positioned on opposite sides of the coordinate system.
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8.6. Creating an image of the 3D-surface
1. Create a 3D-surface and adjust its appearance until you're happywith it.
2. Right click on the image window, then use theCreate Image fromView…

command from the context menu.
3. Select the settings you want.
4. Click theCreate button to create, in the image window, an image with a similar

appearance from the current reproduction of the 3D-surface. Use this command,
if you require an image of the 3D-surface for a presentation or for documenting
your work.

5. Activate the image window with the Surface View. Close theCreate Image From
View dialog box.

8.7. Creating and measuring height profiles
Example: You have created an EFI image and a height map of the surface of a screw.
Measure the distance between the ridges of the thread at different positions on the
screw.

Note: If you want to measure a height map that wasn't computed using the EFI
algorithm, you can use the 3D Line interactivemeasurement function. You can find
step-by-step instructions further below.

1. Load the EFI image with its height map.
l The illustration on the left shows the EFI image of the screw. On the right is the
3D-surface displayed with a pseudo color scheme. You can see that three
threads are shown in the image. The white arrow indicates roughly the same
position on the surface in both images.

Setting up the user interface
2. If necessary, use theView > ToolWindows > Measurement and ROI command to

have theMeasurement and ROI tool window displayed.
3. In theMeasurement and ROI tool window, click the 3D Profile Measurement

button.
l The 3D Profile tool window is appears. The tool window is empty.

l By default, the 3D Profile tool window is placed on top of theMeasurement and
ROI tool window.
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l The 3D Profile Measurement button in theMeasurement and ROI tool window
appears clicked, indicating that the 3D Profile tool window is shown. You can
recognize this status by the button's colored background.

4. Tool windows can only bemoved in the expert mode. Therefore, switch to the
expert mode.
To do this, use the Tools > Options command. In the tree view, select the
Environment > General entry. Select theExpert mode option in theUser interface
group.
Close the dialog boxwithOK.

5. Arrange the 3D Profile andMeasurement and ROI tool windows side by side. You
can do this by dragging theMeasurement and ROI tool window to a different
position. To do this, you have to click on the tab's header located below the tool
windows.

The 3D Profile andMeasurement and ROI tool windows are both positioned at the
lower edge of the user interface (1). Grab one of the tool windows by its header and
drag it to a different position, above the other tool window for example.

Creating a 3D profile
6. Click theArbitrary 3D Profile Line button in the 3D Profile tool window.
7. In the image window, specify the position of the 3D profile line with two clicks of

themouse. Define the 3D profile line in this image to run perpendicular to the
threads.
l You can see the 3D profile line in the image window. The 3D profile line has
two control points that you can use to change the position of the 3D profile line,
if required. The arrow indicates the orientation of the 3D profile's X-axis. The
3D profile's origin is at the end of the 3D profile line opposite to the direction of
the arrow.

l The 3D profile is now displayed in the 3D Profile tool window. In this example,
you can clearly see the three threads.

l In the 3D Profile tool window, the 3D Profile LineMeasurement button
becomes active-

OLYMPUS Stream UserManual 112



8.  Images containing height information
8.7.   Creating andmeasuring height profiles

l AnArbitrary Profile Linemeasurement object is automatically created in the
Measurement and ROI tool window. The actual measurement results,
however, are not yet displayed.

The 3D profile line is shown in white in the image on the left. The 3D Profile tool
window displays the corresponding 3D profile (1). In theMeasurement and ROI tool
window, ameasurement object (2) has been created for the 3D line.

Measuring a 3D profile
8. Click the 3D Profile LineMeasurement button in the 3D Profile tool window.

l You are now inmeasurement mode.

l The button becomes active, indicating that you are now inmeasurement mode.

9. Left click on two points on the 3D profile. The order of the clicks determines the
orientation. In this example, click on one of the lowest points and the nearest
highest point to measure both the depth and half of the distance between two
ridges of the thread.

10. Repeat thismeasurement for all of the distances that you want to measurement
on the 3D profile.
l Themeasurements are now displayed in the 3D profile in the 3D Profile tool
window.

l In the image window, the distances that weremeasured are displayed on the
3D profile line. Eachmeasured distance has two control points that you can
use to change its length, if required.

l Measurement values for eachmeasured distance are now displayed in the
Measurement and ROI tool window. All of themeasurement values belong to
onemeasurement object.

11. In theMeasurement and ROI tool window, click theSelect Measurements button
to display themeasurement parameters you want.
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The image shows a height map on which a 3D profile line has been defined (the blue
line). The chart in the 3D Profile tool window (below) shows the 3D profile. Two
measurements were performed on the 3D profile (1) and (2). Themeasurement is
displayed in the image and in the tool window's chart.

The illustration shows a 3D profile on which two points have been defined. The
measurement parameters that you canmeasure are shown: (1) 3D Intensity
Projection, (2) 3D Length, (3) 3D Image Plane Projection, (4) 3D Angle.

Performing additional 3D measurements
12. If you want, define additional 3D profile lines on the image. You canmeasure

several distances on each new 3D profile line.
l In the 3D Profile tool window, only the 3D profile and themeasured values of
the active 3D profile line are displayed.

l The control points indicate which is the active 3D profile line. In the
Measurement and ROI tool window, themeasurement object belonging to the
active 3D profile line is highlighted.

13. If you want to view a different 3D profile, click theSelect Measurement Objects
button. Then select the corresponding 3D profile line in the image window.
Alternatively, you can also select themeasurement object belonging to the 3D
profile line that you want to view in theMeasurement and ROI tool window
l The selected 3D profile is displayed in the 3D Profile tool window.
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Three 3D profile lines have been defined on the height map. That's why three
measurement objects are displayed in theMeasurement and ROI tool window.
Because two distancesweremeasured on each 3D profile line, themeasurement
object contains two sets of measurement values.
The 3D Profile tool window displays the active 3D profile (themiddle line).

Displaying and saving measurement results
14. To export themeasurement values, click theExport to Excel button in the

Measurement and ROI tool window.
15. To export the 3D profile, click theExport to Excel button or theExport to chart

button in the 3D Profile tool window.
16. Save the image in the TIF or VSI file format. Themeasurements will then also be

saved in the image file.

8.8. Measuring heights interactively
Example: To be able tomake height measurements, you need to have an image
whose intensity values have been calibrated. This could be an EFI image with a height
map or a gray-value image that you have calibrated using the Image > Calibrate
Intensity command.
Use the Clockwork.tif multi-dimensional image and use the EFI algorithm to calculate
the height map. Measure the height difference between the brass-colored gear wheel
in themiddle image segment, and the silver-colored gear wheel on the right-hand side
of the image.

Note: Use the 3D Profile tool window if you want to perform extensive 3D profile
measurements on a height map. You can find step-by-step instructions above.
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1. Load the Clockwork.tif image.
l TheClockwork.tif image is a Z-stack. The works of a clockwas analyzed under
a reflected light microscope. In the process, images of the workswere acquired
at different focus positions.
In the illustration, the Z-stack is displayed in the tile view. Note the brass gear
wheel that is only sharply reproduced in themiddle of the Z-stack.

Creating a height map
2. Use theProcess > Enhancements > EFI Processing command to compute an

EFI image with a height map.
l You can see the EFI image with the clockwork's texture. The resulting image is
amulti-layer image and is accompanied by this icon in the image window's
title. The icon indicates that the individual image layers in themulti-layer image
aren't of the same image type.

l The height map is a layer of the EFI image. The texture imagemakes up the
second layer. The height information is therefore also present in the EFI image.
You canmeasure the height directly on the texture image.

Measuring height
3. If necessary, use theView > ToolWindows > Measurement and ROI command to

have theMeasurement and ROI tool window displayed.
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4. In theMeasurement and ROI tool window, click the 3D Line button.
5. Now, measure the height difference between two image objects. Click, for

example, the brass-colored gear wheel, and the silver-colored gear wheel on the
right-hand side of the image.

6. Click the 3D Line button in theMeasurement and ROI tool window again, then
switch off the 3D measurement.
l In theMeasurement and ROI tool window, and in the image, the 3D Length
measurement parameter is output with the line's complete length. If the 3D
Lengthmeasurement parameter isn't shown, follow the step-by-step
instruction and display themeasurement parameter aswell.
The 3D Intensity Projectionmeasurement parameter measures the height
difference between two points.

Displaying additional measurement parameters
7. In theMeasurement and ROI tool window, click theSelect Measurements button.
8. In the list of all of the availablemeasurement parameters, take a look at the

parameter of the 3D Line object type. All of thesemeasurement parameters apply
to 3D measurements.
l You can find a short description and an illustration of eachmeasurement
parameter in theSelect Measurements dialog box.

9. Select the 3D Intensity Projectionmeasurement parameter.

10. Insert thismeasurement parameter into the list of the displayedmeasurements.
11. Close the dialog boxwithOK.

l In the tool window, you'll now see the 3D Intensity Projectionmeasurement
parameter. It tells you how far in height the two gear wheels are from each
other.

00611
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9. Materials Science Analysis
9.1. Tool Window - Materials Solutions

Use this tool window tomeasure an image, or several images at the same time,
according to different material science analysis processes.

TheMaterials Solutions tool window works similarly to a software wizard. As soon as
you've started an analysis process you'll be guided step by step through the
measurement.

Note: Which of theses analysis processes are available to you, depends on the
software license you've acquired. Maybe you will only see one or two analysis
processes.
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Overview of the supported analysis
processes
(1) Chart Comparison
(2) Grains Intercept
(3) Grains Planimetric
(4) Layer Thickness
(5) Cast Iron
(6) InclusionsWorst Field
(7) Inclusion Content
(8) Throwing Power
(9) Porosity
(10) Phase Analysis
(11) Particle Distribution
(12) AutomaticMeasurement
(13) Coating Thickness
(14) Dendrite ArmSpacing

Starting an analysis process

You start an analysis process by clicking the corresponding button.

Note: A lot of your software's other functions aren't available while an analysis process
is running. For example, you can't open the program options then.
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Stopping an analysis process

You can use theCancel button at the bottom of the tool window to do this.

Alternatively, you can click the appropriate button in the small message box that is by
default displayed at the top left edge of themonitor when an analysis process is in
progress.

Note: If you are in ameasurement mode, youmust leave it before you can cancel the
analysis process.

Independent of which analysis process has been currently selected, the tool window is
always configured in the sameway. It comprises static and dynamic areas.

Structure of the tool window

The static areas (1), (3) and (4) are located at the top and bottom edges of the tool
window. The content of these areas is always largely similar.

The dynamic area (2) is located in themiddle part of the tool window. Its appearance
differs according to which step and which analysis process has been chosen.

(1) Name of the analysis and "Instructions" group
You'll find the name of the current acquisition process right at the top of the tool
window. In the Instructions group, you will find an instruction of what to do in this step
and, if available, additional information.
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(2) Dynamic area
The contents of this area changes completely for each analysis process and for each
step in the analysis. It is therefore described each time one of the different analysis
process is presented.

(3) Current step in the analysis
Here, you can see at which step in the analysis you are at thismoment. The current
step is indicated by a blue arrow.

(4) Buttons
Here, you find the buttons you use to proceed to the next step in the analysis, or to
return to the previous step. You can also cancel an analysis here. Depending on the
current step in the analysis, not all of the buttons are active.

10242 20082019

9.1.1. Materials Solutions - Image source
TheMaterials Solutions tool window leads you step-by-step through amaterials
sciencemeasurement. In the Image source step, the following options are available:

(1) "Image source" group
In this group, you select the image that you want to analyze. You can also analyze
several images at the same time. The following options are available:

l Live image option: With this option, the additional step Image acquisitionwill be
shown. In this step, a live image will be acquired, which will then be analyzed in
the following steps.When the Image results step has been completed, a new
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image of the live image will be automatically acquired, then analyzed. This
enables you to analyze asmany images as you would like during the same
measurement. You can then either save the analyzed images or reject them.

l Selected images option: Loaded images that are currently selected in theGallery
tool window. Loaded images that are not selected in theGallery tool window, will
be ignored for the analysis.

l Folder option: All of the images in a specific directory. You can choose the
directory as you wish.

l Selected database images option: All of the images you have currently selected in
your software's database.

l Stage Path option: All imageswhich you would like to acquire with the saved
stage path. This option is only visible if your microscope stage has amotorized XY
drive.

Not all materials science analysis processes support the use of stage paths. This is
why theStage Path option is only available for these analysis processes:Grains
Intercept,Grains Planimetric, InclusionsWorst Field, Porosity, Phase Analysis,
Particle Distribution.

(2) Buttons to load saved settings
Here, you can load the settings that you want to use for the analysis. Click on the Load
from file... button, if you want to use settings that have been saved. For example, you
can in this way load the comments from a sample that has already been analyzed, and
adapt them for the current sample. Aswell as that, with somematerials science
analysis processes, the slide controls that are available in theSettings step will also be
set to the saved position.

Click on theGet from image... button, if you want to use the settings used for an
already analyzed image for the current analysis. Tomake this possible, the image that
has already been analyzedmust be opened in your software.

(3) "Skip 'Sample Information'" check box
Select theSkip 'Sample information' check box, to skip theSample information step.
As soon as you click theNext button, you'll go straight to theSettings step. Thismakes
sense if you analyze numerous images of the same sample, and you only want to
enter the information on the sample with the first image.

Note: When you analyze images of numerous samples, make sure theSkip 'Sample
information' check box is not selected, because otherwise you won't see theNew
Sample button.

(4) "Check settings and results" list and "Image interval" field
This list is only of significance if you are analyzing several images. If you are only
analyzing one image, leave the presetAll images entry as it is.

If you select several images, you can choose how frequently you would like to check
the settingswith which the images are analyzed. If you would like to analyze a lot of
imageswith the same settings, you can automate the analysis.

The following entries are available in theCheck settings and results list:
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l All images: Select this entry if you want to check the settings for each image. This
option is preset. TheSettings step is then displayed for each new image. This
makes sense, for example, if the images that are to be analyzed are very different
in their image qualities.

l Never: Select this entry, if the settings are never to be checked.With this option,
the systemwill jump over some steps in the analysis and the Image results step
will be displayed. In general, this setting is only sensible if you have saved the
settings to be used as a parameter set and you load them before starting the
analysis.

l First image: Choose this entry, if the settings are only to be checked for the first
image and are then to be used for all other images (even from other samples).

l First image per sample: Choose this entry, if you have several samples (with
several images per sample) and the settings are to be checked for the first image
of each sample.

l First image per scan area: You'll only see this entry when you have chosen the
Stage Path option. Select this entry, if the settings are only to be checked for the
first image in each scan area and if the same scan area is to be used for other
images.

l Image interval: Select this entry, if you would like to analyze several images and
would like to check the settings at regular intervals. If this entry is selected, the
Image interval field will become active. In this field you could, for instance, enter 10
to check the settings for every tenth image.

10265
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9.1.2. Materials Solutions - Stage path settings
TheMaterials Solutions tool window leads you step-by-step through amaterials
science inspection. In theStage path settings step, you define a stage path on your
sample.

What is a stage path?
For most materials science analysis processes, you can define several stage positions
on each sample and can save them as a stage path. Here, stage positions can either
be entire scan areas or individual XY positions. The stage path contains the number of
samples to be analyzed, and information about which scan areas and/or XY positions
are defined on each sample. For thematerials science inspection, the stage will move
to the defined positions one after the other. At each XY position, an image will be
automatically acquired. For a scan area, several imageswill automatically be acquired
and will be assembled into a single image. Each image acquired will be analyzed with
the selectedmaterials science analysis process.

The following stage path settings are available.

(1) Choosing a stage path
(2) Defining samples
(3) Defining scan areas and/or XY-positions
(4) Aligning the sample
(5) Selecting inspectionmode
(6) Selecting focusmode
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(1) Choosing a stage path

To be able to take amaterials science inspection at different positions on one or more
samples, you have to define a stage path. You can use a saved stage path or you can
define a new one.

Defining a new stage path
1. Click theCreates a new stage path button to define a new stage path.

l If there ismore than one sample on a slide, you can define the inspection for
more than one sample. You can enter different information for each sample.
After the inspection is finished, you get the results for each sample separately.

l A stage path is always linked to at least one sample. With the new stage path, a
new entry in theSamples list will always also be produced. If you click on the
Creates a new stage path button, theSample information dialog boxwill be
opened first.

2. In theSample information dialog box, you enter information about the sample. By
default, theReference,Group andComment fields are available to enter details
for the sample.
l If you have changed the default settings, theReference andGroup fields can
also have another name. You can change the default settings in the Tools >
Options > Materials Solutions <Name of the analysis process> dialog box.

l You'll see this information when you create a workbook or a report at the end of
the analysis.

3. Close theSample information dialog boxwithOK to create the new stage path.
l The new stage path is added to theStage path list. Once created, the stage
path is empty and still has to be completely defined.

l Now, define scan areas and/or XY-positions on your sample.

Note: There can only ever be one stage path active. If you define a new stage path,
you will automatically remove all of the currently defined samples and stage positions.
You should thus save a stage path which you would like to use again before defining a
new stage path.

Saving a stage path
Click theSaves the current stage path button, if you would like to use a stage path for
several inspections. The following information will be saved:

l The number of samples
l The data entered about the sample
l All of the defined stage positions, i.e. the positionmarkers for individual XY-
positions and all defined scan areas

l Inspectionmode and Focusmode

Using an existing stage path
In theStage path list you will find all of the stage paths that already exist.
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1. Select a stage path from the list to load the sample information and stage positions
defined in the stage path.
l If one of the positions in the stage path is outside of the currently defined stage
area, you will be presented with an error message. In this case you will not be
able to load the stage path.

Note: TheStage path list contains the stage paths saved by you aswell as those
saved by any other user withPublic access rights. You will not see stage paths saved
by other users withPrivate access rights.

You can edit the stage path and thus adapt it to the current sample.

1. Double click on an entry in theSamples list to open theSample information dialog
box. Here, you can change all of the loaded sample information.

2. Define new stage positions for individual samples, or delete individual stage
positions from theScan Areas list.

3. Click this button next to theStage path list to save the altered stage path under a
new name or to overwrite the existing stage path.

Managing existing stage paths
Click this button next to theStage path list to open theManage Stage Paths dialog
box. Here, you can copy an existing stage path, rename, or delete it.

Note: Public stage paths can be edited, and even deleted by every user of your
software.

(2) Defining samples

Prerequisite: TheSamples list isn't available for all materials science analysis
processes.

If there ismore than one sample on a slide, you can define the inspection for more than
one sample. You can enter different information for each sample. After the inspection
is finished, you get the results for each sample separately. The results also contain the
information that was entered about the sample.

TheSamples field lists all sampleswhich are defined in the current stage path. After
the name of the sample, in brackets you will find the number of stage positions
currently defined for this sample.

Adding and deleting samples
Click this button to add a new sample to the current stage path. TheSample
information dialog box automatically opens. Here, you can enter information about the
sample.

Select one of the samples listed. Click this button to delete the selected sample. All
scan areas and XY-positionswhich were defined for this sample will also be deleted.

Viewing and changing the sample data
Double click on a sample to open theSample information dialog boxwith the current
sample information and, if necessary, to edit it.
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(3) Defining scan areas and/or XY-positions

Use theScan Areas group to define stage positions on the selected sample, to edit
existing stage positions, and tomove the XY-microscope stage.

The following buttons are available:

Adding XY-positions

Adding scan areas

Moving the XY stage to the selected stage position

Editing stage positions

Deleting stage positions

Adding XY-positions
You canmark several positions on your samples. At each XY-position, an image will
be acquired and will be analyzed with the selectedmaterials science procedure.

1. Select a sample from theSamples list.
2. Move the XY stage to a position on the sample that you would like to inspect using

the current analysis process.
l To navigate the XY stage, you can for example use theMicroscope Control or
theStage Navigator tool window. Both tool windowswill automatically be
displayed in theStage path settings step in the analysis.

l In theStage path settings step, your systemwill automatically switch to live
mode, so that you can examine the live image to checkwhether the position on
the sample is suitable for analysis.

3. Click this button , located next to theScan Areas list.
l The current position of the XY stage will now be saved and assigned to the
selected sample.

l The defined XY-position will bemarked by a positionmarker in theStage
Navigator tool window.

4. Move the XY stage to the next position on the sample, where you would like to
take ameasurement.
l The stage will later bemoved to the positions specified and in the sequence
specified in theScan Areas list. Take this into account when defining the stage
positions.

5. Click the button again.
6. Repeat the two last steps until you have defined all of the positions on the sample.
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Adding scan areas
Instead of individual positions, you can also define a whole area on your sample for
materials science analysis. This area can be rectangular or circular.

1. Click this button to define a rectangular scan area. To do so, youmove on the
sample with themotorized XY stage to the rectangular area's top left-hand corner,
then to its bottom right-hand corner.

2. Click this button to define a circular scan area bymoving the XY stage. You define
the scan area bymoving your XY stage to three points, which are on the edge of
the round scan area. Your software will help here with correspondingmessage
boxes.
l Your software will automatically calculate how many individual images are
required to completely acquire and analyze the defined sample area. The
number of the individual images depends on the current magnification. If you
change themagnification, the number of imageswill be recalculated. You do
not have to redefine the scan area.

l The scan area is displayed in theStage Navigator tool window. In the stage
navigator's image display area, you can directly see how many individual
images are needed for the defined area at the current objectivemagnification.
If you change themagnification, the display will be updated.

l The stage will later bemoved to the positions specified and in the sequence
specified in theScan Areas list. Take this into account when defining the stage
positions.

3. In the InspectionMode group, select how the scan areas are to be analyzed. You
can findmore information further below.

Editing stage positions
You can redefine scan areas and XY-positionswhich have already been defined. In
contrast to deleting a stage position and then adding a new one, the name of the stage
position will not be changed.
You can for instance use this option to adjust an existing stage path for a different
sample.

1. From theScan Areas list, select one of the stage positions shown e.g.Rectangle
2.

2. Move the XY stage to the position on the sample, to which you would like tomove
the selected stage position.

3. Click this button to redefine the selectedRectangle 2 stage position. For a scan
area, you will also have to redefine the size in this case.
l The name of the new stage position will remain unchangedRectangle 2.

(4) Aligning the sample

With somematerials science analysis processes, the inspections have to be carried
out at certain positions on the sample. In this case, all samples on the stage have to be
positioned the sameway so that the stage path can go to the correct positions on the
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sample. Use the functions in theSample alignment group to compensate for differing
alignments of the samples on the stage.

Example: You can use theAutomaticMeasurement solution tomeasure test
structures on a wafer. On the wafer, define three positions that are located on every
wafer to bemeasured. If you now put a new wafer to bemeasured on the stage, at the
beginning of themeasurement, move the stage to the three reference positions. This
allows your software to recalculate the stage path.

Defining the reference position
1. Click this button to start the definition of the reference position.

l A yellow triangle on the button indicates that no reference positions have
been defined yet for this stage path.

l TheAcquire Reference Images for Sample Alignment dialog box opens. It
guides you step-by-step through the definition of the reference position.

2. Move the stage to reference position 1 and focus.
In order for the sample alignment to work well, the reference positions should
meet the following conditions.
l The reference positions should be unambiguous.

l The reference positions should be as easy to find on the sample as possible.

l The reference positions should be as far away from each other as possible.

3. Click theNext > button tomove to the next reference position.
l Your software now acquires an image at the first reference position. This
image is saved as a reference image together with the stage path.

4. Define reference positions 2 and 3.
5. Click the Finish button to finalize the definition of the reference positions.

l The button in theSample alignment group changes its appearance. A green
check on the button shows that reference positions have been defined for
this stage path.

6. Click this button next to theStage path list to save the stage path along with the
reference positions and the reference images.
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On the left is an overview of a whole sample. Define three reference positions (1-3) on
the sample. A reference image is acquired at each reference position. The illustration
shows the reference image at position 2. The reference image is displayed in the live-
image during the alignment of the sample to assist you with positioning.
On the right is a similar sample that is positioned differently on the stage. The same
stage path can be used on both sampleswith the aid of the reference positions.

Aligning a sample
1. Begin amaterials science analysis process that contains a stage path. Reference

positions for the stage path are already defined.
l Your software automatically starts a wizard in theDefine Stage Path step in the
analysis. You can cancel the wizard if you don't want to align the sample yet.

2. Click theYes button in themessage box or click theAlign images for sample
alignment button, shown above, to align the current sample with the aid of saved
reference images and reference positions.
l TheAlign images for sample alignment button is only available if reference
positions have been defined for the selected stage path.

l A yellow triangle on the button indicates that the current sample isn't
aligned yet.

l TheAlign images for sample alignment dialog box opens.

3. Decide how the reference image should be displayed. You have the following
options in theAlign images for sample alignment dialog box:
l Select theShow reference image as thumbnail option. Now the reference
image for the current position will be displayed as a small image on the top left
of the live-image.
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l Select theShow reference image in overlay option. Now the reference image
is superimposed in full size on the live-image. Use theDisplay opacity slide
control to change the transparency of the reference image. The smaller the
value, themore transparent the reference image is. Select the value 0 if you
don't want to see the reference image for orientation.

4. Move the stage to the required reference positions one after another. Orientate
yourself using the displayed reference image.

5. When you'vemoved to the third reference position, click the Finish button.
l Your software now compares the positions saved in the stage path with the
current positions youmoved the stage path to and positions the stage path
accordingly.

l The button in theSample alignment group changes its appearance. A green
check on the button shows that the sample is aligned.

(5) Selecting inspection mode

Prerequisite: The options in the InspectionMode group are only relevant for scan
areas, not for XY positions.

Select theSingle frame inspection option. Now, all of the images from a scan area will
be individually analyzed with the selectedmaterials sciencemethod.

Select theMIA image inspection option. Now, all of the images acquired from a scan
area will be assembled directly as they are acquired, like a puzzle, into a stitched
image, to be analyzed with the selectedmaterials sciencemethod.

WithMIA image inspections, the individual images are acquired with a certain overlap
area. Your software will then use pattern recognition to look for two imageswith the
same image information, in the overlap area.
You determine the size of the overlap area in theAcquisition Settings > Acquisition >
AutomaticMIA dialog box. You can open this dialog box, for example, via theProcess
Manager tool window. In the tool window's toolbar, click theAcquisition Settings
button. Select theAcquisition > AutomaticMIA option in the tree view.

The illustration shows a sample on which one scan area (1) is defined. 9 individual
images are needed to fully acquire the scan area.
On the left, theSingle frame inspection option is selected. If, for example, you do a
phase analysis and output a workbook as a result, you will now find the results for 9
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images on the sample's worksheet.
On the right, theMIA image inspection option is selected. On the sample's worksheet
you will now find only one result for the same scan area, as the individual imageswill
be assembled to a single image before the analysis.

(6) Selecting focus mode

When you use a stage path, the various positions that the stagemoves to during the
inspectionmay be at some distance from each other. In this case it will generally be
necessary to refocus several times during the inspection, so that each individual image
is ideally focused and can be analyzed successfully.

From the FocusMode list, select one of the following options:

l Not refocusing on samples
l Manually refocusing on samples
l Using a focusmap
l Using the software autofocus

The selected focusmode applies for the entire stage path, whichmeans for all
samples and all stage positions.

10801 28042017
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9.2. Chart Comparison

9.2.1. What are chart comparisons?
In metallography, chart comparisons are used as ameans of quality control. They
make it possible to compare an image with numerous reference images. The
reference images are a part of the industry standards (which have to be purchased) by
which the chart comparisons are carried out.

Example 1:
During a qualitative grain size analysis, you determine the grain size of metallic
samples. You compare the images that are to be checked with the reference images.
You assign the reference image with grains of the same size to each of the images that
is to be checked.

Example 2:
During a quality control, you check various components to see if they are free of
defects. To do so, you compare the components with images of various components
that are either defective or free of defects. You assign the appropriate reference image
to the object that is to be checked.

General procedure for a chart comparison
The image that is to be checked, and all or some of the reference images, are
displayed simultaneously on the screen. Your softwaremakes sure that all of the
images are always shown on the same scale. Bymaking a visual comparison, the user
finds out which of the reference images is themost similar to the image that is to be
checked. Saved along with every reference image is the value that it was assigned by
the industry standard. By the selection of a reference image, the image that is to be
checked is assigned this value, too.

The above image shows the document group during a chart comparison. The image
that is to be checked is located at the top left, the reference images are arranged either
next to it or beneath it. The selected reference image is framed in red.
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Results
The results of a chart comparison can be output in a workbook. Aswell as that, when
you carry out chart comparisons on live-images, you can immediately reject the
samples that don't meet the required values.

If the Chart Comparison analysis process isn't displayed in the
Materials Solutions tool window
To be able to carry out chart comparisonswith the image analysis program, the charts
from at least one industry standard have to be installed. Only then will theChart
Comparison analysis process be displayed in theMaterials Solutions tool window. The
industry standards that are to be used for the chart comparison have to be purchased.
They can be purchased throughOlympus Soft Imaging Solutions. You will receive a
DVD for each industry standard that you purchase. Use theQuick SetupGuide which
accompanies the DVD to install the industry standard's charts.

Note: Even if you haven't purchased an industry standard yet, you can still view the
Chart Comparison analysis process. To do this, install a demo plate. Using this, you
can get an impression of how this analysis processworks. Real analyses (complying
with industry standards) are, however, not possible using these demo plates.

00723 06052013

9.2.2. Performing a chart comparison

Preconditions
TheChart Comparison analysis process is only displayed in theMaterials Solutions
tool window when you have purchased at least one industry standard and have
installed its' charts.

Even if you haven't purchased an industry standard yet, you can still view theChart
Comparison analysis process. To do this, install a demo plate. You can carry these
step-by-step instructions out with theDemo single grain size demo plate.

Note:Real analyses (complying with industry standards) are, however, not possible
using these demo plates.

Example image FerriteGrains.tif
During the installation of your software some sample images have been installed, too.
You can follow these step-by-step instructionswhen you use the example image
FerriteGrains.tif. Open this image andmake sure that it has been selected in the
document group.

Image source step
1. Activate theMaterials Solutions tool window. Should this tool window not be

visible, use theView > ToolWindows > Materials Solutions command to have it
displayed.

2. Click theChart Comparison button.
l As soon as you've started this analysis process you'll be guided step by step
through themeasurement. A lot of your software's other functionswill not be
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available while an analysis process is running.
l TheMaterials Solutions tool window displays the Image Source step.

3. In the Image source group, choose theSelected images option to analyze the
example image. This imagemust have been opened for this purpose, and have
been selected in the document group.

4. Select theSkip 'Sample information' check box if you don't want to add any details
about the sample or about an image of the sample. If you want to add details,
make sure the check box is not selected.

Note: If you want to analyze images frommore than one sample in the same analysis
process, theSkip 'Sample information' check boxmust be cleared. Only then will the
New Sample button be displayed.With this button, you can specify when an image to
be analyzed belongs to a new sample.

5. Select theAll images entry in theCheck settings and results list.
l If you would like to analyze your own images later on, you can also select
another entry from this list, e.g. if you would no longer like to check the settings
for every image.

6. Click theNext button.
l TheMaterials Solutions tool window will display the next step.

Sample information step
Note: You will only see this step in the analysis if, in the previous step, theSkip
'Sample information' check boxwasn't selected.

1. Enter information on your sample. By default, these fields are calledReference
andGroup.

2. If you want to, enter a comment about the sample. This comment is valid for all of
the images of this sample.

3. If you want to, enter a comment about the current image, too.
4. Click theNext button.

l TheMaterials Solutions tool window will display the next step.

Settings step
1. Select the chart by which you want to analyze the image. If you've installed a

demo plate, select that.
l For the FerriteGrains.tif image, you can select theSingle grain size entry in
these step-by-step instructions to specify the grain size. You'll only see this
entry if you've chosen theDemo single grain size demo plate.

2. Click theNext button.
l TheMaterials Solutions tool window will display the next step.

l In the document group, the new Chart Comparison document will be
displayed.
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Comparison step
1. In theStyle group, choose how the images for the chart comparison are to be

arranged in the document group. Choose an arrangement in which the
FerriteGrains.tif image and the selected reference image are superimposed. To
do so, click this button.
l In the document group, theChart Comparison document will now be
displayed. It contains exactly one image.

l In theOverview field, you see the arrangement that has been chosen. The
selected reference image is framed in red.

2. Compare the structures of the current image with those of the reference image.
Move the slide control below theStyle field towards theOpaque position, if the
image that is to be checked is to superimpose the reference image. Alternatively,
move the slide control towards the Transparent position, if the image that is to be
checked is to be superimposed by the reference image.

The illustration on the left shows the image that is to be checked. Because the slide
control is located in near theOpaque position, the reference image's structures can
only be faintly recognized. For the illustration on the right, the slide control has been
moved towards the Transparent position. Now, the reference image can be clearly
recognized, and the image that is to be checked can be only faintly recognized.

3. If you want to choose another reference image, in theComparison group, click
that image with your left mouse button.

4. When the reference image that is themost similar to the image that is to be
checked, has been chosen: Click theAccept button.
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l The chosen image's data will be accepted in theResults field.

l It's possible to accept several reference images, for example, with samples that
have very different structures.

5. Click theNext button.
l TheMaterials Solutions tool window will display the next step.

Note: When you carry out analyses on the live-image: Click theGet Results button.
You will then see theResults step. Otherwise, when you've finished analyzing one
live-image, the next live-image will always then automatically be offered for analysis.

Results step
1. Select theGenerate workbook check box to have a document of theWorkbook

type automatically created at the end of the analysis.
2. Click the Finish button.

l TheMaterials Solutions tool window switches back to the start position. You
can now use all of your software's functions again.

00724 17112015
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9.3. Intercept Analysis

9.3.1. What is an intercept analysis?
The intercept analysis is used tomeasure grain sizes and to document them. It is often
used inmaterial analyses, for example, when the quality of steel or other metals is
being tested.

When an intercept analysis ismade, measuring lines are placed in an image. Along
thesemeasuring lines, your software searches for abrupt deviations in the pixels'
intensity (gray value). An intensity deviation occurs, for example, if dark pixels are
present in an imagemade up of mainly light pixels. When an intensity deviation
exceeds the parameters that have been set, an intercept point will be plotted at this
position on themeasuring line.

The intercept points are counted. The distance between two intercept points is also
measured. From thismeasurement, themean intercept length is calculated.

Description of the above illustration
The intensity profile is determined along the horizontal measuring line. Whenever the
measuring line crosses a grain boundary, this leads to a distinctiveminimum in the
intensity profile. When an intercept analysis ismade, theseminima in the profile are
used to determine the intercept points. In the illustration shown, the grain boundaries
are dark, the process can, however, also be used on imageswith light grain
boundaries. The analysis of cascaded grain boundaries (with multi-phasematerials) is
also possible.

OLYMPUS Stream UserManual 138



9.  Materials Science Analysis
9.3.   Intercept Analysis

Results of an intercept analysis
An intercept analysis provides the so-called G-value, which is defined as a
characteristic grain size in the corresponding industry standards. G is calculated from
the number of intercept points and themean intercept length. The grain sizes are
measured in accordance with the industry standards:

l ASTME 112-13
l GB/T 6394-2002
l GOST 5639-82
l EN ISO643:2012
l DIN 50601:1985
l JIS G0551:2013
l JIS G0552:1998
l ASTME1382-97 (2015)

The results of an analysis can be displayed in a workbook. Additionally, the results can
be displayed in a report in either MS-Word or MS-Excel format.

00700 04032019

9.3.2. Settings
In this step, youmake important settings for the analysis. You have the following
options:

(1) Buttons for selecting the grain boundary type
Here, you specify which criteria are used to detect the grain boundaries. Depending
on the image that is to be analyzed, the grain boundary type can be dark (left
illustration) or light (middle illustration). Where images that don't have any intensity
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deviations, but only show different gray values, are concerned, select theStep setting
(right illustration).

(2) Pattern of test lines
The line pattern determines along which lines the intercept points are looked for. At
every position along the line, intensity deviationswill be searched for in the intensity
profile. As soon as an intensity deviation fulfills the definition criteria set, it will be
displayed as an intercept point in the image.Which line pattern is suitable for a specific
task, depends on the type of structures that are to bemeasured, and their position in
the image.

The following line patterns are available:

Circles
Three circles are placed in the center of the image. The size of themeasurement
pattern corresponds to the diameter of the largest circle. This line pattern is
appropriate for imageswith structures distributed equally throughout the image or
structureswhich progress from themiddle of the image to the edges.

Cross
The cross consists of two diagonally crossed lines, as well as a line each below and to
the left of this cross. The size of themeasurement pattern corresponds to the length of
the horizontal line below the cross.

Cross and Circles
TheCross and Circles line pattern combines the two line patternsCross andCircles.

Vertical Lines
With this line pattern, vertical lines are distributed evenly across themeasurement
pattern.

Horizontal Lines
With this line pattern, horizontal lines are distributed evenly across themeasurement
pattern.

Horizontal and vertical lines
With this line pattern, horizontal and vertical lines are distributed evenly across the
measurement pattern, forming a grid.

(3) Slide controls for changing the results displayed
You can change the position of the slide controls however you want to in this step. This
has an effect on the number of intercept points that will be found. Therefore you should
keep an eye on the display in the image.
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Grain boundary width
Here, you set the necessary width for the detection of a grain boundary. When a small
grain boundary width is set, your software finds considerablymore intercept points
than with a wider grain boundary.

Noise reduction
Use this slide control to apply a smoothing filter to the image. The smoothing filter
reduces the image noise. You should therefore apply a smoothing filter to images that
are very noisy before the intercept analysis ismade. Move the slide control from the
left to the right, to increase the strength of the smoothing filter in small steps. This will
lead to a reduction of the detected intercept points.

(4) Number of test lines
These fields are only active if you selected a pattern of test lines that contains
horizontal or vertical lines. In this case, you specify here the number of lines to be used
for the intercept analysis.

(5) Industry standard used
In theStandard field, select the industry standard that is to be used for the
measurement.

10263 02052017

9.3.3. Performing an intercept analysis

Step - Image source
1. Activate theMaterials Solutions tool window. Should this tool window not be

visible, use theView > ToolWindows > Materials Solutions command to have it
displayed.

2. Click theGrains Intercept button.
3. In the Image source group, choose the image or the images that you want to

analyze.When you do this, pay attention to the information as to how many
images have been selected This information is shown in bold font at the bottom of
the group.

4. Decide whether you want to load settings that you have saved while you were
analyzing another image. Then you can, if necessary, adapt these settings and
apply them to this image. Click the Load from file... button to load the settings that
have been saved.

5. Decide whether or not you want to add data about the sample or about individual
imageswhile the analysis process is in progress. If you don't want to do so, select
theSkip 'Sample information' check box.
Should you want to add data, (e.g., because you are analyzing images of several
samples in the same analysis), leave the check box deselected.

6. Select theAll images entry in theCheck settings and results list.
l If you analyze your own images later on, you can also select another entry from
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this list, for example, if you don't want to check the settings for every image
anymore.

7. Click theNext button.
l TheMaterials Solutions tool window will display the next step.

l Should you be analyzing the live-image and a database is open, you'll be asked
whether you want to save the acquired individual image in the database.

Step - Sample information
Note: You will only see this step in the analysis if, in the previous step, theSkip
'Sample information' check boxwasn't selected.

1. Enter information on your sample. By default, these fields are calledReference
andGroup.
l If you have changed the default settings, these fields can also have another
name.

2. If you want to, enter a comment about the sample. This comment is valid for all of
the images of this sample.

3. If you want to, enter a comment about the current image, too.
4. Click theNext button.

l TheMaterials Solutions tool window will display the next step.

Step - Settings
1. Select a suitable grain boundary type.
2. Choose a pattern of test lines that is appropriate for the structures in the image

that is to be analyzed. You can choose between various patterns.
l The pattern of test lines determines along which lines intercept points in the
image are looked for.

3. Take a look at the intercept points that have been found in the image. If necessary,
change the settings to optimize the results shown.

4. Click theNext button.
l TheMaterials Solutions tool window will display the next step.

Step - Image results
1. Check the results shown. You can see the results of the current image, and the

overall results of all of the images that have already been analyzed for this sample.
2. Should you not be satisfied with the results for the current image: Click theBack

button to switch back to theSettings step. Then you can try to improve the results
for this image by choosing another line type or bymoving the slide controls to
another position.

3. Should you want to correct the intercept points that have been automatically
found, click theAdd Intercepts... orDelete Intercepts... buttons. This will enable
you to add intercept pointsmanually, or to delete superfluous intercept points.
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4. When you analyze images that you selected before the analysis began: Click the
Next button.
l Should you analyze images from the database, you will then be asked whether
you want to save the changed images, or not. You can either insert the
analyzed images as new images into the database, or overwrite the existing
database imageswith them. Aswell as that, you can either save the images in
the file system or reject them.

l TheMaterials Solutions tool window will display the next step.

l Only when you carry out an analysis on the live-image, or you want to leave out
the analysis of all of the remaining images: Click theGet Results button instead
of theNext button. You will then see theResults step. Otherwise, when you've
finished analyzing one live-image, the next live-image will always then
automatically be offered for analysis.

Step - Results
1. Check the results shown. You can see the overall results for all of the images that

have already been analyzed for this sample.
2. Select theGenerate report check box and then select either theWord option or

theExcel option to automatically create a report in the corresponding application
programwhen the analysis finishes.
l The additional stepReportingwill be added to the current analysis. In the lower
part of the dialog box, the Finish button will change into theNext button.

3. Select theGenerate workbook check box to have a document of the "Workbook"
type automatically created at the end of the analysis.

4. If you want to save the current settings to a file, click theSave settings... button.
Then assign a descriptive name in the next dialog box.
l You can load these settings (parameters) when you analyze further images. To
do so youmust load the image to be analyzed and, in the Image source step,
click the Load from file... button. The sample and image comments, the line
pattern used, and the position of the slide controls in theSettings step will be
saved.

5. Click theNext button.
l This button is only active if you have selected theGenerate report check box as
described above.

Step - Reporting
1. Select theDefault option to use the template that has been defined as the default

template. If you would like to select another template, select theUser defined
option. Click the button with the three points and select the new template in the
Open dialog box.

2. When you want to create anMS-Word report: In theContent group, select the
check box for the pages the report should contain.
l Select theSummary page check box, if the first page of the report is to contain
a summary of all of the results of the current analysis. The creation of a
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summary page can, e.g., be useful, when you have analyzed a large number of
images of a variety of different samples.

l Select theOne page per sample check box, if the report should contain one
page for every sample. This page displays the overall results for all of the
images belonging to that sample. Using this setting is a good idea, for example,
when you have analyzed images of different samples.

l Select theOne page per image check box, if the report should contain a page
of its own for every image. Should only this check box have been selected, and
you have analyzed three images, your report will contain exactly three pages.

l Select theShow results in overlay check box if the image layer that contains the
results is to be displayed along with the images.

3. When you want to create anMS-Excel report: Click theSave settings button to
save the current settings in a file.
l These are largely the same settings that you could already save in the previous
step, theResults step. You can, however, additionally specify which Excel
template you want to use for the report creation here.

4. Click the Finish button.
l The report will be generated and displayed in the application program that you
selected.

l Theworkbookwill be created. It always contains aminimumof two
worksheets. On the first worksheet, you'll see a summary of the results. On the
second worksheet you'll see the details concerning the sample used. Should
you have analyzed several samples, the workbookwill contain additional
worksheets.

l TheMaterials Solutions tool window switches back to the start position. You
can now use all of your software's functions again.

5. Through thematerials analysismeasurement, the image has collected one or
more additional layers (can be seen in the Layers tool window). If required, save
the image in TIF or VSI format to retain these newly created image layers.

00701
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9.4. Grains Planimetric

9.4.1. What is Grains Planimetric?
The grains planimetric analysis is used tomeasure grain sizes and to document them.
It is often used inmaterial analyses, for example, when the quality of steel or other
metals is being tested. The grains planimetric analysis determines the grain size by
means of the grains' area. In this way, it differs from the intercept analysis that
determines the grain size bymeans of the number of intercept points. Sampleswith
either dark or bright grains can be used. The analysis of cascaded grain boundaries
(with multi-phasematerials) is also possible.

The image shown above shows the results of an automatic detection of the grain
boundaries. By default, the grain boundaries that have been detected are displayed in
red (first illustration). Additionally, it's possible to have the grains that have been found
displayed in color (second illustration). Small grains are displayed in darker shades
than big grains.

Measuring the second phase
Samples that have a second phase can also bemeasured. Ferrite pearlite
microstructures, which are important in thematerial analysis of steel, have two
phases; the dark pearlite and the light ferrite. For these kind of samples, your software
can determine the area of all of the second phase objects and subtract them from the
area of the first phase.

The above images display a ferrite pearlite microstructure. In the first image you can
see (in red) the grain boundaries that have been detected. In the second image, all of
the image areas that belong to the second phase are shown (in turquoise). The third
image additionally shows (in green) the grains that were detected.
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Editing grain boundaries
You canmanually edit the grain boundaries that your software found automatically.
You can delete unnecessary grain boundaries and add boundaries that aremissing.

Validating detected grains
You can correct the way that the software detected the grains by selecting the grains
and deleting themmanually. If you inadvertently delete any grains, you can restore
them.

The above image shows the result of an automatic detection of the grain boundaries
after a number of grains have beenmanually deleted. The deleted grains are no
longer taken into account when themeasurement results are determined. They are
cross hatched in the image.

The results of a grains planimetric analysis
A grains planimetric analysis provides the so-called G-value, which is defined as a
characteristic grain size in the corresponding industry standards. The following
standards are available for themeasurement:

l ASTME 112-13
l GB/T 6394-2002
l GOST 5639-82
l EN ISO643:2012
l DIN 50601:1985
l JIS G0551:2013
l JIS G0552:1998
l ASTME1382-97 (2015)

In addition to this, other measurement results are determined; the total number of
grains, themean grain area and the sum of grain areas for example.
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Documenting the results
The results of an analysis can be displayed in a workbook and in a chart. Additionally,
the results can be displayed in a report in either MS-Word or MS-Excel format.

00720 04032019

9.4.2. Settings
In this step, youmake important settings for the analysis. You'll only see some of the
setting options described below. Which of them you see depends on the image type
you chose in the previousSample type step.
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(1) Buttons for selecting the grain boundary type
Prerequisite: You'll only see these buttons if you chose theBright or dark grains type in
theSample type step.

Here, you specify which criteria are used to detect the grain boundaries. Depending
on the image that is to be analyzed, the grain boundary type can be bright or dark. If
the image you want to analyze contains both bright and the dark grain boundaries,
click theBright and dark grain boundaries on gray background button.

In the illustration on the left, the grain boundaries are dark. In the illustration in the
middle, the grain boundaries are bright. In the illustration on the right, the grain
boundaries aremainly dark, but there are some bright boundaries aswell.

(2) Slide controls
The positioning of the slide controls influences the detection of the grain boundaries.
While you are positioning the slide controls, observe which grain boundaries are
found. The preview is updated after every change in the settings.

Position the slide controls in such a way that the grain boundaries are detected as
completely as possible. It doesn't matter if the grain boundaries are interrupted
somewhere in between. The algorithm that calculates the G-value will automatically
close small interruptions in the boundaries.

Note: If you are not sure whether or not a slide control is positioned correctly, click the
Next button and have a look at the results in the Image results step.With theBack
button, you can always return to theGrain boundaries step.

Smoothness
With the help of this slide control you can specify that small structures or patterns that
are located within the grains are to be ignored for the analysis. These structures have
nothing to do with grains. Therefore, it is important to exclude them from the detection.
If this is not done, these small structures are taken for grains and will thus affect the
result of a planimetricmeasurement negatively.

Set the smoothness as exactly as possible, so that small structures or patterns only
just stop being detected. Don't choose a larger value than necessary. If the image
smoothness chosen is unnecessarily great, real small grains won't be detected.
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In the first illustration, the selected image smoothness is too small. With this setting,
numerous structures (e.g., patterns) within the grains are detected, and this negatively
affects the results of the planimetricmeasurement. In the second illustration, a higher
value for the image smoothness has been chosen. You can clearly see that only a few
structureswere still detected within the grains. Therefore, the result of the planimetric
measurement ismore exact.

Threshold
Choose whether a smaller intensity range is sufficient for the detection of a grain
boundary. This is, the case, when all of the grain boundaries stand out clearly against
the background, for example. In this case, you canmove the slide control to the far
right.

If not all of the grain boundaries stand out clearly against the background, e.g.,
because some grain boundaries are brighter than others, a larger intensity range has
to be defined for the detection of the grain boundaries. In this case, move the slide
control to the far left.

In the first illustration, the selected threshold value is too high. In the Image results
step, you can see that not all of the grain boundaries have been detected.

In this illustration, a lower value for the threshold values has been given. In the Image
results step, you can see that all of the grain boundaries have now been detected.

(3) Selecting the grain boundary color and the grain fill color
Here, you specify in which color the grain boundaries that have been detected are to
be shown. To do so, click the arrow button that is located at the right border of the field
and select a color. The grain boundaries should be clearly distinguishable from the
sample's color. By default, the color red is selected.

In theGrain fill color field, select the color in which the detected grains will be shown.
To do so, click the arrow button that is located at the right border of the field and select
a color.

(4) Selecting the industry standard
In theStandard field, select the industry standard that is to be used for the
measurement. The following standards are available:

l ASTME 112-13
l GB/T 6394-2002
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l GOST 5639-82
l EN ISO643:2012
l DIN 50601:1985
l JIS G0551:2013
l JIS G0552:1998
l ASTME1382-97 (2015)

Select theShow grain boundaries check box to display the grain boundaries in the
image window.

10284 04032019
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9.5. Layer Thickness Measurement

9.5.1. What are layer thickness measurements?
By using layer thicknessmeasurements you canmeasure layers on calibrated images
automatically or interactively. The object that is to bemeasured is the thickness of one
layer or of several layers. Each layer is defined by two borders and a neutral fiber. The
neutral fiber is a reference line which is there to specify the layer's course. The neutral
fiber is automatically defined by the program. You can define either open or closed
layer types.When you have a closed layer type, you canmeasure circular layer
structures. In thismode, themeasurement line's first point is automatically connected
to its last point.

Measuring an open layer: In the image, two layers have beenmeasured. You can
see 4 layer borders (blue lines) and two neutral fibers (green lines). Themeasurement
lines (yellow lines) are shown for the currently selected layer.

Measuring a closed layer: In the image, the outer layer has beenmeasured. You
can see the layer borders (blue lines), the neutral fiber (green line) and the
measurement lines (black lines).

Results of a layer thickness measurement
The results of an analysis can be displayed in a workbook. Additionally, the results can
be displayed in a report in either MS-Word or MS-Excel format.
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The borders that have been found, the neutral fibers and themeasurement lineswill
be saved together with the image, if you save it in TIF or VSI format. This information
will be saved in a separate image layer that you can show and hide via the Layers tool
window.

General procedure for a layer thickness measurement
1. Selecting the analysis process

Click the Layer Thickness button, located in theMaterials Solutions tool
window.

2. "Image source" step
Choose the image you want to measure.

3. “Settings” step
Choose the definitionmethod you want to use (Automatic, Manual, Magic

Wand).

4. “Magic wand” step
If you have selected theMagic wand definitionmethod: Define the contours.

5. "Define borders" step
If you have selected theAutomatic orMagic wand definitionmethod: Define

the borders.

6. “Define layers" step
Define the layers.

7. "Image results" step
Take a look at themeasurement results.

8. "Results" step
Document the results (report or workbook).

00725 27062017
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9.5.2. Settings
In this step, the following possibilities are available:

(1) "Settings" group
In theSettings group, choose how the contours are to be defined. To do this, click the
corresponding icon. You can choose between the following definitionmethods. The
current definitionmethod is outlined in yellow.

l automatic definition

l manual definition

l a definition with themagic wand

An automatic definition is suitable for sampleswhose layers feature distinct intensity
differences (e.g., light layers in front of a dark background). With these samples, as a
rule, the automatic threshold value setting used for this definitionmethod functions
well.

A definition bymagic wand is suitable for samples that have irregular borders that
would be very difficult to tracemanually.
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A manual definition is suitable for samples in which there are only very small intensity
differences, whichmeans that the automatic definition would not provide you with
satisfactory results. Also when only a small part of a layer interests you, you can easily
set it with themanual definition.

Please note: You can change the definitionmethod during ameasurement: For
example, you can first have a contour determined by using themagic wand, then add
an additional border manually.

(2) "Layer type" group
In the Layer type group, you choose whether open or closed layers are to be defined.
To do this, click the corresponding icon.

With an open layer type, you can, e.g., measure layer structures that continue all
through the image.When you have a closed layer type, you canmeasure circular layer
structures. In thismode, themeasurement line's first point is automatically connected
to its last point.

Please note: The layer type can only be specified at the beginning of ameasurement.
In contrast to the definitionmethod, the layer type can't be changed during the
measurement.

10500 25022021

9.5.3. Performing an automatic layer thickness measurement
Note: You can follow these step-by-step-instructions on your PC. They describe a
layer thicknessmeasurement on an example image.

Step - Image source
1. Load the Coating.tif example image.

l On this image, the thin light layer is to bemeasured.

2. Activate theMaterials Solutions tool window.
3. Click the Layer Thickness button.
4. In the Image source group, choose theSelected images option to analyze the

example image. This imagemust have been opened for this purpose, and have
been selected in the document group.

5. Select theSkip 'Sample information' check box.
6. Select theAll images entry in theCheck settings and results list.
7. Click theNext button.
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Step - Settings
1. Click theAutomatic button.

2. In the Layer type group, click the icon for an open layer.
3. Click theNext button.

Step - Automatic
1. You see the image on which some of the image structures are now shown in

color, because the first phase was automatically set up.

2. Since the required image structures are not yet shown in color, select theDark
option in theBackground group.

l Now, the required image structures are shown in color.

3. Click theNext button.

Step - Define borders
1. Here, you see the image in which the contours are outlined in red.

2. Click theDefine borders... button.
3. Now, specify which part of the contour represents a border. Click the contour

once with your left mouse button, to activate themode.
Then click with your left mouse button at the position in the contour where the first
border is to begin.
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Then click with your left mouse button at the position in the contour where the first
border is to end.
l The beginning and the end of this border will be indicated by two green
crosses.

4. Now, define the second border. To do so, click with your left mouse button again
at the position where this border is to begin. Then click with your left mouse button
again at the position where this border is to end.
l The beginning and the end of this second border will be indicated by two blue
crosses.

5. Click once with your right mouse button in the image.

l The borders that have been defined will be plotted in blue.

6. Since you don't want to define any additional borders: Then click oncemore with
your right mouse button in the image, to switch off themode for defining the
borders.

7. Click theNext button.

Step - Edit borders
1. Since you have already defined both of the borders, and don't want to change

them: Click theNext button.

Step - Define layers
1. Click theAdd layers... button.
2. Click the first border.
3. Click the second border.

l The layer has now been defined. The neutral fiber is plotted in green. It always
lies in themiddle of the layer.

4. Click your right mouse button to finish the definition of the layer.
5. Click theNext button.
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Step - Image results
1. Take a look at the results of the current image, shown in the Image results group.

This group contains a table with themeasurement results.
l The values in theSteps,Distance and Type fields can be edited when you
double click in the cell you want to edit.

l The lower part of the group contains several buttons, with which you can
change the way the layer thicknessmeasurement is displayed.

2. Check the results shown in the image.

l Themeasurement lines are shown in yellow in the image.

3. Click theNext button.

Step - Results
1. Select theGenerate report check box and then select either theWord option or

theExcel option to automatically create a report in the corresponding application
programwhen the analysis finishes.

2. Select theGenerate workbook check box to have a document of the "Workbook"
type automatically created at the end of the analysis.

l You can load these settings (parameters) when you analyze further images. To
do that for the new image in the Image Source step, click the Load from file...
button.

Step - Reporting
Define the report that contains themeasurement results.

l These are largely the same settings that you could already save in the previous
step, theResults step. You can, however, additionally specify which Excel
template you want to use for the report creation here.

l TheMaterials Solutions tool window switches back to the start position. You
can now use all of your software's functions again.

l Through thematerials analysismeasurement, the image has collected one or
more additional layers (can be seen in the Layers tool window). If required,
save the image in TIF or VSI format to retain these newly created image layers.
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9.5.4. Performing a layer thickness measurement with the magic
wand (closed layer)

You can follow these step-by-step-instructions on your PC. They describe a layer
thicknessmeasurement on an example image.
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Step - Image source
1. Load the "Copper Wire Section.tif" example image.

l The image shows a cross section through a copper wire. The outermost layer
is to bemeasured.

2. Activate theMaterials Solutions tool window.
3. Click the Layer Thickness button.
4. In the Image source group, choose theSelected images option to analyze the

example image. This imagemust have been opened for this purpose, and have
been selected in the document group.

5. Select theSkip 'Sample information' check box.
6. Select theAll images entry in theCheck settings and results list.
7. Click theNext button.

Step - Settings
1. Click theMagicWand button.

2. In the Layer type group, click the icon for a closed layer .
3. Click theNext button.

Step - Magic wand
1. Click theAdd contours... button.

2. Click the button for theHSV color space.
3. Then define the first contour. To do this, click once with your left mouse button on

a position in the image that lies within the outermost layer.
l The contour will be shown by a red line.

Note: Make sure that the contour completely includes the outer layer. And that the
contour's outline isn't discontinued at any point on the outer layer. Change the position
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of the slide control in the Tolerance field, until the contour completely includes the layer
that is to bemeasured.

Wrong: The contour's outline is noncontinuous.

Correct: The contour completely contains the layer that is to bemeasured.

4. Click your right mouse button to finish the definition of the contour.
l Now, the first border has been defined. It will be plotted in blue.

5. Click theNext button.
l TheEdit borders step in the analysis will be shown.

Step - Edit borders
1. Click the topAdd contours... button.
2. Click theNext button.

Step - Magic wand
1. Then define the second contour. To do so, click theAdd contours... button again.
2. Then click a position inside the copper wire.
3. Take care again that the contour contains the inside of the copper wire as

completely as possible, and that its outline isn't discontinued anywhere. At the
same time, this new contour mustn't touch the contour that has already been
defined. Change the position of the slide control in the Tolerance field, until the
second contour looks roughly as shown below:
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4. Click your right mouse button to finish the definition of the contour.
5. Click theNext button.

Step - Edit borders
1. Since you have already defined both of the borders, and don't want to change

them: Click theNext button.

Step - Define layers
1. Click theAdd layers... button.
2. Click the first border.
3. Click the second border.

l The layer has now been defined. The neutral fiber is plotted in green. It always
lies in themiddle of the layer.

4. Click your right mouse button to finish the definition of the layer.
5. Click theNext button.
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Step - Image results
1. Take a look at the results of the current image, shown in the Image results group.

l The values in theSteps,Distance and Type fields can be edited when you
double click in the cell you want to edit.

l The lower part of the group contains several buttons, with which you can
change the way the layer thicknessmeasurement is displayed.

2. Check the results shown in the image.
l Themeasurement lines are shown in the image. Tomake them contrast better,
the color of themeasurement lineswas set to black before themeasurement
took place.

3. Click theNext button.

Step - Results
1. Select theGenerate report check box and then select either theWord option or

theExcel option to automatically create a report in the corresponding application
programwhen the analysis finishes.
l The additional stepReportingwill be added to the current analysis. In the lower
part of the dialog box, the Finish button will change into theNext button.

2. Select theGenerate workbook check box to have a document of the "Workbook"
type automatically created at the end of the analysis.

3. If you want to save the current settings to a file, click theSave settings... button.
Then assign a descriptive name in the next dialog box.
l You can load these settings (parameters) when you analyze further images. To
do that for the new image in the Image Source step, click the Load from file...
button.

4. Click theNext button.

Step - Reporting
Define the report that contains themeasurement results.
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l These are largely the same settings that you could already save in the previous
step, theResults step. You can, however, additionally specify which Excel
template you want to use for the report creation here.
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9.5.5. Performing a manual layer thickness measurement
Note: You can follow these step-by-step-instructions on your PC. They describe a
layer thicknessmeasurement on an example image.

Step - Image source
1. Load the "Coating with porosity.tif" example image.

l On this image, themiddle layer is to bemeasured.

2. Activate theMaterials Solutions tool window.
3. Click the Layer Thickness button.
4. In the Image source group, choose theSelected images option to analyze the

example image. This imagemust have been opened for this purpose, and have
been selected in the document group.

5. Select theSkip 'Sample information' check box.
6. Select theAll images entry in theCheck settings and results list.
7. Click theNext button.

Step - Settings
1. Click theManual button.

2. In the Layer type group, click the icon for an open layer .
3. Click theNext button.

Step - Manual
1. Click theAdd borders... button.
2. Define the first border. To do so, first click with your left mouse button at the

position in the image where the border is to begin. Mark the course of the border
with further left mouse clicks. Then click with your right mouse button at the
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position in the image where the border is to end.
l The border will be shown in red.

3. Define the second border. To do this, proceed exactly as you did when you
defined the first border.

4. Click your right mouse button to finish the definition of the two borders.

l The borders will be shown in blue.

5. Click theNext button.
l TheMaterials Solutions tool window displays theEdit borders step.

Step - Edit borders
1. Since you have already defined both of the borders, and don't want to change

them: Click theNext button.

Step - Define layers
1. Click theAdd layers... button.
2. Click the first border.
3. Click the second border.

l The layer has now been defined. The neutral fiber is plotted in green. It always
lies in themiddle of the layer.

4. Click your right mouse button to finish the definition of the layer.
5. Click theNext button.
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Step - Image results
1. Take a look at the results of the current image, shown in the Image results group.

This group contains a table with themeasurement results.
l The values in theSteps,Distance and Type fields can be edited when you
double click in the cell you want to edit.

l The lower part of the group contains several buttons, with which you can
change the way the layer thicknessmeasurement is displayed.

2. Check the results shown in the image.

l Themeasurement lines are shown in yellow in the image.

3. Click theNext button.

Step - Results
Select the results you want.

Step - Reporting
Define the report that contains themeasurement results.
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9.6. Cast Iron analysis

9.6.1. What is a cast iron analysis?
The quality and consistency of cast iron depends on the distribution and the
morphology of its carbon content. By using a cast iron analysis you can determine the
cast iron's graphite fraction with the help of unetched samples. Aswell as that, with the
help of etched samples you can determine the ferrite/pearlite ratio.

The classification of the detected particles is performed according to the industrial
standard that is selected in the program options. Each standard requires a different
classification of the detected particles. These classifications are included in the
software package purchased, and are automatically installed with it. The following
standards are supported:

l EN ISO945-1:2018
l ASTMA247-17
l JIS G5502:2001
l KS D 4302:2006
l GB/T 9441-2009
l ISO 16112:2017
l JIS G5505:2013
l NF A04-197:2017

Determination of the graphite fraction
By using your software'sCast IronSolution, you canmeasure the graphite fraction
and classify the detected particles. For this purpose, the samplemust not be etched.
How the classes are defined, depends on the standard according to which the cast
iron analysis is carried out.

You see the results of a cast iron analysismade of different forms of graphite. The
color coding of the particles indicates their belonging to a specific size class (1), form
class (2), and a form factor (3).

Results of a cast iron analysis made to determine the graphite fraction
The results of an analysis can be displayed in a workbook. Additionally, the results can
be displayed in a report in either MS-Word or MS-Excel format.
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While you are performing a cast iron analysis, you can create a chart showing the
graphite size, the graphite form or the graphite nodularity. You can also save these
charts as files.

Figure (1) shows a chart of the graphite size. Along the X-axis the size classes are
shown, along the Y-axis the number of detected particles in% is shown.
Figure (2) shows a chart of the graphite form. Along the X-axis the form classes are
shown, along the Y-axis the number of detected particles in% is shown.
Figure (3) shows a chart of the graphite nodularity. Along the X-axis the form factor is
shown, along the Y-axis the number of detected particles in% is shown.

General procedure for a cast iron analysis made to determine the
graphite fraction

1. Selecting the analysis process
Click theCast Iron button, located in theMaterials Solutions tool window.

2. "Image source" step
Choose the image you want to measure.

3. “Settings” step
Choose the sample type (unetched).

Set the graphite parameters.

4. "Graphite distribution" step
If chosen: Determine the distribution of the graphite particles.

5. "Image results" step
Take a look at your image results.

If necessary, Delete or separate detected particles, or add new ones.

6. "Results" step
Document the results (report or workbook).

Determination of the ferrite/pearlite-ratio
By using your software'sCast Iron solution, you can alsomeasure the ferrite/pearlite
ratio. For this purpose, the samplemust have been etched. Since graphite and pearlite
have very similar gray values, it's difficult to differentiate between these two fractions in
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a sample during the same analysis. For this reason, determining the ferrite/pearlite
ratio is done as follows:

To begin with, your software determines, bymeans of the definition of phases, the
ratio of the bright ferrite areas to the dark (graphite and ferrite) areas. During the
analysis, the graphite fraction is entered, and is then subtracted from the dark areas.
This graphite fraction has either been determined in an earlier measurement (this
value can then be imported), or it can alternatively be estimated. Using the pearlite
area that has in this way been corrected, the ferrite/pearlite ratio is calculated.

You see a step in the analysis during the determining of the ferrite/pearlite ratio. The
bright ferrite phase has been determined by your software (shown in yellow here).

00734 04032019

9.6.2. Performing a cast iron analysis (unetched sample)
Note: You can follow these step-by-step-instructions on your PC. They describe how
the graphite fraction is determined.

Step - Image source
1. Load theGlobularGraphite.tif example image.

l The graphite fraction is to bemeasured.

2. Activate theMaterials Solutions tool window. Should this tool window not be
visible, use theView > ToolWindows > Materials Solutions command to have it
displayed.

3. Click theCast Iron button.
4. In the Image source group, choose theSelected images option to analyze the

example image. This imagemust have been opened for this purpose, and have
been selected in the document group.

5. Select theSkip 'Sample information' check box.
l By doing so, you skip theSample information step which is not relevant for this
example image. However, it is quite possible that, when performing your own
analyses, youmight want to load sample results (e.g., the result of a previous
cast iron analysis that determined the graphite fraction). In this case, make sure
theSkip 'Sample information' check box is cleared, which will enable you to use
the Load results button, in theSample information step.

6. Select theAll images entry in theCheck settings and results list.
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7. Click theNext button.
l TheMaterials Solutions tool window will display the next step.

Step - Settings
1. Click this button to set that you want to determine the graphite fraction in an

unetched sample.
l If the button for etched samples has been active before, the setting options in
this window will now change.

2. Use the slide control to define the threshold value for the graphite detection.
Observe the sample. The threshold value has been correctly set when the
graphite particles can be completely detected.

In the illustration (1), the threshold value has been set too high, the detected particles
are too coarse. In the illustration (2), the threshold value has been set too low, the
particles are not detected completely. The illustration (3) shows a correctly set
threshold value.

3. In theStandard pick list, select the industry standard according to which the cast
iron analysis is to be carried out.
l Some standards contain either rules regarding themeasurement of the
nodularity or references to secondary standards. For this reason, additional
fieldsmay now be shown or hidden in the lower area of the tool window.

4. Select the graphite parameter that is to be determined. To do so, select the
corresponding check box. The possibilities listed below are available: Which size
classes, form classes and form factors are used for the classification, depends on
the industry standard according to which the cast iron analysis is performed.
l Graphite size:Sorts the detected particles into specific classes, according to
their size.

l Graphite form:Sorts the detected particles into specific classes, according to
their form.

l Graphite nodularity:Sorts the detected particles into specific classes,
according to their nodularity. The nodularity is a unit of measure for the
sphericity of the graphite.

l Graphite distribution:Makes it possible to compare the distribution of the
particles in the current image with the distribution in specific reference images.
When this check box has been selected, the additional step, theGraphite
distributionwill be added to the cast iron analysis. The graphite distribution
(types A-E) can only be determined for lamellar graphite.

5. In theMinimum size for graphite particle field, specify theminimum size that a
particle must have if it is to be taken into account during the cast iron analysis.
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l All particles that fall short of the value entered will be ignored when the analysis
is carried out.

l Particles that have been detected, but that aren't used for the analysis, (e.g.,
because they don't come up to theminimum size that has been set here) are
shownwith a dashed line in the image.

l The calculation of the sample's graphite fraction is not affected by this setting,
as the smaller particles are also used to calculate the area fraction.

6. In theStandard for size or Standard for nodularity picklist, select the industry
standard that you want to use tomeasure the nodularity.

Note: Whether this picklist is displayed and whether it is calledStandard for size or
Standard for nodularity depends on the entry that is selected above in theStandard
picklist.

7. When theEN ISO945-1:2010 entry is selected in theStandard picklist, the
Classify form IV particles as nodular particles check box becomes active. Select
this check box if all particles that belong to the form IV class should be considered
for the detection of the graphite nodularity. That means that the graphite
nodularity increases and that the number of nodular particles per mm² is also
higher.

8. If theASTMA247-17 entry has been selected in theStandard picklist: In the
Shape factor threshold field, set the threshold value to be used for counting a
detected graphite particle as nodular graphite.
l You can enter values between 0 and 1, the default value is 0.6. If you enter a
smaller value (e.g. 0.4), a larger proportion of the graphite particles found will
be counted as nodular graphite than for example with a value of 0.6.

9. Click theNext button.
l TheMaterials Solutions tool window will display the next step.

Step - Graphite Distribution
Prerequisite: You will only see this step if, in the previous step, you selected the
Graphite distribution check box.

In this step, you can compare the particles that have been detected with reference
images that show different distributions of graphite particles. You can then determine
which of the reference images shows a distribution that ismost similar to that of the
current image. The reference images correspond to images that the chosen standard
contains.

1. In theStyle group, choose how the images are to be arranged in the document
group for the comparison. Choose an arrangement in which the
GlobularGraphite.tif image and the selected reference image are superimposed.
To do so, click this button
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.
l In theOverview field, you see the arrangement that has been chosen. The
selected reference image is framed in red.

l TheCast iron analysis document will now be displayed in the document group.
It contains exactly one image.

2. Compare the graphite distribution of the current image with that of the reference
image. Move the slide control below theStyle field towards theOpaque position, if
the image that is to be checked is to superimpose the reference image.
Alternatively, move the slide control towards the Transparent position, if the image
that is to be checked is to be superimposed by the reference image. If you want to
choose another reference image, in theOverview field, click that image with your
left mouse button.

The illustration on the left shows the image that is to be checked. Because the slide
control is located in near theOpaque position, the reference image's structures can
only be faintly recognized. For the illustration on the right, the slide control has been
moved towards the Transparent position. Now, the reference image can be clearly
recognized, and the image that is to be checked can be only faintly recognized.

3. When you have selected the reference image that is themost similar to the image
that is to be checked: Click theAccept button.
l The chosen image's data will be accepted in theResults field.

l It's possible to accept several reference images, for example, with samples that
have very different structures.
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4. Click theNext button.
l TheMaterials Solutions tool window will display the next step.

Step - Image results
1. Take a look at the results that are shown in the table and also in the image. Select

theShow graphite detection check box, in theValidation group.
l Every particle that has been detected will then be outlined with a colored line.
The color with which the particle is outlined, shows you to which class it
belongs. The same colors will be used in the chart.

On the left, you see the colored identification of the particles in the image. On the right,
you see the chart of graphite sizes that uses the same colors.

l Particles that have been detected, but that aren't used for the analysis (e.g.,
because they don't come up to theminimum size that has been set for the
program options), have a dashed line.

2. If you selected several graphite parameters in theSettings step, toggle between
the different charts.

3. If you want to correct the automatically found particles, use the buttons in the
Validation group.

4. Click theNext button.

Step - Results
1. Take a look at the results that are shown in the table. Among other things, the

number of particles is shown here.
2. Select theGenerate report check box and then select either theWord option or

theExcel option to automatically create a report in the corresponding application
programwhen the analysis finishes.

3. Select theGenerate workbook check box to have a document of theWorkbook
type automatically created at the end of the analysis.
l Leave theGenerate chart check box cleared for these step-by-step
instructions.

4. Click theSave results button, if you want to also determine the ferrite/pearlite-ratio
in another cast iron analysis, on the basis of the etched sample. You can then load
the graphite fraction determined here, and won't need to enter it manually.
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5. Click theNext button.

Step - Reporting
Define the report that contains themeasurement results.

l These are largely the same settings that you could already save in the previous
step, theResults step. You can, however, additionally specify which Excel
template you want to use for the report creation here.

l TheMaterials Solutions tool window switches back to the start position. You
can now use all of your software's functions again.

l Save the image in the TIF or VSI file format.
00736 10072018
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9.6.3. Performing a cast iron analysis (etched sample)
Note: You can follow these step-by-step-instructions on your PC. They describe how
tomeasure the ferrite/pearlite-ratio.

Step - Image source
1. Load the "Ferrite Pearlite.tif" example image.

l The ferrite/pearlite-ratio is to bemeasured.

2. Activate theMaterials Solutions tool window. Should this tool window not be
visible, use theView > ToolWindows > Materials Solutions command to have it
displayed.

3. Click theCast Iron button.
l As soon as you've started this analysis process you'll be guided step by step
through themeasurement. A lot of your software's other functionswill not be
available while an analysis process is running.

l TheMaterials Solutions tool window displays the Image Source step.

4. In the Image source group, choose theSelected images option to analyze the
example image. This imagemust have been opened for this purpose, and have
been selected in the document group.

5. Select theSkip 'Sample information' check box.
6. Select theAll images entry in theCheck settings and results list.
7. Click theNext button.

l TheMaterials Solutions tool window will display the next step.

Step - Settings
1. Click this button to set that you want to determine the ferrite/pearlite-ratio, using

an etched sample.
l If the button for unetched samples has been active before, the setting options in
this window will now change.

2. Use the Threshold for ferrite slider to define the ferrite phase. By doing so, you set
the range of intensity values (the phase) that is valid for the ferrite detection. If the
slide control is closer to the Low position, the phase contains a larger part of the
intensities that are present in the image. If the slide control is closer to theHigh
position, the phase contains a smaller part of the intensities. Thismeans that only
a smaller part of the intensity values is detected as ferrite. All of the pixels that
have been detected as ferrite will be highlighted in yellow in the image.
l The threshold value has been correctly set when the ferrite is completely
detected.
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In the illustration (1), the threshold value has been set too low, toomany particles are
detected as ferrite. In the illustration (2), the threshold value has been set too high, the
ferrite is not detected completely. The illustration (3) shows a correctly set threshold
value.

3. Use theClose gaps in pearlite phase slide control to define how rigid the voids that
the pearlite contains, are to be closed. In this context, a void in the pearlite is an
area within the pearlite that has so bright intensity values that it is assigned to the
ferrite. In the image, voids are visualized as an accumulation of small yellow points
within the pearlite.
Using theClose gaps in pearlite phase slide control is ameans of correcting these
voids. To do so, amorphological filter is applied. Morphological filters are often
used in image analysis to optimize the results of an automatic object analysis.

In the illustration (1), the pearlite phase is little closed. This is whymany voids have
been detected within the pearlite (see arrows). The illustration (2) shows a pearlite
phase that ismore closed.

4. In theGraphite fraction group, select how this sample's graphite fraction is to be
entered. The graphite fraction will be subtracted from the detected pearlite
fraction. Using the pearlite area that has in this way been corrected, the
ferrite/pearlite ratio is calculated. This step is necessary because graphite and
pearlite have very similar gray values and can therefore not be detected
separately by the software. There are two possibilities how to enter the graphite
fraction:
l You select theEnter manually option and enter the value. This option is always
active. You can have e.g., made a note of this value, or have saved it in a
report.

l You select theResult of unetched sample analysis option. This option is only
active if, in the same analysis, you have alreadymeasured the graphite
fraction, using an unetched part of the sample. This option is also active if, you
measured the graphite fraction in a previous analysis, saved these values in a
parameter set and loaded them in the current analysis' Sample information
step.

5. Click theNext button.
l TheMaterials Solutions tool window will display the next step.
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Step - Image results
1. Take a look at the results that are shown in the table. Among other things, here

you will find the ferrite/pearlite-ratio that has beenmeasured.
2. Take a look at the displayed results in the image aswell. To do so, select the

Show ferrite detection check box, in theValidation group.
l Each detected ferrite particle will now be outlined in yellow.

3. Click theNext button.

Step - Results
Select the results you want.

Step - Reporting
Define the report that contains themeasurement results.

l Select theOne page per sample check box, if the report should contain one
page for every sample. This page displays the overall results for all of the
images belonging to that sample. Using this setting is a good idea, for example,
when you have analyzed images of different samples.

l These are largely the same settings that you could already save in the previous
step, theResults step. You can, however, additionally specify which Excel
template you want to use for the report creation here.

00737 08082019
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9.7. Non-metallic inclusions

9.7.1. Overview
There are two analysis processes available in your software for the analysis of non-
metallic inclusions inmetal samples:

1. an analysis of the inclusion content
2. an inclusionsworst field analysis

What is an inclusions worst field analysis?
An inclusionsworst field analysis is a procedure used to checkwhether there are non-
metallic inclusions inmetal samples. This analysis can be used tomeasure the size
and distribution of non-metallic inclusions in steel samples and to determine what type
they are. Non-metallic inclusions can be sulfides and oxides, for example.

With themeasurement results, different production processes can be compared, or
the quality of a product determined.

What exactly is a non-metallic inclusion?
During the production processes, non-metallic inclusions can accrue within steel
alloys. Inclusions affect the chemical andmechanical properties of the steel. The fewer
inclusions there are in a steel, and the smaller and homogeneous these are, the better
is its quality.

Microscope image of different inclusions in a polished steel sample. The inclusions
differ in their color and form. The images show a sulfide inclusion (1), a silicate
inclusion (2), and an aluminum oxide inclusion (3).

The nature and appearance of the non-metallic inclusions depend on a variety of
factors, such as, e.g., the steel type, or the production process. The inclusions are
divided into different classes according to their appearance (color, form, and size). The
classification ismade according to different industry standards.

Since all inclusions are darker than the color of the steel, they can easily be detected
bymeans of an automatic image analysis. When detecting the inclusions, the
inclusionsworst field analysis searches for particles. For the image analysis software,
a particle is a cohesive number of pixels, that all lie within a defined intensity range. For
this reason, you first have to define the intensity range.

You can also define two intensity ranges. This is necessary when the sample contains
both gray (sulfide) and black (oxide) inclusions, for example.
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Particle detection during an inclusionsworst field analysis. When a suitable definition
of the gray value ranges has beenmade, the sulfides (green) and the oxides (red) will
be detected.

Editing inclusions
You canmanually edit the inclusions that your software found automatically. You have
the possibility of deleting, splitting, or joining up inclusions, and you can also change
their type.

Results of an inclusions worst field analysis
If the sample is suitable and the thresholds are set correctly, this analysis finds either
the largest non-metallic inclusion in the sample being analyzed, or the field with the
most inclusions (sorted into inclusion types). The classification and naming convention
of the inclusions differs from industry standard to industry standard. The sizes are
measured in accordance with the industry standards:

l ASTME 45-18method A
l DIN 50602:1985methodM
l ISO 4967:2013method A
l GB/T 10561:2005method A
l JIS G0555:2003method A
l UNI 3244:1980methodM
l EN 10247:2017methodM(L/n)
l EN 10247:2017methodM(L/d)
l EN 10247:2017methodM(a)
l EN 10247:2017methodM(a/n)
l EN 10247:2017method P(a)
l EN 10247:2017method P(L/d)
l SEP 1571:2017methodM

Note: It is also possible to perform an inclusionsworst field analysis with the EN 10247
standards’ version from 2007. To do so, select this version of the standard in the
program options. You have to do this before starting the analysis process.

Viewing inclusions on the image
If you want to view detailed results for individual particles while the analysis is still in
progress, use theShow Inclusion Results button in the Image results step.
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When this button is active, the details for an inclusion are displayed when you hover
themouse pointer over it in the image window.Which details these are depends on
the standard that has been selected. Usually, the type, the length, and the width are
indicated. For some standards, the area is also shown. For some standards, if the
length or width of an inclusion exceeds the specified limit oversizedwill also be
displayed.

Displaying the results in the workbook
The results of an analysis can be displayed in a workbook. If theDisplay inclusion
results in the workbook check box has been selected in the program options, the
workbookwill also contain the individual results for each inclusion that was detected, in
addition to the overall results. If oversized inclusionswere detected, theywill be
identified with a plus sign (+) in the Type column.

Displaying the results in the report
Additionally, the results can be displayed in a report in either MS-Word or MS-Excel
format.

00733 25022021

What is an analysis of the inclusion content?
An analysis of the inclusion content is a procedure used to checkwhether there are
non-metallic inclusions inmetal samples. This analysis can be used tomeasure the
size and distribution of non-metallic inclusions in steel samples and to determine what
type they are. Non-metallic inclusions can be sulfides and oxides, for example.

With themeasurement results, different production processes can be compared, or
the quality of a product determined.

If the sample is suitable and the thresholds are set correctly, the analysis of the
inclusion content detects all of the non-metallic inclusions in the sample being
analyzed. The prerequisite is that the inclusionsmust be within the area of the fields.
Because of the complexity, an analysis of the inclusion content can currently only be
performed onmonochrome 8 bit images.

The images to be analyzed are usually stitched images of a polished steel sample. The
whole image is divided into fields by default. All of the fields are called theArea of
fields. Each field has a size of 710 µm x 710 µm as specified by the standard. This
corresponds to an area of the sample of 0.5mm2 per field. The supported standards
recommend aminimum sample area of 10mm x 16mm. This amounts to 320 fields.
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The illustration shows an image (3) with the area of fields (2). The area of fields is
made up of individual fields (1).

Observing ambiguous inclusions at the microscope
If you want to observe an inclusion in detail, click it in the image window. Your stage
will thenmove to the corresponding part of the sample and you can observe this
inclusion in detail at themicroscope.

This option is only available if your microscope has amotorized stage and if youmade
all the necessary settings for the stage path and the scan area.

The results of an analysis of the inclusion content
If the sample is suitable and the thresholds are set correctly, the analysis of the
inclusion content detects all of the non-metallic inclusions in the sample being
analyzed. This is done for each inclusion type separately. The classification and
naming convention of the inclusions differs from industry standard to industry
standard. The analysis is performed in accordance with the selected standard and the
selectedmethod. The following standards are available:

l ASTME 45-18method D
l ISO 4967:2013method B
l EN 10247:2017method K
l SEP 1571:2017method K

Note: The results of the different standards are displayed differently in the image
window and in the Image Navigator tool window.With the first two standards, a
colored outline is displayed around each field (and around each inclusion) that
contains a detected inclusion of the currently selected type.With theEN 10247:2017
andSEP 1571:2017 standards, a colored outline is displayed around each inclusion
that is detected. The fields don't have a colored outline.
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Illustration on the left: Display of the results in the Image Navigator tool window when
the analysis is performed in accordance with theASTME 45-18method D or the ISO
4967:2013method B standard. In the example shown 4 fields are outlined.
Illustration on the right: Display of the results in the Image Navigator tool window when
the analysis is performed in accordance with theEN 10247:2017method K or the
SEP 1571:2017method K standard. The inclusions of the currently selected type are
outlined.

00571 31012020

9.7.2. Performing an inclusions worst field analysis
Note: You can follow these step-by-step-instructions on your PC. It describes how you
can detect the worst inclusion in a sample.

Prerequisite: In order to analyze imageswith the inclusionsworst field analysis, make
sure that the sample is placed on the stage in a way that the inclusions have a
horizontal orientation in the image.

Image source step
1. Load the NMI0_0.tif example image.

l The largest non-metallic inclusion is to bemeasured.

2. Activate theMaterials Solutions tool window. Should this tool window not be
visible, use theView > ToolWindows > Materials Solutions command to have it
displayed.

3. Click the InclusionsWorst Field button.
4. In the Image source group, choose theSelected images option to analyze the

example image. This imagemust have been opened for this purpose, and have
been selected in the document group.

5. Select theSkip 'Sample information' check box.
6. Select theAll images entry in theCheck settings and results list.

l If you analyze your own images later on, you can also select another entry from
this list, for example, if you don't want to check the settings for every image
anymore.

7. Click theNext button.
l TheMaterials Solutions tool window will display the next step.
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Settings step
1. In theEvaluationmethod field, set the industry standard you are going to use for

the analysis.
2. Use theAll inclusions slide control to define the threshold value for all of the

inclusions. You can find this slide control in the Thresholds group. Observe the
sample. The threshold value has been correctly set when the inclusions are
completely recognized.

The illustration shows a correctly set threshold value.

3. Since in this sample there are no oxide inclusions, set theOxide inclusions slide
control at the position Low.

4. Click theNext button.
l TheMaterials Solutions tool window will display the next step.

Image results step
1. Take a look at the results that are shown in the table. Should you have analyzed

several images of the same sample, you can switch between a display of the
image results for the current image and the results for all of the images. To do this,
select either the Image option, or theSample option, located below the table.
l The table with themeasurement results contains a classification of the
inclusions that have been detected. How this classification looks like, depends
on the standard bywhich the analysis was performed.
For example, the "ASTME 45Method A" standard uses the classification A
(Sulfide), B (Alumina), C (Silicate) and D (Globular Oxide). Furthermore, this
standard groups the inclusions into "t" (thin) and "h" (heavy), according to their
mean width (inclusions type A, B, C) or to their diameter (inclusions type D).
Other standards use another classification of the inclusions, and don't further
divide them up into groups.

2. Take a look at the displayed results in the image aswell.
l In the image, every detected inclusion will now be outlined with a colored line.

The illustration shows a detected particle. The entire inclusion is outlined with a
colored line.

l Particles that have been detected, but that aren't used for the analysis (e.g.,
because they don't come up to theminimum size that has been set in the
industry standard), are shownwith a yellow line.
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3. If you want to see detailed results for an inclusion: Click theShow Inclusion
Results button andmove themouse pointer in the image window to the required
inclusion.
l The details for the selected inclusion will be shown.Which details these are
depends on the standard that has been selected. Usually, the type, the length,
and the width are indicated. For some standards, the area is also shown. For
some standards, if the length or width of an inclusion exceeds the specified limit
oversizedwill also be displayed.

3. If you want to correct the automatically found inclusions, use the buttons in the
Edit inclusions group.

5. Click theNext button.

Results step
1. Take a look at the results that are shown in the table. Here, you see, for each

inclusion type separately, the worst inclusion found in any of the analyzed images.
2. Select theGenerate report check box and then select either theWord option or

theExcel option to automatically create a report in the corresponding application
programwhen the analysis finishes.

3. Select theGenerate workbook check box to have a document of the "Workbook"
type automatically created at the end of the analysis.

4. If you want to save the current settings to a file, click theSave settings button.
Then assign a descriptive name in the next dialog box.

Reporting step
Define the report that contains themeasurement results.

l These are largely the same settings that you could already save in the previous
step, theResults step. You can, however, additionally specify which Excel
template you want to use for the report creation here.

00738 04032019

9.7.3. Performing an analysis of the inclusion content
The following step-by-step instruction describes, in a simplified way, how you can
detect the inclusion content in a sample.

Preparation
Whenworking with stitched images, it is useful to have the Image Navigator tool
window always displayed. Then you can easily zoom in and out of the stitched image
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without losing orientation. Therefore, click theDisable Auto Hide button once in the
Image Navigator tool window before starting the analysis process.

Preconditions that must be met by the image to be analyzed:
The following prerequisitesmust bemet so that an analysis of the inclusion content
can be successfully performed on a stitched image.

l the steel samplemust be optimally prepared for analysis of the inclusion content
(cleaned and polished)

l the steel samplemust be Illuminated appropriately for the acquisition (no
overexposure)

l the steel samplemust show inclusions that are suitable for an automatic analysis
l the inclusionsmust be aligned horizontally in the image

Image source step
1. Load the image that you want to analyze. You want to measure all non-metallic

inclusions on this image.
Note: As a rule, stitched images are saved in VSI file format. When you load images,
the default file format is TIF. If you don’t see the image that you want to analyze in the
Open Image dialog box, selectAll file format.

2. Activate theMaterials Solutions tool window. Should this tool window not be
visible, use theView > ToolWindows > Materials Solutions command to have it
displayed.

3. Click the Inclusion Content button.
4. In the Image source group, choose theSelected images option to analyze the

example image. This imagemust have been opened for this purpose, and have
been selected in the document group.

Note: If your microscope has amotorized stage, you can select theStage Path option
here. When youmake all the necessary settings for the stage path and the scan area,
then you have the following possibility: In the Image results step, you can click on an
inclusion in the image window . Your stage will thenmove to the corresponding part of
the sample and you can observe this inclusion in detail at themicroscope.

5. Select theSkip 'Sample information' check box.
6. Select theAll images entry in theCheck settings and results list.
7. Click theNext button.

l TheMaterials Solutions tool window will display the next step.

Area of fields step
1. Decide whether you want the area of fields to be a rectangle or a polygon. For

these step-by-step instructions, select theRectangle option.
l By default, the area of fields is rectangular and covers the whole image.

2. Use themouse to reduce the size of the area of fields and then place it at a
suitable position on the sample (see illustrations).
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Illustration on the left: Position the pointer on amarker in the image window. The
mouse pointer will change shape (see the red ellipse). Drag the handle in the required
direction.
Illustration in the center: The size of the area of fields has been reduced. The
values in theArea andNumber of fields fields are automatically updated.
Illustration on the right: To change the area of fields, position your mouse pointer
over one of its handles again. Themouse pointer turns into a four headed arrow (see
the red circle). While pressing the left mouse button, drag the area of fields to the
required position.

3. If required, change the line color that is used to show the area of fields.
4. Click theNext button.

l TheMaterials Solutions tool window will display the next step.

Settings step
1. In theEvaluationmethod field, set the industry standard you are going to use for

the analysis. For these step-by-step instructions, theEN 10247:2017method K
industry standard is selected.

2. Set the slide control for All inclusionsmore to the positionHigh (for example, to the
value 200). Observe the sample. The threshold value has been correctly set when
the inclusions are completely recognized.

3. Set the slide control forOxide inclusionsmore to the position Low (for example, to
the value 50).

4. Click theNext button.
l TheMaterials Solutions tool window will display the next step.

Image results step
1. First, take a look at the displayed results in the image. Each inclusion that has

been detected is now outlined in the color of the inclusion type it has been
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assigned to.

2. Then take a look at the results that are shown in the table Inclusions results. The
table with themeasurement results contains a classification of the inclusions that
have been detected.

3. Click on a cell in theNumber column to have all inclusions displayed in bold that
correspond to the selected inclusion type and that have been assigned to the
selected length class. The length classes can be found in the left column in the
Inclusions results table.

The illustration on the left shows an example where the 2 inclusions are selected in the
table that have been assigned to the 355 µm length class.
The illustration on the right shows the Image Navigator tool window. The two
inclusions have been highlighted whichmakes them easy to find (see the two arrows).

4. Select theShow all inclusions of selected type check box to display all inclusions
of the currently selected type in bold in the image window, nomatter what their
size is.

5. If you want to see detailed results for an inclusion: Click theShow Inclusion
Results button andmove themouse pointer in the image window to the required
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inclusion.

l The details for the selected inclusion will be shown.Which details these are
depends on the standard that has been selected. Usually, the type aswell as
the exact length and width are displayed. For some standards, the area is also
shown. For some standards, if the length or width of an inclusion exceeds the
specified limit oversizedwill also be displayed.

6. If you want to correct the automatically found inclusions, use the buttons in the
Edit inclusions group.

7. Click theNext button.

Results step
1. Take a look at the results that are shown in the table. The following information is

given:
l Industry standard andmethod used
l Sample name
l Number of images
l Total area of fields
l Detailed sample results, sorted by inclusion types

2. Select theGenerate workbook check box to have a document of theWorkbook
type automatically created at the end of the analysis.

3. If you want to save the current settings to a file, click theSave settings button.
Then assign a descriptive name in the next dialog box.

4. Click the Finish button.
00570 31012020

9.7.4. Editing inclusions
There are two analysis processes available in your software for the analysis of non-
metallic inclusions inmetal samples:

1. an analysis of the inclusion content
2. an inclusionsworst field analysis

In both analysis processes, you canmanually edit the inclusions that your software
found automatically.

Note: If you havemanually corrected inclusions and return to theSettings step (e.g., to
change the settings of the slide controls), your manual correctionswill be deleted.
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Merging inclusions
1. Enlarge the display of the image until you can easily recognize the two inclusions

that you want to join.
l In this example, these two inclusions are to be joined.

2. In theEdit inclusions group, click theMerge inclusions button.
l Themouse pointer will change its form. You will then be in edit mode. The only
thing you can do now is tomerge inclusions. In thismode, other work with your
software isn't possible.

3. With your left mouse button, click the two inclusions.
Note: Should you join two inclusions that belong to different inclusion types, the
inclusion type of the first inclusion you selected will be used for the new joint inclusion.
In this case, take care that you click the two inclusions in the right order.

l The inclusionswill be joined. The results will be updated.

4. If you want to, you canmerge further inclusions.
5. Click your right mouse button to leave the edit mode, and to confirm the changes.

Splitting an inclusion
1. Enlarge the display of the image until you can easily recognize the inclusions that

are to be separated.
l In this example, the particle on the far left-hand side that is indicated by an
arrow is to be split.

2. In theEdit inclusions group, click theSplit inclusion button.
l Themouse pointer will change its form. You will then be in edit mode. The only
thing you can do now is to split inclusions. In thismode, other work with your
software isn't possible.

3. To do so, click once with your left mouse button at an arbitrary position on the line
surrounding the inclusion.
l The surrounding line and all of the particles that belong to this inclusion will be
displayed bold.

4. Click with your left mouse button at the position in the image where the separation
line is to begin. This defines the line’s start point.

5. Move themouse pointer to draw a separation line through the object.
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6. Click the left mouse button to confirm the separation.
l The inclusion will be split.

7. If you want to, you can split further inclusions.
8. Click your right mouse button to leave the edit mode, and to confirm the changes.

l The results will be updated.

Deleting an inclusion
1. Enlarge the display of the image until you can easily recognize the inclusion that is

to be deleted.
2. In theEdit inclusions group, click theDelete inclusion button.

l Themouse pointer will change its form. You will then be in edit mode. The only
thing you can do now is to delete inclusions. In thismode, other work with your
software isn't possible.

3. Position your mouse pointer on the inclusion that is to be deleted.
l The line surrounding the inclusion will be displayed bold.

4. Click the left mouse button.
l The inclusion will be deleted.

5. If you want to, you can delete further inclusions.
6. Click your right mouse button to leave the edit mode, and to confirm the changes.

l The results will be updated.

Changing the inclusion type
1. Enlarge the display of the image until you can easily recognize the inclusion that is

to be changed.
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2. In theEdit inclusions group, click theChange inclusion type button.
l Themouse pointer will change its form. You will then be in edit mode. The only
thing you can do now is to change an inclusion's type. In thismode, other work
with your software isn't possible.

3. Left click once on the inclusion that you want to assign to a different inclusions
type.
l A picklist will drop down. It shows all of the inclusion types that the currently
chosen standard contains. A checkmarks the currently chosen inclusion type.

An example of what the picklist can look like. Depending on the standard that has been
chosen, the picklist can contain other entries.

4. Select the new type of inclusion you want.
l The new inclusion type will be assigned. In the image, the inclusion will now be
displayed with a surrounding line in another color.

5. Click your right mouse button to leave the edit mode, and to confirm the changes.
l The results will be updated.

00739 20082019
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9.8. Throwing Power Measurement

9.8.1. What is a throwing power measurement?
Use the Throwing Power solution to determine the quality of the copper plating on an
HDI panel. You canmeasure through-holes, microvias and filledmicrovias.

The Throwing Power solution is completely integrated into theMaterials Solutions tool
window. The tool window works in a similar way to a software wizard. As soon as
you've started an analysis process you'll be guided step by step through the
measurement.

Before you start a throwing power measurement

The following conditionsmust bemet before you start a throwing power
measurement.

1. Prepare suitable cross-sections through the panels. Tomeasure a through-hole,
you will also need a flat section of it.

2. The results of a throwing power measurement is usually saved in a database. You
should thus open the required database.
If no database exists yet, create one using the database template supplied.
The flexible measurement mode is an exception. In thismode, the table with the
measurement results isn’t automatically saved.

3. Align your microscope.
4. Make sure that your software is correctly configured.
5. Start your software. Switch to livemode and select the best settings to acquire an

image.While a throwing power measurement is in progress, youmay no longer
alter all settings for the image acquisition.
l Check the white balance If necessary, carry out a white balance.

l Select the live-image's resolution in theCamera Control tool window.
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General procedure for a throwing power measurement

1. Selecting the analysis process
Click the Throwing Power button, located in theMaterials Solutions tool

window.

2. Step - Settings
Select one of the followingmeasurement methods: Through-holes,Microvias, Filled

through-holes, Filledmicrovias.
When you select the Flexible mode entry, the final two steps in the analysis disappear.

3. Step - Diameter
If you have selected the Through-holesmeasurement method: Place a flat
section of the through-hole under your microscope. Measure the diameter of

the through-hole.

4. Step - Measurements
Place a cross section through the panel under your microscope. Measure all of the

parameters specified in theMeasurements list.
Repeat this step in the analysis andmeasure other cross sections.

5. Step - Report images
Acquire three images for the final report.

6. Step (MS-Word, MS-Excel)
Produce a report with the results of the throwing power measurement. The
procedure is slightly different, depending on whether you want to create the

report in MS-Word or MS-Excel.
00500
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9.8.2. Measurements
In this step you carry out the actual throwing power measurement. The sequence and
themeasurement parameters are specified. Your software will show all of the required
measurement parameters in a diagram.

The following options are available:

(1) Displaying the parameters to bemeasured
(2) Performing the throwing power measurement
(3) Continuing the throwing power measurement

(1) Displaying the parameters to be measured

Your software will provide you with visual support when performing the throwing
power measurement. The distance which is to bemeasured next will be drawn in the
schematic illustration at the top of theMaterials Solutions tool window. The copper
plating is shown in orange, the panel in green.

From theMeasurements list, choose anymeasurement parameter to show the
distance to bemeasured in the schematic illustration.
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Required measurement parameters

Through-holes

d = diameter of the through-hole
(additional remarks further below)

S1-4 = thickness of the surface plating

B1-6 = thickness of the plating inside
the through-hole

Microvias

d = diameter of themicrovia

T= thickness of the panel

S1, S2 = thickness of the surface
plating

Bmin = minimum thickness at the
bottom of themicrovia (additional
remarks further below)

Filled microvias

d = diameter of themicrovia

T= thickness of the panel

S1, S2 = thickness of the surface
plating

C1, C2 = minimum corner plating
thickness

D = the dimple's height or depth ( 
additional remarks further below )

Filled through-
holes

d = diameter of themicrovia

T= thickness of the panel

S1-4 = thickness of the surface plating

C1-4 = minimum corner plating
thickness at the top and bottom of the
microvia

Dt =the dimple's height or depth at the
upper side

Db = the dimple's height or depth at
the lower side (additional remarks
further below)
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Remarks about the required measurement parameters
1. You can't preciselymeasure the actual through-hole diameter on the panel's

cross section if the cross section doesn't run exactly through the center of the hole.
Therefore, a separatemeasurement of the hole's diameter is needed on a flat
section of the through hole.

2. Look for theminimumplating thickness in the area that is indicated in the
illustration. Measure this thickness to get theBmin parameter.

3. A Dimple represents the difference in heights between the plated copper within a
microvia or through-hole and around the perimeter of that microvia or through-
hole. When the filledmicrovia or through-hole is not completely filled, the
measurement value is positive.
When the filledmicrovia or through-hole is overfilled, themeasurement value is
negative.

Instruction images for flexible measurement mode
You can also use the Throwing Power Solution to define your own rules for measuring
lengths on similar samples. You can provide the user with visual support when
performing the throwing power measurement by providing instruction images.

(2) Performing the throwing power measurement

Measure the distance which is shown in the diagram. To do that, click with the left
mouse button on the start and end points of the distance to bemeasured.

(3) Continuing the throwing power measurement

As soon as you havemeasured all of the parameters which are required for the
selectedmeasurement method, theNext andGet Results button will become active in
the lower part of the dialog box.

Performing additional measurements

Click theNext button tomeasuremore structures on your panel. All of the
measurement parameters will be reset for the new measurement. The previously
measured parameters will be saved and will be included in the analysis, which will be
issued in a report at the end of the throwing power measurement. If you would like to
examine the individual measurements again later on, save a workbook in the database
in theReporting step.

Finishing the throwing power measurement

Click theGet Results button.With this, the actual throwing power measurement is
finished. Acquire pictures for the report now and then create the report.

If you are using a user-definedmeasurement method, click the Finish button to end the
measurement.
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Possible warnings once the measurement is complete
To get statistically reliablemeasurement results, you will have tomeasure several
though-holes or microvia. You can set a requiredminimumnumber of between 1 and
10. To do this, use the Tools > Options > Materials Solutions > Throwing Power dialog
box. Threemeasurements is preset as theminimumnumber.
If you finish themeasurement before that, a corresponding warningmessage will be
produced.

During the analysis, the arithmeticmean of all of themeasurements carried out will be
calculated. If the standard deviation for ameasurement parameter exceeds 5%, you
will also get a corresponding warning. In this case, measure another five structures on
the panel, to increase the statistical reliability.

10594

9.8.3. Measuring the throwing power of a microvia on a circuit
board

Example: These step-by-step instructions describe theMicroviasmeasurement
method as an example of a throwing power measurement. The other measurement
methodswhich are available work in a similar way.

1. Prepare the throwing power measurement.
2. Activate theMaterials Solutions tool window. Should this tool window not be

visible, use theView > ToolWindows > Materials Solutions command to have it
displayed.

3. Click the Throwing Power button.
l TheMaterials Solutions tool window displays theSettings step.

Selecting the measurement method
4. From theMeasurement method list, select theMicrovias entry.

l In theMaterials Solutions tool window you will now see a schematic illustration,
which shows the cross section through amicrovia.

5. Click theNext button.
l TheMaterials Solutions tool window will display the next step.

l Your software will automatically switch to the livemode.

l TheCamera Control andMicroscope Control toolbars will be displayed so that
you can set the exposure time and the current magnification.

l TheMeasurements table in theMaterials Solutions tool window contains the
required parameters tomeasure the throwing power of amicrovia. The first
measurement parameter, d, will automatically be selected and will be shown in
the schematic illustration in a tool window.
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TheMicroviasmeasurement method contains the following parameters: d = diameter
of themicrovia, T = thickness of the circuit board,S1 andS2 = thickness of the surface
coating of the track,Bmin = minimum thickness of the coating at the base of the
microvia

Measuring the first microvia
6. Place one of the circuit board cross sections to bemeasured under your

microscope. Refer to the cross section as shown in the schematic illustration.
7. Move the stage so that the first distance to bemeasured can be clearly seen in the

live image and adjust the focus.
8. Select the best magnification. To do that, in theMicroscope Control toolbar, click

the required objective's button.

Note: The imageswhich you acquire with your software will only be correctly
calibrated if you specify the current objectivemagnification before acquiring the image.
Correctly calibrating the image is a requirement for a correct measurement.

9. Set a zoom factor for your image window that will make themicrovia that is to be
measured clearly visible. You can rotate themouse wheel to change the zoom
factor of the live image in the image window.
You will achieve themost precisemeasurements if you set the zoom factor at
100%.

10. If necessary, adjust the exposure time.
11. Measure the distance which is shown in the diagram. To do that, click with the left

mouse button on the start and end points of the distance to bemeasured.
l The line you havemeasured will be displayed in the image.

l The result will be displayed in theMaterials Solutions tool window in the
Measurements table.

l Your software will now automatically activate the next parameter to be
measured in theMeasurements table and will also show this in the diagram.
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In the live image, measure the diameter of themicrovia. The two helper lines stand
vertically on themeasured distance and help you to align themeasured distance
exactly with themicrovia's borders.

12. Move the stage so that the next distance to bemeasured can be clearly seen in
the live image and adjust the focus.
If necessary, select another objectivemagnification to be able tomeasure the
distance with the best accuracy.

13. Measure the required distance.
14. Repeat the last steps until you havemeasured all of the required parameters.

For the last measurement parameter, Bmin, measure the lowest thickness of the
coating within a certain area. This area is circled in the schematic illustration.
l As soon as you havemeasured all of the parameters which are required for the
selectedmeasurement method, theNext andGet Results buttonswill become
active in the lower part of the dialog box.

Measuring the other microvias
15. Click theNext button to conclude themeasurement for the current microvia.

l TheMaterials Solutions tool window displays theMeasurements step.

l As an intermediate step, your software will save all of the valuesmeasured so
far.

l All values from the last measurement will be deleted from theMeasurements
table.

16. Now, measure the next microvia. To get statistically reliable measurement results,
you will have tomeasure several microvia.

Finishing the throwing power measurement
17. Click theGet Results button when you havemeasured the required number of

microvias.
l TheMaterials Solutions tool window displays theReport images step.

18. Acquire three images to document themeasurement. You could for example,
acquire three different cross sections at a low magnification. Or you acquire an
overview image of amicrovia and then acquire two images at a higher
magnification showing interesting details.
If necessary, change the sample for this. Move the stage to the required location.
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Select a suitablemagnification and exposure time and focus on the sample.
Click on this button to acquire the image.
l The images acquired will be displayed in theMaterials Solutions tool window.

Acquire three images to finish the throwing power measurement.

19. Open the database where you would like to save themeasurement results. In the
database, select the folder where themeasurement results are to be saved, or
create a new record.

20. Click theNext button.
l TheMaterials Solutions tool window displays theReporting step. In the
Template group, you'll see a preview of the document template that has
currently been chosen.

21. Select theAddworkbook to the database check box.
22. Start theMSWord application.
23. Click this button .

l This finishes the throwing power measurement.

l TheMaterials Solutions tool window switches back to the start position.

l The three images that are acquired will be saved in the database. The name of
the images in the database is determined by the current default value for the
Image name database field. The database administrator can set up this default
value.

l A workbookwith themeasurement results will be created and saved in the
database.

l The concluding report will be generated and displayed inMS-Word.

Editing the report and saving it
1. Check the report in MSWord. If necessary, addmore text.
2. When you are satisfied with the report, in MSWord, use theOlympus > Save to

Database command to also insert the report into the database. Before doing that,
make sure that the correct database folder has been selected.
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The results of a throwing power measurement will be saved in the database. You can
for example access the data in the document view of the database (1). The project
header view (2) shows the higher level database folder. In the sample list view (3) the
database folder will be selected which contains the data. The gallery view (4) shows
the three images acquired, the workbookwith themeasurement results and the saved
MSWord report.

Loading the measurement results
3. In your software, open the database where themeasurement results are saved.
4. Switch to your database's document view. Select the database folder which

contains themeasurement results. If your database is based on the supplied
database template, then the database folder is a record of typeSample.

5. In the gallery view, double click, for instance, on the symbol for the workbook to
view themeasurement results.
l Theworkbook contains the values for all of themicroviasmeasured.

l Statistical values e.g. standard deviation, can also be displayed in the
workbook. You can specify exactly which statistical valueswill be shown. To do
this, open the Tools > Options > Measurement and ROI > Results dialog box.
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9.8.4. Performing a flexible number of length measurements on
more than one sample

You can also use the Throwing Power Solution to define your own rules for measuring
lengths on similar samples.

Example: You want to measure several distances on different wafers. Create a user-
definedmeasurement method and perform themeasurement on 10 wafers.

The first image shows a part of a wafer. You want to measure the same three
distances on different wafers (1-3).

Creating a preview image and an instruction image.
When you aremakingmeasurements on several samples, the distances always have
to bemeasured in the same order. You can provide the user with visual support when
performing the throwing power measurement by providing instruction images.

The imagemust meet the following conditions:

l All of the filesmust be saved in PNG format.
l All of the filesmust be in the same directory.
l The file namesmust have the following syntax:
00.png - Preview image
01.png - Instruction image for themeasurement of the first distance
02.png - Instruction image for themeasurement of the second distance

l Theremust be an image in the folder for each distance that you want to measure.
l The image resolutionmust be 200x200 pixels.

1. Create an image that shows the sample that you want to measure.
2. Create an image for eachmeasurement that you want to perform. The image

should show the distance that you want to measure aswell as the name of the
measurement. You can either simply number themeasurements, or you can
name themeasurement parameters.

Defining your own measurement method
3. Activate theMaterials Solutions tool window. Should this tool window not be

visible, use theView > ToolWindows > Materials Solutions command to have it
displayed.

4. Click the Throwing Power button.
l TheMaterials Solutions tool window displays theSettings step.

5. From theMeasurement method list, select the Flexible mode entry.
l Additional setting options now appear in theMaterials Solutions tool window.

OLYMPUS Stream UserManual 200



9.  Materials Science Analysis
9.8.   Throwing Power Measurement

6. This examplemeasures three distances. Therefore, enter a value of 3 in the
Number of measurements field.

7. This examplemeasures only distances. Therefore, clear theAdditional
parameters check box.

8. For this example, we want to create a report in theMS-Excel application program
at the end of the analysis. Select theGenerate report in Excel check box and leave
theGenerate workbook check box clear.

9. Click theNext button.
l TheMaterials Solutions tool window displays theMeasurements step.

l The table contains three entries, with themeasurement parameters 01, 02 and
03. Each parameter represents one of the distances that will bemeasured on
the sample.

l If necessary, you can rename themeasurement parameters now. To do this,
double click the name of the parameter and enter the required name.

10. Click theSave Settings... button.
l A dialog box for saving parameter sets opens.

11. Enter a descriptive name for the user-definedmeasurement method in theName
field,Wafer-3d for example.

12. In theDescription field, enter a comprehensive description of themeasurement
method. This description will be shown in theMaterials Solutions tool window later
when you perform themeasurement.

13. Select thePublic option. Themeasurement method can now also be used by
other users. You will be able to recognize this by the small icon ( ) next to the
parameter set's name.

14. Click theSave button to close the dialog box.
l Amessage box appears.

15. Click theYes button and go to the folder that contains the preview and instruction
images for the user-definedmeasurement method.
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In theMaterials Solutions tool window, the instruction image (1) that belongs to the
selectedmeasurement parameter (2) is displayed.

l If the images in the folder that you selected don’t meet the requirements, an
error message appears.

l The images are copied and saved together with the parameter set.

16. You can now start with themeasurement itself. If you only wanted to define the
measurement method, click this button in theMaterials Solutions tool window’s
navigation area.

Performing a measurement with a measurement method that has
already been defined
1. Click the Throwing Power button, located in theMaterials Solutions tool window.

l In theMeasurement method list, you find all of the user-definedmeasurement
methods that have been saved.

2. Select theWafer-3d entry from theMeasurement method list.
l In theMaterials Solutions tool window, you can now see the description and
the preview image.

3. Click theNext button.
l Your software will automatically switch to the livemode.

l TheCamera Control andMicroscope Control toolbars will be displayed so that
you can set the exposure time and the current magnification.

l TheMeasurements table in theMaterials Solutions tool window contains the
requiredmeasurement parameters. The first measurement parameter is
selected automatically and the first instruction image is displayed in the tool
window.
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4. Place one of the samples that you want to measure under your microscope. Move
to the position on the sample that is shown in the preview image.

5. Measure the distance that is shown in the instruction image. To do that, click with
the left mouse button on the start and end points of the distance to bemeasured.
l The line you havemeasured will be displayed in the image.

l The result will be displayed in theMaterials Solutions tool window in the
Measurements table.

l Your software now automatically activates the next parameter to bemeasured
in theMeasurements table. The instruction image is updated automatically.

6. Measure the required distance.
l As soon as you havemeasured all of the parameters which are defined in the
measurement method, theNext and Finish buttons in the lower part of the
dialog box become active.

7. Click theNext button to conclude themeasurement for the current sample.
l TheMaterials Solutions tool window displays theMeasurements step.

l As an intermediate step, your software will save all of the valuesmeasured so
far.

l All values from the last measurement will be deleted from theMeasurements
table.

8. Now, measure the next sample or the next position on the sample. To get
statistically reliablemeasurement results, you have to perform several
measurements.

9. Click theNext button to show the next stepReporting.
l Youwill only see this step if you selected theGenerate report in Excel check
box in the previous stepSettings.

10. Decide whether you want to use a default report template or a user-defined report
template. If you would like to select a user-defined report template, select theUser
defined option. Click the button with the three points and select the new report
template in theOpen dialog box.

11. Click the Finish button to complete themeasurement.
l TheMS-Excel application program opens and the report is displayed.

12. Use the File > Save command to save the report. Give it a descriptive name.
00501
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9.9. Porosity Measurement

9.9.1. What is a porosity measurement?
With a porositymeasurement, youmeasure the percentage of the surface of your
sample which ismade up of pores aswell as determining the number and density of
the pores. If the size of the pores is also being determined, all of the pores that exceed
a definedmaximumpore size can be displayed in color in the image. In this case, the
largest pore can be displayed in color in the image aswell.

Note: The samples are usuallymetallographic sections that have been prepared
especially for porositymeasurements. The porosity that ismeasured only applies to
the exposed cross-sectional plane of the sample. Therefore the porosity of other parts
of the sample that are above or below the cross-sectional planemay be different.

It is a precondition for a porositymeasurement that the pores differ from the rest of the
sample, for example, because they are darker. The pores thus have differing intensity
values to the rest of the sample, making automatic analysis of the image possible. For
the image analysis, so-called phases are defined which cover a certain range of
intensity values.

Porositymeasurement on one image. All of the pixels which lie within the defined
intensity range, will be shown in color during this step in the analysis. In the example
shown, red has been selected for the phase.

Selecting the industry standard
One of the following standards can be used for themeasurement if required.

l VW 50093/P 6093:2012
l VDGP 201-2002
l VDGP 202-2010
l VDGP 211-2010

Manually processing the image porosity value
You canmanually adjust the result of the automatic image analysis. You do this
interactively on the image. Note that you are not changing the image itself, but the
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image'smeasurement layer.

You canmanually delete parts of the image which have been recognized as pores (in
image analysis, one speaks of detected objects). This can be necessary, if for example
artifacts in the image are recognized as pores because they have similar intensity
values. Bymanually deleting these objects, the artifacts will be excluded from the
analysis.

In addition, you can alsomanually add other image segments which were not detected
as such but which are actually pores. With themanual addition and deletion of objects,
you always change the percentage porosity value of the image.

Measuring on ROIs
You can choose whether you would like tomeasure the entire image or if the
measurement should only be carried out on a part of the image, a so called ROI
(RegionOf Interest). You can also define several ROIs.

On the image, the porosity of an ROI ismeasured.

Results of a porosity measurement
The results of an analysis can be displayed in a workbook. Additionally, the results can
be displayed in a report in either MS-Word or MS-Excel format.
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General procedure for a porosity measurement

1. Selecting the analysis process
Click thePorosity button, located in theMaterials Solutions tool window.

2. "Image source" step
Choose the image you want to measure.

3. “Settings” step
Define the parameters for the pore size and porosity. If required, you can

select a standard.

4. “Target values” step
If necessary, you can change the preset target values. This step is optional.

5. "ROIs" step
Define the ROIs, or measure the porosity of the whole sample.

6. "Threshold" step
Define the intensity range for the phases.

7. "Image results" step
Take a look at your image results. If necessary, delete pores, or add new ones.

8. "Results" step
Document the results (report or workbook).

10606 11032019

9.9.2. Settings
In this step in the analysis, youmake all of the settings that you want to apply to the
porositymeasurement. First of all, at the top of the tool window select which standard
you want to use, if any.

If you are analyzingmore than one image at the same time, theSettings step is only
displayed for the first image. The settings that youmake here are automatically applied
to all of the other images.
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(1) Selecting the industry standard

Decide whether you want to use one of the following standards for the porosity
measurement. TheNone entry is selected by default. Thismeans that no standard will
be used.

l VW 50093/P 6093:2012
l VDGP 201-2002
l VDGP 202-2010
l VDGP 211-2010

When a standard is selected, some of the fields in the tool window change. For
example, thePore accumulations andPore nests check boxes are only displayed
when you have selected a standard.

(2) Pore size parameter
In thePore size parameter field, choose how the pore size is calculated.

Choose theMax. (Feret) setting to use themaximum spacing of parallel tangents on
opposing sides of particles.
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Choose theEquivalent Circle Diameter setting, to use the diameter of a circle which
has the same area as the particle.

If necessary, click on the button which shows the units and select the units in which the
image to be analyzed has been calibrated.

Disregarded pores
In the Lower limit field, enter theminimum size that an object must have to be
considered when determining the number of pores. In theUpper limit field, enter the
maximum size that an object may have to be considered when determining the
number of pores.

Note: In the Image results step, the disregarded pores are shown as not having been
detected. They don’t have a colored overlay.

Example of the way that disregarded pores are displayed in the Image results step.
The pores that are displayed without a colored overlay exceed the value specified in
theUpper limit field.

(3) Porosity parameters

Select which parameters you want to use to determine the porosity.

Parameters Description

Porosity

When this check box is selected, the porosity will be determined. Which
algorithm will be used depends on the standard that has been selected and on
the settings in theSettings and Target values steps.

If necessary, you can view and change the value in thePermissible porosity
field in the Target values step. The porosity is expressed in%.

Pore size

When this check box is selected, the pore size will be determined. Pores that
exceed themaximum permissible pore size are displayed with a colored edge
in the Image results step. If you haven't changed the color in the program
options (Tools > Options > Materials Solutions > Porosity) the colorGreenwill
be used for this.

When the pore size is determined, the largest pore is also displayed with a
colored edge by default in the Image results step. If you haven't changed the
color in the program options, the colorBluewill be used for this.

If required, themaximum permissible pore size is defined by the standard
being used. If necessary, you can view and change the pore size in theMax.
permissible pore size field in the Target values step.
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Number of pores

When this check box is selected, the number of pores will be determined. If
you have defined ROIs, only the number of pores that are inside the ROIs will
be determined.
You can view and change the number of pores in thePermissible number of
pores field in the Target values step.

Distance of
adjacent pores

When this check box is selected, the distance between two adjacent pores will
be determined. Pores that are at less than the permissible distance will not be
included in the results.

If necessary, you can view and change the distance in thePermissible
distance factor field in the Target values step.

Pore
accumulations >
Distance factor

When this check box is selected, your software will search for what are called
pore accumulations. The definition of a pore accumulation is that the distance
between two pores is smaller than the diameter of the smaller of the two pores
(when the value is set to 1 in theDistance factor field).

If necessary, you can view and change the value in thePore accumulations
field in the Target values step.

Pore nests >
Max. permissible
pore size

When this check box is selected, your software will search for what are called
pore nests. These are groups of pores that have an even larger area than pore
accumulations. Pore nests will only be searched for if the value in theMax.
permissible pore size field is larger than 0. If necessary, you can view and
change the value in thePore nests field in the Target values step.

Pore density >
Unit

When this check box is selected, your software will calculate how densely the
found objects are spaced in the defined area. If required, in theUnit field,
change the units used to show the pore density in the results. The unit is
always a unit of area (for example, 1mm² or 1 µm²).

The sample density selected in theUnit field must match the unit in which the
image that you want to analyze is calibrated.

If necessary, you can view and change the value in thePermissible pore
density field in the Target values step.

(4) Displaying the “Target values” step

The Target values step is optional. The check box is not selected by default. Select the
Define target values check box if you want to view or change the default settings, or if
you want to view the Target key field.

10632 04032019

9.9.3. Threshold
All of the pixels which lie within an automatically defined intensity range, will be shown
in color during this step in the analysis. This intensity range is called a "phase".

The intensity value range is limited by a top and a bottom intensity value. These are the
so-called threshold values.
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In this step in the analysis you can change the threshold values. You can also create
another phase.

On the left you can see a sample for which only one phase has been defined.

Please note that defined ROIswill not be considered in this step in the analysis, but
only in the next step.

(1) "Component" field

Click theAutomatic Threshold Computation button to have the threshold values
initially calculated automatically. Then you canmanually process them, if necessary.
TheAutomatic Threshold Computation dialog box opens. Make the necessary
settings here.

If youmeasure the porosity in a color image, in theComponent list you can select
whether the threshold value is to be determined on the intensity value or on the red,
green or blue part of the image. The threshold value setting in color images ismore
complex than it is in gray-value images.
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(2) Defining threshold values

Note: If you would like to set threshold values for several phases in a gray-value
image, you will have to begin by setting the threshold value for the darkest phase.
Then set the threshold value for the next phase, and so on.

Click theNew Threshold button to set an initial value for the selected phase's
threshold value range. As soon as youmove your mouse pointer onto the image it will
change its shape to that of a pipette.
Click on one pixel or on the image area whose intensity value is to be utilized as the
initial value for the threshold range. All of the pixels that have the same intensity value
will be colored in the image, and displayed in the histogram. The threshold value range
initially contains only this one intensity value. As a rule, you will still need to expand this
threshold value range. Continue clicking relevant pixels or threshold value ranges,
until all of the required structures in the image are a part of the phase.

Click theAdd Threshold button to select additional pixels that are to belong to the
threshold value range. The image segments will be colored and displayed in the
histogram. The current threshold value range will continue to be expanded until it
contains the intensity values of all of the selected pixels.

Click theShrink Threshold button to select pixels that aren't to belong to the threshold
value range. The threshold value range will continue to be reduced until it no longer
contains the pixels you have selected.

Click theUndo Pipet button to undo the last selections step by step. Click theRedo
Pipet button to restore the last selections that were undone, step by step.

Adding, changing, and deleting phases
Click on theAdd Phase button to add a phase for which the threshold values are to be
calculated automatically. Double click on the field in thePhase Name column, to enter
a name for the phase.

Double click on the field in theColor column to choose a color. The phase will be
displayed in the color you have assigned it, in the image window and in the histogram.
The intensity range for the phase will be automatically calculated. In the [ Min. field, the
lower threshold value will be specified. In theMax.[ field the higher value will be
specified. You can change the values here or you can change them interactively in the
histogram.

Click theRemove Phase button to delete a phase. It's only possible to remove a
phase when at least two phases have been defined.

(3) Changing threshold values interactively in the histogram

The histogram shows the intensity distribution of the active image. If the imagemainly
consists of light and dark areas, the histogramwill show two peaks. A peak is an
intensity value (or an intensity range) which occurs particularly frequently in the image.

The intensity range which was defined for a phase will be shown in color in the
histogram. You canmove the edges of the range in the histogram. To do that, move
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themouse pointer to the edge of the slide. If you havemore than one phase, the phase
that you would like to changemust be selected in the table.

When themouse pointer changes shape, click and drag the edge of the range in the
required direction. The values in the [Min. andMax.[ fields in the table will change. In
the image, there will now bemore or less pixels in the color of the phase.

10626 04032019

9.9.4. Performing a porosity measurement

Step - Image source
1. Load theMacroscopicComponent.tif example image.

l The porosity is to bemeasured in this image.

2. Activate theMaterials Solutions tool window. Should this tool window not be
visible, use theView > ToolWindows > Materials Solutions command to have it
displayed.

3. Click thePorosity button.
4. In the Image source group, choose theSelected images option to analyze the

example image. This imagemust have been opened for this purpose, and have
been selected in the document group.

5. Select theSkip 'Sample information' check box.
l By doing so, you skip theSample information step which is not relevant for this
example image.

6. Select theAll images entry in theCheck settings and results list.
7. Click theNext button.

l TheMaterials Solutions tool window will display the next step.

Step - Settings
1. Decide whether you want to perform the porositymeasurement according to a

particular standard. For these step-by-step instructions, use theVDGP 202-2010
standard.

2. In thePore size parameter field, choose how the pore size is calculated.
l Choose theMax. (Feret) setting to use themaximum spacing of parallel
tangents on opposing sides of particles.

l Choose theEquivalent Circle Diameter setting, to use the diameter of a circle
which has the same area as the particle.

3. The example image is calibrated inmillimeters. You should thus click on the button
which shows the units (at the right, next to theMinimum size for counting field),
and select mmas the units.

4. For these step-by-step instructions, leave the Lower limit check box and the
Upper limit check box in theDisregarded pores group clear.

5. In thePorosity parameters group, select the following check boxes.Porosity, Pore
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size,Number of pores. Leave the other check boxes clear for these step-by-step
instructions.

6. Leave theDefine target values check box selected.
l Then the Target values step, which is optional, will be shown. In this step in the
process you can view and change the porosity values that the sample you are
analyzingmust attain.

7. Click theNext button.

Step - Target values
1. The values that the sample you are analyzingmust attain to pass the porosity

measurement are displayed at the top of the Target values step. These values are
shown in the Target key field in the lower part of the tool window.
l The target key formats the values that you entered in a way specified by the
standard you are using. Some of the values in the target key are rounded up or
down. Themore parameters that are analyzed for the porositymeasurement,
the longer the target keywill be.

Example: The target keyVDG P202-%10/Ø1means: TheVDG P202 standard was
used. The permissible porosity is 10% (written%10). Themaximumpermissible pore
size is 1mm (writtenØ1).

l At the end of themeasurement, thePorosity key field is displayed in the Image
results step. The porosity key shows the results of themeasurement. All of
these values have also been rounded up or down. The format of the porosity
key and the target key are identical. This enables you to quickly compare the
requiredmeasurement results with themeasurement results that were
attained.

2. Because no adjustments are required for theMacroscopicComponent.tif example
image: Click theNext > button.
l For your own samples you will later need to enter suitable values here. You can
save these and use them for subsequent measurements.

Step - ROIs
1. For theMacroscopicComponent.tif example image, define a ROI which

encompasses the shape of the object. To do this click theCreatemagic wand
ROIs button and click a bright point in the image inside the component whose
porosity you aremeasuring.
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l TheROI will be displayed. If required, you can change the size and shape of
the ROI by changing the parameters in theMagic wand properties group.

l It is not absolutely necessary to define ROIs. So you can’t make any settings in
theROIs step.

2. Click theNext button.

Step - Threshold
All of the pixels which lie within a defined intensity range, will be shown in color during
this step in the analysis. This intensity range is called a "phase". The intensity value
range is limited by a top and a bottom intensity value. These are the so-called
threshold values.

Please note that the defined ROI will not be considered in this step in the analysis, but
only in the next step. This is why the background color in this step is also shown in
color.

1. If necessary, reduce or increase the intensity range of the phase. In the image,
watch how the object areas found become larger andmore objects are found.
l To do this, change the values in theMin. andMax. fields in the table in the tool
window. Alternatively, interactively change the lower and upper threshold
values in the histogram shown at the bottom of the tool window. Move the
mouse pointer over the edge of the phase, until the pointer changes and, with
the left mouse button pressed, drag the edge in the required direction.

2. Click theNext button.

Step - Image results
1. Take a look at the results in the overlay. All of the objects used to determine the

porosity value will, in this step in the analysis, be shown in the color that has been
selected for the phase.
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l When theShow largest pore check box is selected, the largest pore that was
detected will be displayed with a colored edge in the overlay. In the program
options, the color Blue is the default color.

l When theShow pores exceedingmax. permissible pore size check box is
selected, the pores that exceed themaximumpore size will also be displayed
with a colored edge. In the program options, the colorGreen is the default
color.

2. Select the Image option and take a look at the results displayed in the table.
l The porosity value is displayed. You can also compare the target keywith the
porosity key here.

3. If necessary, manually add objects or delete objects that have been detected. To
do this, use the two buttons in the lower part of the tool window.

l The results that are shown in the table are refreshed immediately.

4. Click theNext button.

Step - Results
Select the results you want.

Step - Reporting
1. Select theDefault option to use the template that has been defined as the default

template. If you would like to select another template, select theUser defined
option. Click the button with the three points and select the new template in the
Open dialog box.

2. When you want to create anMS-Word report: In theContent group, select the
check box for the pages the report should contain.

3. When you want to create anMS-Excel report: You can click theSave settings
button to save the current settings in a file.
l These are largely the same settings that you could already save in the previous
step, theResults step. You can, however, additionally specify which Excel
template you want to use for the report creation here.

4. Click the Finish button.
5. Through thematerials analysismeasurement, the image has collected one or

more additional layers (can be seen in the Layers tool window). Save the image in
TIF or VSI format to retain these newly created image layers.
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9.10. Phase Analysis

9.10.1. What is a phase analysis?
With a phase analysis, youmeasure the percentage of the area fraction that the phase
covers in your samples. A phase is a number of pixels which lie within a defined
intensity range. The intensity value range is limited by a top and a bottom intensity
value. These are the so-called threshold values.

It is a precondition for the phase analysis, that the phases differ from the rest of the
sample e.g. because they are darker or lighter. You can define one or more phases. If
the parts (objects) of the sample whose area fraction you would like tomeasuremostly
have the same intensity values, then one phase is enough. If the objects have very
different intensity values, then several phaseswill have to be set up.

With a phase analysis you can define phases andmeasure the percentage of the area
fraction that a particular phase covers. To the left, you can see an example for a phase
analysis with two phases (light and dark). In the right example, a third phase was
created for the same sample which covers the pixels lying between the dark and the
light phase.

The result of the automatic image analysis can be restricted by an object filter. Objects
which do not reach theminimumobject size will not be included when determining the
area fraction covered by the phase in percent. In this way you can, for example,
prevent dust particles being assigned to a phase and distorting the result.

Measuring on ROIs
You can choose whether you would like tomeasure the entire image or if the
measurement should only be carried out on a part of the image, a so called ROI
(RegionOf Interest). You can also define several ROIs.
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On this image, the area fraction covered by the phases ismeasured on two ROIs.

Manually adjusting the result of the automatic image analysis
You canmanually adjust the result of the automatic image analysis. You do this
interactively on the image. Note that you are not changing the image itself, but the
image'smeasurement layer.

You canmanually delete parts of the image which were detected as objects. This can
be necessary, if for example artifacts in the image are detected as objects because
they have intensity values similar to the defined phase. Bymanually deleting these
objects, the artifacts will no longer be included when determining the area fraction
covered by this phase.

In addition, you can alsomanually add other image segments which were not detected
as such but which are actually objects. When youmanually add and delete objects,
you always change the area fraction covered by the corresponding phase.

Results of a phase analysis
The results of an analysis can be displayed in a workbook. Additionally, the results can
be displayed in a report in either MS-Word or MS-Excel format.

General procedure for a phase analysis

1. Selecting the analysis process
Click thePhase Analysis button, located in theMaterials Solutions tool

window.

2. "Image source" step
Choose the image you want to measure.

3. "ROIs" step
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Define the ROIs, or measure the whole sample.

4. "Threshold" step
Define the intensity range for the first phase, and define other phases if

necessary.

5. "Object filter" step
Define theminimumobject size.

6. "Image results" step
Take a look at your image results.

If necessary, delete objects, or add new ones.

7. "Results" step
Document the results (report or workbook).
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9.10.2. Performing a phase analysis

Step - Image source
1. Load the SprayCoating.tif example image.

l In this image, the percentage area of the bright and the dark phases are to be
measured within an ROI.

2. Activate theMaterials Solutions tool window. Should this tool window not be
visible, use theView > ToolWindows > Materials Solutions command to have it
displayed.

3. Click thePhase Analysis button.
4. In the Image source group, choose theSelected images option to analyze the

example image. This imagemust have been opened for this purpose, and have
been selected in the document group.

5. Select theSkip 'Sample information' check box.
l By doing so, you skip theSample information step which is not relevant for this
example image.

6. Select theAll images entry in theCheck settings and results list.
l If you analyze your own images later on, you can also select another entry from
this list, for example, if you don't want to check the settings for every image
anymore.

7. Click theNext button.
l TheMaterials Solutions tool window will display the next step.
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Step - ROIs
1. For the SprayCoatingt.tif example image, define a rectangular ROI which covers

the part of the sample that you would like to analyze. To do so, click theCreate
Rectangular ROIs button, and define the rectangle on the image by twomouse
clicks.

Note: It is not absolutely necessary to define ROIs. If you want to measure the entire
image, in theROIs step in the analysis, click directly on theNext button without
defining a ROI.

2. Leave theUse for next images check box clear, because these instructions only
analyze one image. Later on, when you are using your own images and want to
analyzemore than one image at the same time, you can select this check box to
use the sameROI on all of the images that are selected in the current analysis
process.

Note: The ROI that is defined only applies for the current analysis process.When you
start a new analysis process, you have to define new ROIs. If you want to use the
sameROIs for more than one analysis process, save them and reload them later.

3. If you want to set a fixed size for the rectangular ROI, select theUse discrete size
check box. You will find this check box in theRectangle properties group. This
group is only displayed when theCreate Rectangular ROIs button is selected or
when a rectangular ROI is selected in the image.With the help of theUse discrete
size check box, you can create several rectangular ROIs that all have a size (or a
multiple of a size) defined by you.

4. Click theNext button.
l TheMaterials Solutions tool window will display the next step.

Step - Threshold
Prerequisite: These step-by-step instructions assume that theSimplified color space
(I/R/G/B) option has been selected. You can find this option in theOptions > Materials
Solutions > Phase Analysis dialog box.

1. When you are performing the phase analysis on color images, select the Intensity
Value entry in theComponent list. If you are analyzing gray-value images, the
Intensity Value entry is preset and can’t be changed.
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l All of the pixels which lie within a defined intensity range, will be shown in color
during this step in the analysis. This intensity range is called a phase. The
intensity value range is limited by a top and a bottom intensity value. These are
the so-called threshold values.

l Please note that the defined ROI will not be considered in this step in the
analysis, but only in the next step. In this step in the analysis, pixels which are
outside of the ROI will thus also be shown in color.

2. If necessary, reduce or increase the intensity range of the first automatically
created phase. Make sure that the first phase covers the dark pixels. (You can
only define the phase for the bright pixels in the next step.) In the image, watch
how the object areas found become larger andmore objects are found.
l To reduce or increase the intensity range, in the tool window's table change the
values in theMin. andMax. fields. Alternatively, interactively change the lower
and upper threshold values in the histogram shown at the bottom of the tool
window. Move themouse pointer over the edge of the phase, until the pointer
changes and, with the left mouse button pressed, drag the edge in the required
direction.

3. Now, define the second phase. To do so, click theAdd Phase button, and click
theNew Threshold button. Now click so long in the bright areaswithin the ROI,
until they are shown in the color of the phase.

4. If necessary, change the two phaseswhich have already been defined. To do
that, select the phase which you want to change in the table in the tool window.
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5. Click theNext button.
l TheMaterials Solutions tool window will display the next step.

Step - Object filter
In this step in the analysis, only the pixels within the defined ROI are considered. All
objects whichmeet the conditions defined in the object filter, will be shown in the color
of the phases.

All objects which do not meet the conditions defined in the object filter, will be shown in
this step in the analysis in red hatching. Thismeans that these objects will not be taken
into account when determining the percentage area of the phase.

1. If necessary, change the conditions for the object filter. First adjust the units. As
the SprayCoating.tif image was calibrated inmicrometers, click on the button
showing the units (to the right next to theMinimumobject area field), and select
µm as unit.

2. In theMinimumobject area field, enter theminimum size that an object must have
to be considered when determining the area fraction covered by the phase. You
can thus exclude small objects such as dust particles from the determination of the
percentage area of the phase.Watch how more or less object areas are found as
the hatched objects in the image increase or decrease.

During the analysis process, you can use your software's zoom function as usual.
Move your mouse pointer onto the appropriate position in the image, then use the
mouse wheel to zoom into or out of the image.

3. Click theNext button.
l TheMaterials Solutions tool window will display the next step.

OLYMPUS Stream UserManual 222



9.  Materials Science Analysis
9.10.   Phase Analysis

Step - Image results
In this step in the analysis, all of the objects used to determine the phase fraction will
be shown in the color of the phase. Objects which do not come up to theminimumarea
and which were thus shown hatched in the previous step in the analysis, will now be
shownwith no color.

1. Take a look at the results that are shown in the table. In the Image results field,
you will see the area fraction covered by each phase.

2. If necessary, manually change which objects your software uses to determine the
area fraction of the phase. You can delete, or add objects.

3. Click theNext button.

Step - Results
Select the results you want.

Step - Reporting
1. Select theDefault option to use the template that has been defined as the default

template. If you would like to select another template, select theUser defined
option. Click the button with the three points and select the new template in the
Open dialog box.

2. When you want to create anMS-Word report: In theContent group, select the
check box for the pages the report should contain.

3. When you want to create anMS-Excel report: Click theSave settings button to
save the current settings in a file.
l These are largely the same settings that you could already save in the previous
step, theResults step. You can, however, additionally specify which Excel
template you want to use for the report creation here.

4. Click the Finish button.
5. Through thematerials analysismeasurement, the image has collected one or

more additional layers (can be seen in the Layers tool window). If required, save
the image in TIF or VSI format to retain these newly created image layers.
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9.11. Particle Distribution

9.11.1. What is a particle distribution?
With a particle distributionmeasurement, the software counts how many particles are
in an image and classifies them, for example, according to their size or their form.

It is a precondition that the particles can be detected by the software. Therefore, the
particlesmust differ from the rest of the sample, for example, because they are darker
or lighter. In this case, you can define a phase with an intensity range that covers the
intensity values of all of the particles. If the particles that you want to measure largely
have the same intensity values, then one phase is enough. If you want to measure light
and dark particles, you will need a second phase.

All detected particles aremeasured according to ameasurement parameter that you
selected (for example,Area). The results can be classified automatically. For this, you
define a classification with up to 16 classes. For some samples, a coarse classification
with only 2 classes is sufficient, whereas other samples require amore detailed
classification with 10 classes for example.

Example of a particle distributionmeasurement. In the image, the particles have been
detected andmeasured according to theAreameasurement parameter. The results
are shown according to the defined classification. In the example shown, the particles
were assigned to three size classes. The diagram shows how many particles each
size class has.

OLYMPUS Stream UserManual 224



9.  Materials Science Analysis
9.11.   Particle Distribution

You see the same particle distributionmeasurement as in the example above, but now
with amore detailed classification. Now the particles were assigned to seven size
classes.

Measuring on ROIs
You can choose whether you would like tomeasure the entire image or if the
measurement should only be carried out on a part of the image, a so called ROI
(RegionOf Interest). You can also define several ROIs. The particle distribution will
always bemeasured over all ROIs and the results do not differentiate between ROIs.

Filtering and editing particles
Define one or more filters to specify which particles to include in the analysis.

You can edit the particlesmanually. You do this interactively on the image. Note that
you are not changing the image itself, but the image'smeasurement layer.

You canmanually delete parts of the image which were detected as particles. This can
be necessary, if for example artifacts in the image are recognized as particles because
they have intensity values similar to the defined phase. Bymanually deleting these
particles, the artifacts will no longer be considered whenmeasuring the particle
distribution. In addition, you can alsomanually add other image segments which were
not detected as such but which are actually particles.

Additionally, you can split particlesmanually andmerge several small particles into
one big particle. To do so, in the image first click on the particles which you want to
merge.

Results of a particle distribution measurement
The results of an analysis can be displayed in a workbook and in a chart. Additionally,
the results can be displayed in a report in either MS-Word or MS-Excel format.
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General procedure for a particle distribution measurement

1. Selecting the analysis process
In theMaterials Solutions tool window, click theParticle Distribution button.

2. "Image source" step
Choose the image you want to measure.

3. "ROIs" step
Define the ROIs, or measure the whole sample.

4. "Threshold" step
Define the intensity range of the phase.

5. “Auto split particles” step
Configure amorphological filter to split particles.

6. "Edit Particles” step
Define filters and edit the particles.

If necessary, delete particles or add new ones. You can alsomanually split
particles andmerge separate particles into one.

7. "Classification" step
Check and change the classification.

8. "Image results" step
Take a look at your image results.

9. "Results" step
Document the results (report, workbook, or chart).
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9.11.2. Measuring the particle distribution

Step - Image source
1. Load the "GlobularGraphite.tif" example image.

l In this image, the dark nodular graphite particles are to counted and the
particles are to be classified according to their size.

2. Activate theMaterials Solutions tool window. Should this tool window not be
visible, use theView > ToolWindows > Materials Solutions command to have it
displayed.

3. Click theParticle Distribution button.
4. In the Image source group, choose theSelected images option to analyze the

example image. This imagemust have been opened for this purpose, and have
been selected in the document group.

5. Select theSkip 'Sample information' check box.
l By doing so, you skip theSample information step which is not relevant for this
example image.

6. Select theAll images entry in theCheck settings and results list.
l If you analyze your own images later on, you can also select another entry from
this list, for example, if you don't want to check the settings for every image
anymore.

7. Click theNext button.
l TheMaterials Solutions tool window will display the next step.

Step - Threshold
All of the pixels which lie within a defined intensity range, will be shown in color during
this step in the analysis. This intensity range is called a "phase". The intensity value
range is limited by a top and a bottom intensity value. These are the so-called
threshold values.

Please note that the defined ROI will not be considered in this step in the analysis, but
only in the next step. In this step in the analysis, pixels which are outside of the ROI will
thus also be shown in color.
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1. If necessary, reduce or increase the intensity range of the phase. In the image,
watch how the particle areas that are found become larger or smaller and how
more or less particles are found.
l To reduce or increase the intensity range, in the tool window's table, change
the values in theMin. andMax. fields. Alternatively, interactively change the
lower and upper threshold values in the histogram shown at the bottom of the
tool window. Move themouse pointer over the edge of the phase, until the
pointer changes and, with the left mouse button pressed, drag the edge in the
required direction.

2. Select theAuto split particles check box, which is displayed below the histogram.
l The additional stepAuto split particleswill be added to the current analysis.

3. Select theCheck classification check box, which is displayed below the histogram.
l The additionalClassification step will be added to the current analysis.

Note: If you analyze several images of a sample in the same analysis process, you can
only check the classification for the first image of the sample. The selected
classification will be adopted for all other images of this sample. This is why theCheck
classification check box is not available from the second image of the sample onwards.

4. Click theNext button.
l TheMaterials Solutions tool window will display the next step.
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Step - Auto split particles
In this step, you configure themorphological filter. It is used for splitting objects. To do
so, use the Fine / Coarse slider. The settings that you specify can have a big effect on
the image results.

Example:

On the left is the image where themorphological filter for separating objects has been
set relatively high. The tendency is for fewer and larger objects to be found. On the
right is the same image where themorphological filter for separating objects has been
set low. Here, more and smaller objects are found.

Note: This step is only shown if theAuto split particles check box in the Threshold step
is selected.

1. Click thePreview button to see how many borders are found when using the
preset value of 1.
l This setting tends to findmore borders where objects can be split.

2. Take a look at the borders that have been found in the image. Each border is
shown by a red line across a particle.

3. If required, move the Fine / Coarse slider slightly or enter the required value in the
edit field and press the [Enter] key.

4. Click thePreview button again to view the changes in the image.
l The higher the value you enter, the fewer borders are found.

5. Reset the value for the "GlobularGraphite.tif” example image back to the preset
value of 1, and click thePreview button.

6. Click theNext button.
l The objects are split.

l TheMaterials Solutions tool window will display the next step.

Step - Edit Particles
You can define one or more filters in this step. You can use these filters to limit the
particles that are included in the analysis.
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In the illustration on the left, all of the particles contained in the ROI are colored red. A
filter has been applied to the image on the right. Only the particles that are within the
definedmeasurement range have been colored red.

1. In the table, click themeasurement parameter for which you want to define a filter
range. You can click theAreameasurement parameter, for example.
l If the requiredmeasurement parameter doesn't appear in the table, click the
Select particle measurements button. Select themeasurement parameter you
want in theSelect Particle Measurements dialog box.

2. Define the upper and the lower value for the filter range for themeasurement
parameter. You can either enter the filter range directly in the list or you can
interactively determine it, by selecting particles in the image.

Entering the filter range directly
1. Double click in the [Min. field, located next to themeasurement parameter to enter

the lower value for the filter range.
2. Either enter the requiredmeasurement value, or use the arrow keys.
3. Double click in theMax.[ field, then enter the higher value for the filter range.

l Particles that will be included in the analysis are colored red.

Defining the filter range interactively
1. In the table, click themeasurement parameter for which you want to define a filter

range.
2. Click theSelect maximum value button to define the filter range's upper value.
3. In the image, click a particle whosemeasurement value is to be used as the lower

value for the filter range.When you, for example, define a filter range for theArea
parameter, click the smallest particle that you still want to measure.
l Themeasurement value will then be automatically adopted in the [Min. field.

l If you want to undo the selection you'vemade, click theClear minimum value
button.

4. Click theSelect maximum value button to define the filter range's upper value.
5. Click a particle whosemeasurement value is to be used as the upper value for the

filter range. Click the largest particle that you still wish tomeasure.
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l Themeasurement value will then be automatically adopted in theMax.[ field.

l If you want to undo the selection you'vemade, click theClear maximum value
button.

l The particles that will be included in the analysis are colored red.

Saving and loading filter settings
1. Click theSave Filter button to save your filter settings as a parameter set. A

parameter set that has been saved can be exported and imported.
2. Use the Load Filter button to load it at a later date.

Editing particles
1. If necessary, you can delete and add particles. Additionally, you can split particles

manually andmerge several (previously selected) small particles into one big
particle.
l Delete particles by first clicking on the particle to be deleted in the image and
then clicking on theDelete selected particles button. If you say yes to the
warningmessage, the particle will be deleted. The display below the table with
themeasurement parameters is updated. You can also delete several particles
at once, by holding the [Ctrl] key pressed, while clicking on the particles.

l Add particles by first clicking on this button . Then draw a freehand polygon
around the particle to be added. Make sure that the freehand polygon lies as
exactly as possible on the edge of the particle to be added. End the definition of
the polygon with the right mouse button. The number in the display below the
table with themeasurement parameters increases.

l Merge particles by first clicking in the image on the particles which you want to
merge. Keep the [Ctrl] key pressed while you click on the particles. Then click
theMerge selected particles button.

l Split particles by first clicking on theDraw a line that will split particles button,
and then define a line between the particles you want to split. Click the right
mouse button and confirm the input.

Note: If you have edited particles and return to the Threshold step in the analysis (e.g.
to change the threshold values) your manual correctionswill be deleted. If necessary,
you will then again have tomanually edit particles in theEdit Particles step in the
analysis.

2. Click theNext button.

Step - Classification
In this step in the analysis, only the pixels within or on the edge of the defined ROI will
be considered. If a filter was defined in the previous step, only the particles that fall
within the filter'smeasurement value range will be included in the analysis. All particles
that will be used for the particle distributionmeasurement are colored in this step.

Note: This step is only displayed if theCheck classification check box in the Threshold
step is selected.
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1. As the nodular graphite particles on the "GlobularGraphite.tif" image are to be
classified by their size, in theMeasurement list, select theArea parameter.
l The particle distribution always uses exactly onemeasurement parameter. The
threemost frequently used parameters are: Area,Max. (Feret), andEquivalent
Circle Diameter. These parameters are always shown in theMeasurement list
and can be selected quickly.

l If you analyze your own images later on, youmaywant to measure the
particles according to another parameter, for example, according to the shape.
To select another measurement parameter, click theSelect Particle
Measurement button, located at the right hand side of theMeasurement list.
Then select themeasurement parameter you want in theSelect Particle
Measurement dialog box.

2. If necessary, adjust themeasurement units. As the "GlobularGraphite.tif" image is
calibrated inmicrometers, the µm²measurement unit must be selected.

Note: The preset measurement unit depends on the parameter selected in the
Measurement field. Some parameters don’t require ameasurement unit. The button
will thus not be shown.

3. Click theAutomatic Classification button. You will find this button in the toolbar
above the table.
l TheAutomatic Classification dialog box opens.

4. In theAutomatic Classification dialog box, click theGet Min./Max. from Image
button. In theMinimum andMaximum fields, the area of the smallest and biggest
particle is entered. The kind of value that is read out from the image and entered in
theMinimum andMaximum fields depends on the selectedmeasurement
parameter. In theNumber of classes field, enter how many classes are to be used
for the classification of particles. For the "GlobularGraphite.tif" image, enter the
value 3. Close the dialog boxwithOK.

5. Look at the table in the tool window. It contains the classification with the three
classes. Also look at the diagram below the table. It displays how many particles
are in each class.
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6. Click theNext button.
l TheMaterials Solutions tool window will display the next step.

Step - Image results
In this step in the analysis, all of the particles will be shown in the color of the class to
which they belong. All particles that do not belong to any of the defined classes are
shown hatched in this step.

1. Take a look at the displayed results in the Image results field. You see how many
particles each class contains.

2. TheParticle area fraction field displays the particle area fraction as a percentage.
This value informs you about the percentage the sum of the area of all particles
found in this analysis has in comparison to the total area being analyzed (the
detection area).
The particle area fraction is determined by dividing the area of all found particles
by the detection area. It doesn't matter whether the found particles have been
assigned to a class or not. The detection area can either be the whole image, or
one or more ROIs. With particles that are on the border of the detection area, only
the part that is inside the detection area is included in the calculation.

On the left is a ROI with a particle area fraction of 40%. On the right is a ROI with a
particle area fraction of 10%.

3. In the diagram below the Image results field, the classification of the particles is
shown graphically. If many classes have been defined, a look at the chart is the
quickest way to know which class containsmost particles.

Note: You can also select a different way of classifying the results. Then the chart can
look very different. Use the Tools > Options... command and select theMaterials
Solutions > Particle Distribution entry in the tree view. This command is not available
while an analysis is running.
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Note: You will get this chart as a file in OCT format, if in theResults step in the
analysis, you select theGenerate chart check box.

4. Click theNext button.

Step - Results
Note: If you analyze several images of a sample in the same analysis process, this
step is only shown after the last image has been analyzed.

1. Select theGenerate report check box and then select either theWord option or
theExcel option to automatically create a report in the corresponding application
programwhen the analysis finishes.

2. Select theGenerate workbook check box to have a document of the "Workbook"
type automatically created at the end of the analysis.

3. Select theGenerate chart check box, so that, at the end of the evaluation, the
systemwill automatically create the diagram shown in the Image results step as a
separate document, of type "workbook".

4. If you want to save the current settings to a file, click theSave settings... button.
Then assign a descriptive name in the next dialog box.
l You can load these settings (parameters) when you analyze further images. To
do that for the new image in the Image Source step, click the Load from file...
button. The sample and image comments are saved, as are the phases used
and the settings in theClassification step in the analysis.

6. Click theNext button.

Step - Reporting
1. Select theDefault option to use the template that has been defined as the default

template. If you would like to select another template, select theUser defined
option. Click the button with the three points and select the new template in the
Open dialog box.

2. When you want to create anMS-Word report: In theContent group, select the
check box for the pages the report should contain.

3. When you want to create anMS-Excel report: Click theSave settings button to
save the current settings in a file.
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l These are largely the same settings that you could already save in the previous
step, theResults step. You can, however, additionally specify which Excel
template you want to use for the report creation here.

4. Click the Finish button.
5. Through thematerials analysismeasurement, the image has collected one or

more additional layers (can be seen in the Layers tool window). If required, save
the image in TIF or VSI format to retain these newly created image layers.

Note: Use the Tools > Options > Count andMeasure > Display dialog box to specify
whether the found particles should be displayed in outline or whether they should be
filled. You can change these settings at any time, before or after the analysis, for
example, and also for images that have already been saved in TIF or VSI format.
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9.12. Automatic Measurement

9.12.1. What exactly are automatic measurements?
Use automaticmeasurements when you want to repeatedly carry out the same
measurement on similar images. You use ameasurement routine defined by the
software administrator for themeasurements. You only have to specify the position on
the sample when carrying out themeasurement. The actual measurement is
automatically carried out by your software.

Prerequisites for automatic measurements
Themeasurement tasks that can be carried out using theAutomaticMeasurement
solution have to fulfill the following requirements:

1. Simple geometric structures can bemeasured, for example, the distance between
two lines or the diameter of a circle.

2. Themeasurement object must be displayed on one image. Themeasurement
can't analyze any structures that are spread over more than one image.

3. The imaging conditions for the image acquisition should be comparable for all
samples that are to bemeasured with onemeasurement routine. The average
image brightness and the image contrast in particular should be comparable.

4. The samples to bemeasured should be aligned the same. Themeasurement
routine will not deliver any results if the samples are aligned differently. For
example, wafers that can be positioned precisely on the stage are suitable.

Examples of measurement tasks
The following examples are structures that can bemeasured with theAutomatic
Measurement solution.

You canmeasure line structures like those illustrated in the image on the left with the
AutomaticMeasurement solution. You can for examplemeasure the width of a line
(1), the distance between two lines (2) or the length of a line (3).
On the right is an example of a workpiece with holes. You canmeasure the distance
between two holes (4) or the diameter of a hole (5), for example.

00540 18012014
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9.12.2. Performing an automatic measurement
Prerequisite: A measurement routine is required for an automaticmeasurement. You
can only create andmanage ameasurement routine if you've started your software as
Administrator or Power User.

9.12.3. Defining a measurement routine

Overview of the procedure for defining a measurement routine
The following steps are necessary if you want to define ameasurement routine.

Define Routine
In this step you create a new measurement routine or delete an existingmeasurement

routine.

Define Reference Image
In this step, youmake important settings for themeasurement routine. You select the
measurement parameters, acquire a reference image, and define amatching pattern.

Define Inspections
In this step, you select one or several measurement parameters that are to be used in this

measurement routine.

Define Measure
In this step, you define the actual measurement routine on the reference image. To do this,
you define one or more scanners, depending on the inspectionmode you chose. You specify

some parameters for the analysis of the scanner.

Define Tolerance
In this step, you define the tolerance range for themeasurement routine's measurement

results.

Define Workbook
In this step, you configure the workbook that is created at the end of an automatic

measurement.

1. Activate theMaterials Solutions tool window. Should this tool window not be
visible, use theView > ToolWindows > Materials Solutions command to have it
displayed.

2. Click theAutomaticMeasurement button.
l TheMaterials Solutions tool window displays theStart Page group.

3. In theStart Page group, select the Import Routines button and import the
"WAFER-500x.amr" examplemeasurement routine. If you create your own
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measurement routines at a later point in time, you can use these example
measurement routines as a basis and adapt them to fit your needs.

4. Click theManage Routines button.
l You can now define the importedmeasurement routine.

Define Routine step
1. Select the "Wafer-500x" measurement routine from theMeasurement routine list.
2. Select the Live image option.
3. Click theNext button.

Define Reference Image step
For everymeasurement routine, a reference image is saved showing the structure to
be automaticallymeasured by themeasurement routine.

1. Select a reference image. To do this, select the From disk option and load the
"Wafer-500x.tif" example image.

2. Select theUse amatching pattern check box.
3. Click theDefine pattern area button to define a pattern area on your sample. In

the reference image, keep your left mouse button pressed and drag a rectangle
around thematching pattern.

4. Right click twice to confirm thematching pattern
l Thematching pattern is shown in the image.

l The structure can be automatically found by your software using pattern
recognition. The scanners are then automatically positioned correctly. A
scanner is the segment of the image that is analyzed by the automatic
measurement.

In the illustration thematching pattern is framed in red.

5. Click theNext button.

Define Inspections step
In theDefine Inspections group, all of the inspections that are defined in the "Wafer-
500x.amr" measurement routine are listed. In this example, measurement parameters
are selected that measure the width of a line, the distance between two lines and an
angle.

1. Click theNext button.

OLYMPUS Stream UserManual 238



9.  Materials Science Analysis
9.12.   AutomaticMeasurement

Define Measure step
In theDefineMeasure group, the scan area for eachmeasurement parameter is
defined on the reference image.Which scanners and how many scanners are
required depends on the inspection that was selected in theDefine Inspections step.
For thePoint to line distance inspection, for example, two rectangular scanners have
to be defined.

1. Click theDefine scanner area button located in theScanner 1 tab.
l The scan area that has already been defined in the examplemeasurement
routine is displayed. Themeasurement point for thePoint to line distance
inspection is defined with this scan area.

l The arrow indicates the scanner's orientation.

2. Finish the definition of the scan area.
To do so, either right click the image window or click theConfirm Input button. You
can find this button on the Toolbox toolbar.
l Your software will now analyze the scan area. The analysis can take a
moment, depending on the size of the defined scan area.

l The result is ameasurement point that is displayed with a small blue cross in
the image.

3. Switch to theScanner 2 tab.
4. Click theDefine scanner area button.
5. The scan area that has already been defined in the examplemeasurement routine

is displayed. Themeasurement line for thePoint to line distance inspection is
defined with this scan area.
l The arrow indicates the scanner's orientation.

6. Finish the definition of the scan area.
To do so, either right click the image window or click theConfirm Input button. You
can find this button on the Toolbox toolbar.
l Your software will now analyze the scan area. The analysis can take a
moment, depending on the size of the defined scan area.

l The result is ameasurement line that is displayed in blue in the image. The
distance is calculated between thismeasurement line and themeasurement
point fromScanner 1. The distance is shownwith a yellow line.

The illustration shows thePoint to line distance inspection in which two scan areas
(green) are defined. In this example, the distance between the small blue cross and
the blue line ismeasured. The yellow line shows themeasured area.

OLYMPUS Stream UserManual 239



9.  Materials Science Analysis
9.12.   AutomaticMeasurement

7. After all the scan areas have been defined and analyzed, the result of the
measurement is displayed at the bottom of theMaterials Solutions tool window.
l If you want, you can change the units of measurement for themeasurement
results.

8. Click theNext button.

Define Tolerance step
In this step, you define the tolerance range for themeasurement routine's
measurement results. TheMeasurement result field displays the results of thePoint to
line distancemeasurement method on the "Wafer-500x.tif" reference image. This
measurement result is the reference value for all automaticmeasurements carried out
with thismeasurement routine. The values saved in the examplemeasurement
routine are displayed in theMinimumallowed andMaximumallowed fields.

1. Adopt the values and click the Next button.
l You automatically go back to theDefine Inspections step.

Note: You have to define the position of the scanners separately for each inspection.

2. Repeat the last steps and define the scan areas for all of the inspections.

Define Workbook step
After you define the scan areas for all of the inspections, the Finish button becomes
active.

1. Click the Finish button to save the settings in themeasurement routine.
l You can now use themeasurement routine for automaticmeasurements.

2. If you haven't defined a workbook in theDefine Inspections step, you cannot
complete the steps. The Finish button isn't active. You automatically go back to
theDefine Inspections step.

3. Click theDefineWorkbook button in theDefine Inspections step.
4. In theDefineWorkbook group, select the properties that you want the workbook's

header to contain.
5. Click the Finish button to save the settings in themeasurement routine.

9.12.4. Performing an automatic measurement
Prerequisite: You don't need any Administrator or Power User rights to perform an
automaticmeasurement. You do, however, need ameasurement routine that was
created by an Administrator or a Power User.

1. Activate theMaterials Solutions tool window. Should this tool window not be
visible, use theView > ToolWindows > Materials Solutions command to have it
displayed.

2. Click theAutomaticMeasurement button.
l As soon as you've started this analysis process you'll be guided step by step
through themeasurement. A lot of your software's other functionswill not be
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available while an analysis process is running.
l TheMaterials Solutions tool window displays theStart Page group.

3. Select theStart Routine button in theStart Page group.

Select Routine step
1. Select the "Wafer-500x" measurement routine from theMeasurement routine list.
2. Select the Folder option and load the five "Wafer-500x.tif" example images. The

example images are numbered from 01 to 05 in the file name.
3. Click theNext button.

l The first "Wafer-500x.tif" example image ismeasured.

l The results of the automaticmeasurement are displayed in theMaterials
Solutions tool window.

4. In theMeasure group, click theMeasure button.
l The next "Wafer-500x.tif" example image ismeasured.

5. Repeat this procedure until all five of the example images have beenmeasured.
6. Click the Finish button.

l The results are automatically exported to aWorkbook document.
00541 29082019
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9.13. Coating Thickness

9.13.1. What is a coating thickness measurement?
Using theCoating Thickness analysis process you can analyze ball indentation cuts of
thin coatings and determine their coating thickness. The sample under test should be a
substrate, which has one or more coatings that were applied using different coating
methods (PVD, CVD, VPS, APS etc.).

To determine the coating thickness, a ball indentation is ground into the sample. This is
done using a rotating grinding ball, which has a diameter between about 10 and 50
mm. The ball indentationmust have theminimum thickness of the sum of all coatings.

In case of a flat or spherical sample surface, the grinding ball's indentation is round. If
the sample surface is curved in one direction, the grinding ball's indentation is ellipse-
shaped.

You can choose between the following sample surfaces:
Flat,Cylindrical convex,Cylindrical concave, Spherical convex, or Spherical concave.

Measurement order
You can carry out themeasurements in any the order you want. You canmeasure the
coatings from the outside to the inside, for example. To do this, the coating's outer
border is defined first on the image and, following that, all of the remaining borders.
Alternatively, you can alsomeasure the coatings in the reverse order, from the inside
to the outside. It's also possible, for example, to specify a border on amiddle coating to
begin with and to first measure from this border towards the inside and then towards
the outside.

The borderlines that have been defined are shown in color. They are located in an
additional image layer (can be seen in the Layers tool window). By default, the
borderlines are shown in red. In the program options, you can set a different color or
thickness for the borderline. In the program options, you can also specify for each
measurement line to be displayed in a different color.

You can see a coating thicknessmeasurement on the flat sample surface. One coating
has beenmeasured.
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Number of measurements per image
Every image is onlymeasured once by default. However, you can set the program
options tomeasure an image several times. Then the results of the last measurement
will constantly be compared to the results of the previousmeasurement. The average
value of all of themeasurements performed to date is always displayed.

Results of a coating thickness measurement
The coating thickness ismeasured in accordance with the industry standard that is set
in the program options. The following industry standards are available:

l EN 1071-2:2002
l VDI 3824:2001
l EN ISO26423:2016

The results of an analysis can be displayed in a workbook. Additionally, the results can
be displayed in a report in either MS-Word or MS-Excel format.

If theCreate image with results shown in information bar check box has beenmarked
in the program options, a new image document will be created additionally during the
measurement. This image document shows themeasured image with the borderlines
and an information bar (under the image). You can determine the contents of the
information bar. You can save the image document as a TIF file and send it to others
who don't have access to the image analysis program, for example.
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General procedure for a coating thickness measurement
1. Selecting the analysis process

Click theCoating Thickness button, located in theMaterials Solutions tool
window.

2. "Image source" step
Choose the image you want to measure.

3. “Settings” step
Select the sample surface type (Flat for example).

Specify further measurement parameters.

4. "Measurement" step
Define the outer and inner borders of each coating.

5. "Results" step
Document the results (report or workbook).

10615 04032019

9.13.2. Measuring the coating thickness
This step-by-step instruction describes how you canmeasure the thickness of a
coating. An image of the flat sample surface on which 1 coating is to bemeasured
once has been selected as an example. If you selected an image with a different
surface in theSettings step, there will be small differences in the procedure.

CoatingThickness2_GrindingBallDiameter_40mm.tif example image
During the installation of your software some sample images have been installed, too.
You can follow this step-by-step instruction using the CoatingThickness2_
GrindingBallDiameter_40mm.tif example image. Open this image andmake sure that
it has been selected in the document group.

Step - Image source
1. Load the CoatingThickness2_GrindingBallDiameter_40mm.tif example image, or

alternatively, the image that you want to measure.

2. Activate theMaterials Solutions tool window. Should this tool window not be
visible, use theView > ToolWindows > Materials Solutions command to have it
displayed.
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3. Click theCoating Thickness button.
4. In the Image source group, choose theSelected images option to analyze the

loaded image. For this to work, this imagemust be selected in the document
group.

5. Select theSkip 'Sample information' check box, to skip theSample information
step.
l As soon as you click theNext button, you'll go straight to theSettings step. You
can do this if you don't want to enter any information about the sample, which is
the case here.

Note: If you want to analyze images frommore than one sample in the same analysis
process, theSkip 'Sample information' check boxmust be cleared. Only then will the
New Sample button be displayed.With this button, you can specify when an image to
be analyzed belongs to a new sample.

6. Select the First image entry in theCheck settings and results list.
l If you select the First image per sample entry, you can check the settings for
each new sample.

7. Click theNext button.
l TheMaterials Solutions tool window will display the next step.

Step - Settings
1. Select the sample surface type. For the CoatingThickness2_

GrindingBallDiameter_40mm.tif example image, select the Flat sample surface.
l You can choose between the following sample surfaces: Flat,Cylindrical
convex,Cylindrical concave, Spherical convex, or Spherical concave.

2. Select the crater shape. The indentation that the grinding ball makes in the
sample's surface is called a "crater".
l If the Flat, Spherical convex or Spherical concave sample surfaces are
selected, this indentation is round. The indentation is elliptical when the
Cylindrical convex orCylindrical concave sample surface types are selected.

3. If you selected theCylindrical convex orCylindrical concave sample surface
types: Select the direction of the ellipse's long axis. This information is taken into
account when calculating the coating thickness.

4. Specify how many coatings you want to measure in theNumber of coatings field.
A maximumof 20 coatings can bemeasured.

5. Enter the diameter of the grinding ball used in theGrinding ball diameter field. The
grinding ball's diameter must be known in order to produce an accurate coating
thicknessmeasurement. If necessary, change the suggested unit.

6. If you selected theSpherical convex or Spherical concave sample surface types:
Enter the curvature radius of the surface used in theCurvature radius of surface
field. This valuemust be known because it's needed for the calculation of the
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coating thickness.
l The curvature radius of the surface is only important for themeasurement of
the coating of spherical sample surfaces. That's why this field isn't displayed
when you've selected a different sample surface type.

Step - Measurement
1. Move themouse pointer onto the image window. All other areas of your software

can't be used in this step.

l Themouse pointer turns into a cross .
2. You can carry out themeasurements in any the order you want. When you want

to measure the coating from the outside to the inside, proceed as follows: Define
the first coating's outer borderline by clicking three points on its outer border. With
cylindrical sample surfaces, the outer borderline is defined by clicking twice on the
ellipse's outer border (taking the direction of the selected long axis into account).

The illustration in theMeasurement step shows how the borders of a
coating have to be defined.

l The outer borderline is displayed. It's has the color red by default. You can set a
different color or thickness for the borderline. Make these settings before you
start the analysis process.

3. Define the first coating's inner borderline by clicking once three times on its inner
border. Whether you define the second border with one or with three clicks of the
mouse depends on whether theMeasure usingmultiple points check boxwas
selected in theSettings step.
l The inner borderline is displayed. If you only want to measure one coating, the
mouse pointer turns into an arrow.

4. If you want to measuremore than one coating: Define all further coatings to be
measured, each with one additional mouse click.
l As soon as you've defined the inner border of the last coating, themouse
pointer turns into an arrow .

5. Check the values in theMeasurements table.
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6. If you want, you can correct a borderline. To do this, move themouse pointer to
the small handle on the borderline so that it takes on this shape . Now click the left
mouse button andmove the borderline to where you want it.
l The borderline is corrected and the values in theMeasurements table are
updated.

7. If you want, you can change the coating's name. Normally, the coatings are
numbered serially. If, for example, you prefer to specify the coatingmaterial, click
once on the number in theCoating field in theMeasurements table to select the
entry. Then click on the entry onemore time to overwrite it. Enter the desired text.

8. Click theNext button.
l TheMaterials Solutions tool window will display the next step. If you specified
that an image should bemeasuredmore than once in the program options, you
now remain in theMeasurement step and perform the next measurement.

Step - Results
TheMaterials Solutions tool window displays themeasurement results. You can view
the results for all of the currently analyzed images, sorted by sample. The average
values are displayed in theCoating thickness, Total Thickness, Total Penetration
Depth, andPenetration Depth in Substrate fields. Thismeans that the results of all of
themeasurements of the same type are added together and then divided by the
number of measurements.

Step - Reporting
1. Select theDefault option to use the template that has been defined as the default

template. If you would like to select another template, select theUser defined
option. Click the button with the three points and select the new template in the
Open dialog box.

2. When you want to create anMS-Word report: In theContent group, select the
check box for the pages the report should contain.

3. When you want to create anMS-Excel report: Click theSave settings button to
save the current settings in a file.
l These are largely the same settings that you could already save in the previous
step, theResults step. You can, however, additionally specify which Excel
template you want to use for the report creation here.

4. Click the Finish button.
5. Through thematerials analysismeasurement, the image has collected one

additional layer (can be seen in the Layers tool window). If required, save the
image in TIF or VSI format to retain this newly created image layer.
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9.14. Dendrite Arm Spacing

9.14.1. What is a dendrite arm spacing measurement?
Dendrites are formed inmetal alloys when they solidify. They are branching, tree-like
structures. A dendrite arm spacingmeasurement, to put it simply, measures the
distance between the individual branches of the tree.

From the dendrite arm spacing an expert can tell whether ametal alloy solidified
quickly or slowly, among other things.

The samples are usuallymetallographic sections that have been prepared especially
for themeasurement of dendrite arm spacing. In order for your results to be valid, the
dendrite arms that youmeasuremust lie entirely within the cross-sectional plane. The
measurement lines should be positioned in the image so that they intersect several
neighboring dendrite arms at a right angle.

Schematic diagram of ameasurement line that intersects four dendrite arms. The
black double arrow shows the dendrite arm spacing between the second and third
dendrite arm.

It is a precondition for a dendrite arm spacingmeasurement that the dendrites differ in
someway from the rest of the sample, because they are brighter for example. In this
case, the dendrites will have different intensity values from the rest of the sample,
making automatic analysis of the image possible. For the image analysis, so-called
phases are defined which cover a certain range of intensity values.

Different methods for detecting dendrites
If your images are suitable, the dendrites can be detected using automatic threshold
setting. The image's foreground is separated from its background by using the
threshold value settingmethod. All of the objects that are to be analyzed have to
belong to the image's foreground. The number of dendrite arms that are on the
measurement line that you drew will then be detected by the software.
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Three dendrite arm spacingmeasurements using the automaticmethod of dendrite
detection. All of the pixels that have been classed as part of a dendrite are displayed in
the colorDarkCyan in the image.

If using automatic threshold detection doesn't produce adequate results, manually
enter the number of dendrite arms that intersect themeasurement line that you drew.

Three dendrite arm spacingmeasurements using themanual method of detecting of
dendrites.

Displaying the results
The results of an analysis can be displayed in a workbook. The following information is
given:

l Sample name
l Number of Measurement Lines
l Total Length
l Dendrite arms
l Average DAS
l Median DAS
l Variance of average DAS
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Additionally, the results can be displayed in a report in either MS-Word or MS-Excel
format. The user can specify the structure of the report. The reports can also contain
images and themeasurement lines that were used.

Example of a page in a report in MS-Word that shows the image that wasmeasured
and the positions of themeasurement lines.

07512 11032019

9.14.2. Measuring dendrite arm spacing
Note: You can follow these step-by-step-instructions on your PC. It describes how to
measure dendrite arm spacing.

Step - Image source
1. Load theDAS1.tif example image.

l Let's assume you want to perform two dendrite arm spacingmeasurements.

2. Activate theMaterials Solutions tool window. Should this tool window not be
visible, use theView > ToolWindows > Materials Solutions command to have it
displayed.

3. Click theDendrite ArmSpacing button.
l As soon as you've started this analysis process you'll be guided step by step
through themeasurement. A lot of your software's other functionswill not be
available while an analysis process is running.

l TheMaterials Solutions tool window displays the Image Source step.

4. In the Image source group, choose theSelected images option to analyze the
example image. This imagemust have been opened for this purpose, and have
been selected in the document group.

5. Select theSkip 'Sample information' check box.
l By doing so, you skip theSample information step which is not relevant for this
example image.
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6. Click theNext button.
l TheMaterials Solutions tool window will display the next step.

Step - Settings
1. Because theDAS1.tif example image is suited for automatic threshold setting:

Select theAutomatic option.
2. Use the Threshold for dendrites slide control to define a suitable threshold for the

detection of the dendrites.
l All of the pixels that have been classed as part of a dendrite are displayed in
DarkCyan in the image. This is only the case if theShow dendrite detection
check box is selected.

3. Use the Improve dendrite detection slide control to optimize the threshold for the
detection of the dendrites.
l The Improve dendrite detection slide control specifies a second phase. This
phase only includes gray values from 0-100.

4. With theDAS1.tif example image, leave theMaterial-dependent constant field
clear.

5. Click theNext button.
l TheMaterials Solutions tool window will display the next step.

Step - Measurement
1. When you go to this step in the analysis, your software automatically switches into

ameasurement mode.
l Themouse pointer turns into a cross on the image. Themeasurement function
icon appears at the bottom right of themouse pointer .

l Youwill remain in thismeasurement mode until you explicitly switch it off.

2. Draw ameasurement line through the first dendrites that you want to measure. To
do this, left click once on the image tomark the start of themeasurement line.
Thenmove themouse pointer to the end of themeasuring line and left click again.

Note: The dendrite arms that you want to measuremust lie in the sample's cross-
sectional plane in order to deliver reliable results.

l Themeasurement line is shown in red. Themeasurement line is also shown in
blue where it runs through parts of the sample that belong to the detected

OLYMPUS Stream UserManual 252



9.  Materials Science Analysis
9.14.   Dendrite ArmSpacing

phase.

3. Draw moremeasurement lines through dendrites whose arm spacing you want to
measure.

4. Right click or press the [Esc] key on your keyboard to leave themeasurement
mode.
l Now you canmove themouse pointer freely again.

l You can now still move the existingmeasurement lines if necessary. A
measurement linemust be selected before you canmove it.

5. Take a look at themeasurement results in theMeasurement results table. You
can still make the following changes. Use the buttons below the table for this.

l Addingmeasurement lines

l Deletingmeasurement lines

l Changing the number of dendrite arms in ameasurement line

6. Take a look at themeasurement results in theResults field. What you see here is
the overall results for all of themeasurement lines. When youmeasuremore than
one image or more than one sample in an analysis, theResults field shows the
overall results for all of themeasuring lines.

Note: If you aren't satisfied with the results and go back to theSettings step to change
the settings, this deletes all of themeasuring lines. You will then have to redraw all of
themeasurement lines in theMeasurement step.

7. Leave theShow DAS onmeasurement line check box cleared for these step-by-
step instructions.
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8. Click theNext button.
l TheMaterials Solutions tool window will display the next step.

Step - Results
Select the results you want.

Step - Reporting
1. Select theDefault option to use the template that has been defined as the default

template. If you would like to select another template, select theUser defined
option. Click the button with the three points and select the new template in the
Open dialog box.

2. When you want to create anMS-Word report: In theContent group, select the
check box for the pages the report should contain.

3. When you want to create anMS-Excel report: You can click theSave settings
button to save the current settings in a file.
l These are largely the same settings that you could already save in the previous
step, theResults step. You can, however, additionally specify which Excel
template you want to use for the report creation here.

4. Click the Finish button.
5. Through thematerials analysismeasurement, the image has collected one or

more additional layers (can be seen in the Layers tool window). Save the image in
TIF or VSI format to retain these newly created image layers.

07511 11032019
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10. Counting and measuring objects
10.1. Overview

You can detect and analyze objects in imageswith your software. You can find an
overview of the process flow of an automatic image analysis here.

Prerequisite: The automatic object analysis functions are only available when the
Count andMeasure software solution has been purchased and is active.

10.1.1. The schematic process flow of a sample analysis
A complete sample analysis is, as a rule, made up of several steps. In the following, a
simplified, schematic process flow is described. In this example graphite particles are
counted and classified. After each individual step in the analysis, the resulting image is
shown.

A sample analysis typically proceeds in three steps.

(1) Segmenting (2) Counting andMeasuring (3) Classifying

The source image: How many graphite particles are in the image and how large are
they?

(1) Segmenting
To begin with, the image has to be segmented. The image's foreground is separated
from its background by using the threshold value settingmethod. All of the objects that
are to be analyzed have to belong to the image's foreground. This is a prerequisite for
the next step, in which the objects aremeasured and counted.
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The segmented image: The graphite particles are colored. This distinguishes them
clearly from the background.

(2) Counting and measuring
The objects are detected, counted, andmeasured. For themeasurement of the
objects, numerousmeasurement parameters are available. Select themeasurement
parameters that interest you.

TheObject Measurements results view shows the results in a table.

(3) Classifying
When the objects have beenmeasured, they can be classified. For this purpose, a
classification, in which the number and definition of the individual object classes is
specified, has to be defined. The size distribution of the graphite particles is going to be
determined in this example. You need to define a classification scheme that sorts all of
the objects into different classes according to size.

Left: The classified objects in the image, made recognizable by the allocation of
different colors.
Right: TheClassHistogram results view shows the results in a diagram.
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10.1.2. The detailed process flow of a sample analysis
Not all of the steps listed below are essential. Some steps are optional, and can be
carried out additionally. In the example that follows, an object analysis is described in
whichmany of the possible steps are carried out. Normally, however, you would not
carry out all of these steps, only certain ones. Steps that always have to be carried out,
that's to say, those that are not optional, appear in bold format.

Acquiring or loading an image

Checking the settings

Processing an image with a filter

Setting threshold values

Defining ameasurement parameter

Defining an object filter

Defining the classification

Defining an ROI measurement

Viewing the results

Editing objects

Saving the image together with results and settings

Exporting data
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Acquiring or loading an image
Acquire an image or load one. The current image is shown in the document window.
All of the steps are carried out on this image.

Checking the settings
Check all of the current settings. In the Tools > Options > Count andMeasure >
Detection dialog box, there are some settings that have a significant influence on the
results. For this reason, you should always check the settings before you begin an
object analysis.

Processing an image with a filter
You can process the image with a number of filters to improve on the requirements for
the automatic object analysis. Use, for example, theSeparate Objectsmorphological
filter, to better separate the objects in the image.

Setting threshold values
The threshold values can be set automatically or manually. Select a suitable threshold
valuesmethod, for example,Manual threshold value. The image's foreground is
separated from its background by using the threshold value settingmethod. All of the
objects that are to be analyzed have to belong to the image's foreground.

Defining a measurement parameter
In theSelect Object Measurements dialog box, select the requiredmeasurement
parameters for objects. Only the selectedmeasurement parameters are output in the
results views.

Defining an object filter
Define which objects are to be excluded from your analysis. With the help of the object
filter, you can define an individual filter range for each object parameter. Objects that
don't fall within this filter range won't be shown in the results. The results only relate to
the objects that lie within the defined filter range.

Defining the classification
First, define or select a suitable classification scheme. To do this, use theOptions >
Count andMeasure > Classification dialog box. The classification scheme specifies
the number of object classes and the way that they are defined.

In theSelect ClassMeasurements dialog box, select all of the classmeasurement
parameters that interest you. A typical measurement parameter for classes is, for
example, the number of objects per class. You can naturally also display other
measurement parameters for classes, such as the area of all of the objects in a specific
class.

Non classified objects are objects that can't be categorized by the classification
process. These are displayed hatched. This can, for example, happen, when a
classification is used for the first time, or has to be further customized.

Defining an ROI measurement
You can limit the object analysis to certain image segments. These image segments
are called ROIs (RegionOf Interest). Tomake it possible for the object analysis to be
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carried out on one or more ROIs, the ROIs first have to be defined on the image.

In theSelect ROI Measurements dialog box, select all of the ROI measurement
parameters that interest you. A typical ROI measurement parameter is, for example,
the number of objects per ROI. You can naturally, also calculate other measurement
parameters for ROIs, such as, the area of all of the objects on a specific ROI.

Viewing the results
Click theCount andMeasure button, located in theCount andMeasure tool window,
to have the object analysis carried out.

The objects are detected andmeasured in one step. The objects are classified, and
displayed in the corresponding class color in the image. Objects that don't fall within
any class are cross hatched.
The default setting is thePhase classification scheme. You can define phases in the
threshold dialog box. The settings that you specify there, the color of individual phases
for example, are automatically adopted by the classification scheme.
You can define other classification schemes and select them. For example, classify the
objects according to their size or their color.

TheObject Count group in theCount andMeasure tool window shows how many
objects there are altogether, and how many of the objects lie within the filter range.

Results views
In theCount andMeasure Results tool window, you can select between various
results views for the display of the data. TheObject Measurement results view shows
the results sheet with the individual results of all of the detected objects and the
statistical values.

TheObject Filter results view, offers the possibility of having the histogram for a
chosen object parameter displayed. This enables you, for example, to output a size
distribution of the detected objects. In the size distribution you can see how many
objects have a specific area. Aswell as that, you can view the applied filter range and
the statistics for each object measurement.

TheClassMeasurements results view, shows the results for all of the defined classes,
for example, the number of objects per class. In theClassHistogram results view, you
see the class results as a histogram, for example, along the X-axis, the classes, and
along the Y-axis, the area ratio per class.

TheROIMeasurements results view, shows the results for all, of the defined ROIs, for
example, the number of objects per ROI. Select theROI Histogram results view, to
view the same results as a histogram.

Displaying the measurement results
Themeasurement results will be shown in the image in a special data layer, the
DetectedObjects layer. Try and picture the layer as a transparencywhich is placed
over the image.When youmeasure an image, the image data will not be changed by
having themeasurement results displayed on it.

You can, at any time, hide or show theDetectedObjects layer. To do so, use the
Layers tool window. There you have access to all of an image's layers. The eye icon

identifies all of the layers that are currently on display on your monitor. Click the eye
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icon in front of themeasurement layer, to display theDetectedObjects layer. Click an
empty cell without an eye icon tomake the corresponding layer reappear. You can
configure the display and the output of themeasurement results.

Editing objects
In theCount andMeasure tool window, you can find a toolbar with which you can deal
with individual objects. You can select one or more objects, add new objects, or delete
objects. Aswell as this, it's possible tomanually or automatically separate objects that
are joined together.

Saving the image together with results and settings
The image is automatically saved together with the all of the results and settings. It isn't
necessary to save the results separately.

Note: Always use the TIF or VSI file format when saving an image. Otherwise you will
losemost of the image information and the results during saving.

When you have analyzed and saved an image, you can restore all of the settings from
the original image analysis with theRestore Options button. You can use the settings
again, for the analysis of another image for example. This applies to all of the settings
of the threshold value setting, detection, and classification.

This doesn't apply to the filter settings. These can be saved and loaded separately, in
theObject Filter results view. Excluded are also the object, class, and ROI,
parameters. These can also be saved and loaded separately.

This button is located on theCount andMeasure tool window's toolbar.

Exporting data
Data can be exported as anMS-Excel table, or as an internal workbook. They can also
be exported as a diagram from theClassHistogram andROI Histogram results views.
Thismakes it possible to save the results independently of the image and the object
analysis's settings.

00396

10.2. Carrying out an automatic image analysis
You can use an automatic image analysis to carry out numerousmeasurement tasks.
Several typical tasks and their process flow are described here.

Prerequisite: The automatic object analysis functions are only available when the
Count andMeasure software solution has been purchased and is active.

Basic functions for automatic image analysis
Counting objects
Measuring objects (selecting and outputtingmeasurement parameters)
Filtering objects
Classifying objects

Performing a phase analysis
Performing a phase analysis
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10.2.1. Counting objects
Example: You have an image with objects that interest you. You want to know how
many of these objects there are in the image.

You want to detect and count graphite particles on the example image.

Preconditions
The objects that you want to count must not be connected, but must be clearly
separated from one another. The objects in the foreground should be optically clearly
separated from the image's background. In the example image shown, the
background is bright. The objects are in the foreground and are dark in color.

Preparations
1. Use theView > ToolWindows > Count andMeasure command to have theCount

andMeasure tool window displayed.
2. Acquire an image or load one.

l During the installation of your software some sample images have been
installed, too. You can follow these step-by-step instructions using the
GlobularGraphite.tif example image.

Setting options
3. Open theOptions dialog box by clicking theCount andMeasure Options button,

located in theCount andMeasure tool window.
4. Select theCount andMeasure > Detection entry in the tree view.
5. In theOptions group, enter the value 5 in theMinimumobject size field. An object

must now be at least 5 pixels large in order to be counted as an object. By doing
that, you will rule out the possibility that individual pixels, that maywell have the
same color or intensity as the objects, but don't belong to an object, are counted
as objects, which would then falsify the results. This way you can exclude noise
and dust particles.

6. ClickOK to exit theOptions dialog box.

Setting threshold values

7. In theCount andMeasure tool window, click theAutomatic Threshold... button to
open theAutomatic Threshold dialog box.
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l If theAutomatic Threshold button is not yet active, activate it first. To do so,
select theAutomatic Threshold... entry in the Threshold button'smenu. You
open thismenu by clicking the small arrow next to the button.

l The threshold values are set automatically in theAutomatic Threshold dialog
box.

l All of the objects that have been detected will be displayed in color.

8. Checkwhether the objects have been correctly recognized.
Should the objects not have been correctly recognized, go to theBackground
group and enter whether the background is bright or dark.
For the image shown above, select theBackground > Bright option, since the
image shows dark objects against a bright background.

9. Only when theRemove Phase button in theChannel thresholds for phase ...
group is active:
Delete all but one of the phases by continuing to click theRemove Phase button
until the button becomes inactive.
l By doing that, you will make certain that no phases from earlier analyses are
still defined.

Viewing the results
10. To obtain the results, click theCount andMeasure button in theAutomatic

Threshold dialog box.

All the objects that are found are displayed in color in the image.

l TheAutomatic Threshold dialog boxwill be closed.

l The number of objects found is displayed in theObject Count group in the
Count andMeasure tool window.

l The objects that have been analyzed are then displayed in color, on their own
image layer. This image layer is calledDetectedObjects. Use the Layers tool
window tomake these image layers appear or disappear, or to delete them.
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The number of objects detected will be shown below, in theCount andMeasure tool
window, in theObject Count group. Should you not be able to see this number, click
the small black arrow tomake it visible. 

Separating objects
It is sometimes the case that two objects that are next to each other are not detected
separately because, as far as the software is concerned, they are joined together.
These sorts of objects can be separatedmanually.

1. Zoom into the image to enable you to better process the object.
2. Then click theManually Split Objects button, located in theEdit Objects group,

thenmove your mouse pointer onto the image.
3. Now define a separation line through the object by clicking the left mouse button.

Make sure, when you do this, that you drag the line over the object's outside edge,
since otherwise it won't be separated.

4. Right click to confirm the separation line.
l The object will then be divided up into two independent objects. The results will
be updated.

5. Then click theManually Split Objects button again, located in theEdit Objects
group, to leave themode for splitting objects.

Left: Two objects are touching each other and thus are counted as a single object.
Middle: Draw a separation line through the object.
Right: The joined up object has been separated, there are now two independent
objects. Separating the object puts it in a different size class and it is therefore allotted
a different color.
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10.2.2. Measuring objects (selecting and outputting
measurement parameters)

Example: You have an image with objects of different sizes. You want to know the
area of the largest object and to have a close look at that object in the image. In
addition to that, you want to export the results into a sheet.

Preparations
1. Acquire or load an image.
2. Carry out an automatic object analysis on the image.

Selecting a measurement parameter
3. Open theOptions dialog box by clicking theCount andMeasure Options button,

located in theCount andMeasure tool window.
4. In the tree view, select theCount andMeasure > Measurements entry, then click

theSelect Object Measurements button, located in theMeasurements group.
5. In theSelect Object Measurements dialog box, add theArea andObject ID

measurement parameters and close any open dialog boxes.
l From somemeasurement parameters other, more complex, measurement
parameters can be derived. In this case, you will find the basicmeasurement
parameters in the list of measurement parameters. Select the basis
measurement parameter from the list and define whichmeasurement
parameters are to be derived from it in the area of the dialog box to the right of
the list.
There are, for example, many different ways of determining the inner extent of
objects. In this case, you can select between theminimal, maximal andmean
inner extent.

6. Next, in theCount andMeasure tool window, click theCount andMeasure button
to output the results.

Viewing and sorting the results
7. In theCount andMeasure Results tool window, select theObject Measurements

results view.
l Themeasurement values for the objects' areas are displayed in theArea
column.
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8. Sort theArea column to find out which value is the smallest or the largest. To do
so, double click on the header of theArea column.
l This column'smeasurement valueswill then be sorted in ascending or
descending order.

9. Double click the header of the column again to sort themeasurement values in the
reverse order.
l An arrow in the header will show you the direction in which they are sorted.

Object - sheet link
10. Select the largest value in theArea column.

l The corresponding object will likewise be selected in the image window. In this
way, you can easily find an object that belongs to a specific value, and view it.

On the top left you can see theObject Measurements results view. The area of every
object that was detected is listed. The object with ID number 65 is the largest and
comes first in the table after sorting has taken place. The object with ID number 65 has
been selected in the results view and is therefore cross hatched in the image window.

Exporting the results to a sheet
11. In theObject Measurements results view, click theExport toWorkbook button.

10.2.3. Filtering objects
Objects that disturb you, or that don't interest you, can be excluded from the
measurement results. All of themeasurement values that lie outside the defined
measurement value area, won't be displayed, nor taken into account in any of the
results views.

Example: On an image with spheres of different sizes, 9 size classes are defined. You
want to know how many spheres fall into which size class. When the analysis has
been carried out, you discover that the number of the small spheres has been
overestimated, because spheres that weren't correctly separated, were also taken
into account (image on the left). Define an object filter that only counts roughly circular
objects.
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Left: At the top right of the image, you can see some spheres that weren't divided
properly. They have been sorted into the class of small spheres and are displayed in
red.
Right: After the definition of an object filter, the number of objects in each class has
changed. In particular, the red class of small spheres now has fewer objects.

Preparations
1. Load the image you want to analyze or acquire one.
2. Carry out an automatic object analysis on the image.
3. In theCount andMeasure Results tool window, switch to theObject Filter results

view.
l In the table you will see a list of all of the selectedmeasurement parameters
and their corresponding filter ranges. There will always only be one
measurement parameter active.

l If themeasurement parameter that you want to use for the object filter doesn’t
appear in the list, click theSelect Object Measurements button. You can find
the button on theCount andMeasure Results tool window's toolbar.
If you only want to evaluate the almost spherical objects, you can select the
Sphericity object parameter.

Entering the filter range directly
4. In the table in theObject Filter results view, click themeasurement parameter for

which you want to define a filter range.
5. Double click in the [Min. field, located next to themeasurement parameter to enter

the lower value for the filter range.
6. Either enter the requiredmeasurement value directly, or use the arrow keys.
7. Double click in theMax.[ field, then enter the higher value for the filter range.

l The higher value itself no longer belongs to the filter range.

l You can delete individual values by double clicking the value, then pressing the
[Del] key.

Defining the filter range interactively
8. In the table, click themeasurement parameter for which you want to define a filter

range.
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9. Click theSelect minimum value button, above theMeasurement list to define the
filter range's lower value.
l Themouse pointer will change its form.

10. Click an object whosemeasurement value is to be used as the lower value for the
filter range.
l Themeasurement value will then be automatically adopted in the [Min. field.
When you, for example, define a filter range for theArea parameter, click the
smallest object that you still want to measure.

l In the image window, the result of the filtering of the objects can be seen
straight away. All of the values that are outside the defined filter range will be
excluded from the results.

l The filter range contains precisely those values that are to appear in the
measurement results. All of the values that are outside the defined filter range
will be excluded from the results.

l The Toggle Object Filter button appears clicked, thereby showing you that the
object filter is active.

11. If you want to undo the selection you'vemade, click theClear minimum value
button.

12. Click theSelect maximum value button to define the filter range's upper value.
13. Click an object whosemeasurement value is to be used as the upper value for the

filter range. Click the largest object that you still want to measure.
l Themeasurement value is rounded up and automatically adopted in theMax.[
field. The object is still within the filter range.

Switching off the object filter
14. Release the Toggle Object Filter button.
Note: A defined object filter is not automatically deactivated when you load another
image. If, for example, no objects are shown, make sure that the object filter is
deactivated.

10.2.4. Classifying objects
Example: You have an image with two object classes, e.g., large and small cells. You
want to know how many objects fall into which size class.

Preparations
1. Acquire an image or load one. You can follow these step-by-step instructions

using theWoodVessels.tif example image.
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2. Perform an automatic object analysis on the image.
3. Select theArea object measurement.

Selecting measurement parameters for the object classes
4. In theCount andMeasure Results tool window, select theClassMeasurements

results view.
5. Click theSelect ClassMeasurements button, then in theSelect Class

Measurements dialog box, add theMean (Area),Object Class andObject Count
measurement parameters.
l With theMean (Area) parameter, themean area of all of the objects in a class
will be calculated. That's to say, the parameter give you ameasured value for
how large the objects in this class are, on average.

l With theObject Class parameter, you write the name and the color of the class
in the results sheet, as well. You should, without fail, adopt this parameter in
the results sheet to make it possible to assign themeasurement results
correctly to the individual classes. You can also adopt this parameter in the
Object Measurements results sheet. Then, in the results sheet, you'll be able to
immediately recognize to which class each of the individual objects belongs.

l At the end, theObject Count parameter delivers the values you are looking for
in the task: the number of objects found in each class.

6. Close theSelect ClassMeasurements dialog box.

Defining classes
7. Open theOptions dialog box by clicking theCount andMeasure Options button,

located in theCount andMeasure tool window.
8. Select theCount andMeasure > Classification entry in the tree view.
9. In theCurrent Classification group, click theNew Classification button, then

select theNew 'One parameter Classification' entry.
l TheDefine 'One parameter' Classification dialog box opens.

10. Enter a descriptive name for the new classification in theName field, size class for
example.

11. Select theArea entry in theMeasurement list.
l Only themeasurement parameters that have been selected for the object
analysis are shown in the list.

12. Click theAutomatic Classification button to switch to theAutomatic Classification
dialog box.

13. In theAutomatic Classification dialog box, click theGet Min./Max. from Image
button. Then the smallest and largest value of the selected parameter that has
been entered in theMinimum andMaximum fields, will be used.
l In this way, you'll be certain that all of the objects in the image can be assigned
to one of the classes that have been defined.

14. Enter the value 2 in theNumber of classes field, and in theScale field, select the
Logarithmic entry.
l By doing this, you have defined two size classes.
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Viewing the results
15. ClickOK and then theCount andMeasure button, located in theDefine 'One

parameter' Classification dialog box.
l The classeswill be displayed in the image in color. Themeasurement
parameters that have been selected for the classeswill be output in theClass
Measurements results view.

In the illustration, you can see the image with both of the size classes. The column (1)
shows the number of large (green) and small (red) cells that was being looked for.

16. Close theDefine 'One parameter' Classification dialog box.
l In theOptions > Count andMeasure > Classification dialog box, the new
classification is active in the list. You can now use this classification for other
analyses aswell.

17. Close theOptions dialog boxwithOK.
18. Then in theCount andMeasure Results tool window, activate theClass

Histogram results view to have the class results displayed as a bar chart.
19. Select theMean (Area) entry in theMeasurement picklist, and theClass entry in

theGrouped by picklist.
l Now the histogram displays themean area of the objects for each class.

In the illustration, you see the results for the object classes in theClassHistogram
results view. Themean area ratio for the object classes is displayed as a diagram. You
can clearly see that the green objects are significantly larger than the red objects.
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10.2.5. Performing a phase analysis
Example: You have an image with several phases. You want to know how large the
area ratio of the individual phases is.

Setting options
1. Open theOptions dialog box by clicking theCount andMeasure Options button,

located in theCount andMeasure tool window.
2. Click theCount andMeasure > Detection entry in the tree view. Enter a value of 1

in theMinimumobject size field. This ensures that the whole image will be
analyzed.

Selecting measurement parameters
3. Select theArea object parameter.
4. Select theObject Class, Sum (Area) andRelative Object Count class parameters.

Setting threshold values
5. In theCount andMeasure tool window, click theAutomatic Threshold... button to

open theAutomatic Threshold dialog box.
6. Select theNone option in theBackground group. Thismeans that no area of the

image is defined as background. In this case, the complete image will be
evaluated when the automatic analysis is carried out.

7. Keep clicking theAdd Phase button to add new phases until thresholds have been
set for all of the phases in the image.
l The threshold values are automatically set.

l The phases that have been defined are shown in the histogram.

l You can also observe the definition of the phases in the image window. The
defined phases have the same color that theywere allocated in the dialog box.

Viewing the results
8. Then click theCount andMeasure button to get the results.

l The results are shown in theCount andMeasure Results tool window in the
ClassMeasurements results view. For each phase, you see the area that this
phase takes up in the image.
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The result of a phase analysis: The results sheet shows the area ratio of each phase.
The sum of the percentage area ratio is 100%, because the whole image was
analyzed.
Image (1) has four phases; one black, one light gray, one dark gray and one white.
Image (2) shows the image resulting from the phase analysis.

Note: The phase analysis is also available in the analysis processes in theMaterials
Solutions tool window. You can use it to very simply apply the phase analysis to
several images consecutively and to display the results in a report.
This analysis process is only available if you have bought the corresponding solution.

00513

10.3. Carrying out an automatic image analysis on ROIs
AnROI (RegionOf Interest) is a certain area of an image. You can limit an automatic
image analysis to a certain segment of the image. The analysis will then only be
performed on this image segment. You can also define several ROIs and compare the
results with each other.

Defining ROIs
Performing a phase analysis on a ROI
Analyzing object classes on ROIs

10.3.1. Defining ROIs
There are several ways of defining ROIs.

l Use the functions in theCount andMeasure tool window.
l Convert a detected object into an ROI.
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Using the "Count and Measure" tool window
1. Load the image you want to analyze or acquire one.
2. Use theView > ToolWindows > Count andMeasure command to have theCount

andMeasure tool window displayed.
3. Carry out an automatic object analysis on the image.
4. In theCount andMeasure tool window, click the small black arrow next to the

Count andMeasure button.
5. Select theCount andMeasure on ROI entry from the button's context menu.

l TheCount andMeasure button is now calledCount andMeasure on ROI.

6. From theCount andMeasure on ROI button's context menu, select theNew ROI
command.
l A context menu that offers you 3 tools for the definition of ROIs, will open. You
can define an ROI as a rectangle, circle or polygon. It is also possible to define
several ROIs on an image using different tools.

7. Click on a tool to select it, theRectangle button for example, thenmove your
mouse pointer onto the image.
l The pointer will change its shape to a cross. The selected tool appears under
themouse pointer.

8. With your left mouse button, define the segment in the image that is to be used for
the analysis. If needed, right click to confirm the ROI.
If necessary, define further ROIs.

9. When all of the ROIs have been defined, click theCount andMeasure on ROI
button to obtain the results.

Note: If theCount andMeasure on ROI button has been activated, but no ROI have
been defined, the automatic analysis will by performed on the complete image.

Converting an object into an ROI
You can use thismethod of defining an ROI when you want to analyze objects within
an object.

The image on the left showsworkpiece with holes. The automatic object analysis
(right) has turned the workpiece into a ROI.

1. Load the image you want to analyze or acquire one.
2. Define the threshold values to include the object that you want to turn into an ROI.

l In the example shown, you can use automatic threshold value setting and
select a light background.
Please note that the holes should not be filled by the image analysis. To do this,

OLYMPUS Stream UserManual 272



10.  Counting andmeasuring objects
10.3.   Carrying out an automatic image analysis on ROIs

clear the Fill holes check box in the Tools > Options > Count andMeasure >
Detection dialog box.

3. Carry out an automatic object analysis on the image.
4. Click theSelect DetectedObjects button to switch to the selectionmode. You can

find the button in theCount andMeasure tool window, in theEdit Objects group.
5. Select the object that you want to turn into an ROI.
6. Click the right mouse button to open a context menu.
7. Select theCreate ROIs fromSelectedObjects command from the context menu.

l The object will now be converted into an ROI.

l You can find the ROI in theMeasurement and ROI tool window. You can
rename the ROI here. You can also save and delete the ROI.

8. Now define suitable threshold values for the objects inside the defined ROI.
l In the example shown, you can use automatic threshold value setting and
select a dark background.

10.3.2. Performing a phase analysis on a ROI

Task
You have a light object. The light object contains several smaller areas belonging to a
dark phase. You want to know what percentage of the whole area of the light object is
taken up by the dark phase. This problem can be resolved by performing a phase
analysis on a ROI.

On the second image (right), the ROI has been defined as a light object. This enables
the percentage area ratio to be computed.

1. Load the image you want to analyze or acquire one. You can follow these step-by-
step instructions using theMacroscopicComponent.tif example image.

Selecting measurement parameters
2. Select theROI andArea Fraction ROI class parameters. To do this, you can click

theSelect ClassMeasurements button located in theClassMeasurements
results view.

Defining an ROI
3. In theCount andMeasure tool window, click theCount andMeasure button's

small black arrow to open a context menu. In the context menu, select theNew
ROI > Polygon command.
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4. Move your mouse pointer onto the image.
l The pointer will change its shape to a cross.

5. With your left mouse button, define the segment in the image that is to be used for
the analysis. To do this, click on pixels on the edge of the light object.

6. Right click to confirm the ROI.

Setting threshold values
7. Open theManual Threshold dialog box.
8. Set suitable threshold values for the phase.

Viewing the results
9. In theCount andMeasure tool window, click theCount andMeasure button's

small black arrow to open a context menu. In the context menu, select theCount
andMeasure on ROI command.
l The results for the ROI are shown in theClassMeasurements results view.
TheArea Fraction ROI column showswhat percentage of the ROI's area is
taken up by the phase.

10.3.3. Analyzing object classes on ROIs

Task
You are interested in two segments and two object classes on an image.
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TwoROIs have been defined on the image. You want to calculate the number of large
and small cells in the upper and lower area of the image and compare them to each
other.

Preparations
1. Acquire an image or load one.

l You can follow these step-by-step instructions using theWoodVessels.tif
example image.

2. Perform an automatic object analysis on the image.
3. Select theArea,Object Class andROI object measurements.
4. Select theMean (Area),Object Class,Object Count andROI class

measurements.
5. Select a classification that groups all objects into two size classes.

Defining an ROI
6. Define two rectangular ROIs on the image.

Setting options
7. Open theOptions dialog box by clicking theCount andMeasure Options button,

located in theCount andMeasure tool window.
8. Select theCount andMeasure > Detection entry in the tree view.
9. In theBorders - ROI group, select the Truncate option. By doing this, you will

make sure that objects that lie on the edge of the ROI are counted aswell.
Observe though, that the objects will be cropped. The area of the objects on the
edge won't, therefore, be correctlymeasured. You should use this option
especially when you're mainly interested in finding out how many objects are
present, and are not interested in the area.

Selecting measurement parameters for the ROIs
10. Select theCount andMeasure > Measurements entry in the tree view.
11. Click theSelect ROI Measurements button, then in theSelect ROI Measurements

dialog box, add theMean (Area),ROI andObject Countmeasurement
parameters.

12. Close all open dialog boxes.

Viewing the results
13. In theCount andMeasure tool window, click theCount andMeasure button's

small black arrow to open a context menu. Select theCount andMeasure on ROI
entry there.
l The button is now calledCount andMeasure on ROI. The results will be
automatically output.

l The classeswill be displayed in the image in color. The selectedmeasurement
parameters for the classes and ROIswill be output in theClassMeasurements
andROIMeasurements results views.
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The analysis performed above, supplied numerous different results. This illustration
explains some of the possible results of the analysis that was performed above.

In the image in themiddle, you can see that the analysis was carried out on two ROIs
(blue and yellow). In both ROIs, objects were recognized that were assigned to two
size classes. The small objects are shown in red, the large objects in green.

Class measurements
The results of the classmeasurement are shown to the left of the image. You can find
these results in both theClassMeasurements and theClassHistogram results view.
In diagram (1), you can see themean area of an object for each of the size classes
defined.
As can be expected, the green objects are on average, much larger than the red ones.

In diagram (2) the number of objects that fall into the green class and the red class, are
shown. Clearly, there are far more small, red objects, than there are large, green
ones. The class results take all of the objects into account, regardless of in which ROI
theywere found.
You can, however also output the class results per ROI. In this case, select theROI
entry, in theGrouped by list.

ROI measurement
The results of the ROI measurement are shown to the right of the image. You can find
these results in theROIMeasurements and theROI Histogram results view.
In the diagram (1) you can see, for each ROI, themean area of all of the objects found
in that ROI. More large, green objects were found in the yellow ROI, than in the blue
ROI. For this reason, themean area of an object in the yellow ROI is considerably
larger than that in the blue ROI. The difference is, however, not so extreme as the ratio
of small to large objects is.

In diagram (2) the number of objects per ROI has been plotted. There aremore
objects in the blue ROI than there are in the yellow one.

00356 05062015

OLYMPUS Stream UserManual 276



10.  Counting andmeasuring objects
10.4.   Editing objects

10.4. Editing objects
In theCount andMeasure tool window, you can find a toolbar with which you can deal
with individual objects. You can select one or more objects, add new objects, or delete
objects. Aswell as this, it's possible tomanually or automatically separate objects that
are joined together. Should you not be able to see theEdit Objects group in theCount
andMeasure tool window, click the small black arrow tomake it visible.

Editing objects
The buttons in theEdit Objects group aren't available until the image has been
analyzed. Some of the editing functions require you to first select the objects you want
to work on.

Select one or more objects that you want to edit and then click, for example, theDelete
SelectedObjects button to delete all of the selected objects simultaneously. The
results will be immediately updated. If you have deleted or added objects, the total will
be correspondingly adjusted.

Note: When you have edited objects in an image, then analyze the image again, the
changes you'vemadewill be lost.

Selecting detected objects
1. Carry out an object analysis on the current image or load an image with an

existing object analysis.
2. Click theSelect DetectedObjects button in theCount andMeasure tool window

to switch to the selectionmode.
l Now, as soon as youmove themouse onto the image, the shape of themouse
pointer will change. The shape of themouse pointer is different depending on
whether themouse pointer is on an object or not.

3. Click on any object to select it.
l The selected object will be displayed hatched, and can now be edited.

l The corresponding row in theObject Measurement results view will be
selected. Thus, selecting, is onemore way in which you can examine
measurement values of individual objects.

l Alternatively, you can also use theSelection Tool button, located on the
Toolbox toolbar.

Selecting several objects
4. To select several objects simultaneously, in the selectionmode, while keeping the

[Ctrl] key depressed, click the objects you want to select, one after the other.
l Every object you click will be added to the selection.

l Alternatively, you can also keep the left mouse button depressed, and while
doing so, drag out a frame. All of the objects that are fully, or only partly, within
this frame, will be added to the selection.
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Undoing the selection
5. To undo a selection, in the selectionmode, while keeping the [Ctrl] key depressed,

click the selected object again.

Selecting all of the objects
6. To select all of the objects simultaneously, use the keyboard shortcut [Ctrl + A], in

the selectionmode.

Selecting objects via the results sheet

You can also select objects using the results sheet in theCount andMeasure Results
tool window. Thismethod can be useful if you only want to select objects with specific
numerical values, for example.

1. In theCount andMeasure Results tool window, click any row in theObject
Measurement results sheet.
l The row will be selected. The corresponding object in the image will also be
selected, and will appear hatched. You can always recognize which object
belongs to whichmeasurement result.

l Youwill then automatically switch into the selectionmode.

2. You can also select several rows simultaneously here, or undo selections. To do
this, use the same keyboard shortcuts that you use for the selection of objects in
the image.

3. Then click theSelect DetectedObjects button, located in theEdit Objects group,
again to leave the selectionmode.

Adding new objects
1. Carry out an object analysis on the current image or load an image with an

existing object analysis.
2. To add new objects to an image, use theNew Object button in theCount and

Measure tool window. Click the arrow next to theNew Object button.
l A context menu opens that offers you 2 tools for adding objects. You can add
an object as a polygon or as a circle. It's also possible to use both tools on one
image.

3. Click on a tool, e.g., theNew Circle . Object button, thenmove your mouse
pointer onto the image.
l The shape of themouse pointer on the image indicates the current mode.

4. While keeping your left mouse button depressed, drag out a circle on the image,
that is to be added as a new object.

5. Confirm your selection with the right mouse button. Add, if necessary, further
objects.
l The results shown in theObject Measurements table are updated and the
object count is increased accordingly.
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Deleting objects
1. Carry out an object analysis on the current image or load an image with an

existing object analysis.
2. Click theSelect DetectedObjects button in theCount andMeasure tool window

to switch to the selectionmode.
3. Click on an object to select it. If you want, expand the selection and select more

objects to be deleted.
4. Click theDelete SelectedObjects button to delete the selected object.

l All of the selected objects will be deleted from the image. The corresponding
data in theObject Measurement sheet will be deleted.

5. You can also select objects using the results sheet in theCount andMeasure
Results tool window. Select one or more rows there. Then right click and select
theDelete All SelectedObjects command in the context menu.

Separating objects manually
1. Carry out an object analysis on the current image or load an image with an

existing object analysis.
2. Click theManually Split Objects button, thenmove your mouse pointer onto the

image.
l The shape of themouse pointer on the image indicates the current mode.

3. Next, while keeping your left mouse button depressed, drag a line through the
object that you want to separate into two. Make sure, when you do this, that you
drag the line over the object's outside edge, since otherwise it won't be separated.
You can also separate several objects with a separation line.

4. Right click to confirm the separation line.
l The object will then be divided up into two independent objects.

l The classification is updated. As a consequence, some objectsmay now be
assigned to other classes. The object count is increased, and a new line is
added to the results sheet.

Separating objects automatically
1. Carry out an object analysis on the current image or load an image with an

existing object analysis.
2. Click theSelect DetectedObjects button in theCount andMeasure tool window

to switch to the selectionmode.
3. Click one or more objects to select them.
4. Click theAuto Split SelectedObjects button to have the touching objects

automatically separated.
l Objects that fulfill themorphological criteria for a separation, will be separated.

l If a lot of objects are selected, the automatic object separation can take a long
time. If this is the case, a progress bar is displayed in the status bar. You can
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abort the process at any time by clicking theCancel button.
l The results will be correspondingly updated.

Left: A joined up object that is to be separated.
Middle: The joined up object has been selected.
Right: The joined up object has been separated, there are now two independent
objects.

Note: The automatic separation of objects only functions in cases that are very clear-
cut. For this reason, the recommendation; apply amorphological filter before the
actual object analysis is performed, to generally improve the separation of objects.

00503 05062015
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10.5. Enhancing the segmentation
It maywell occur, that after the segmentation has taken place, objects in an image
have not yet been correctly separated. To improve the segmentation, you can, for
example, use amorphological filter.

Separating touching objects
Task: Use theSeparate Objectsmorphological filter to separate touching objects
before performing an image analysis.

In this image, several objects are touching. Thismeans that the detection process
doesn't recognize them as separate objects. It counts them as a single object.

Preparation
1. Load the image that you want to analyze.
2. TheSeparate Objects filter creates separation lines on the image. This changes

the image information. Therefore, save the source image under a different name if
you want to keep the original data.

Separating objects
3. Use theProcess > Morphological Filter > Separate Objects... command.

l The Filter: Separate Objects dialog box opens.

4. Zoom into the source image tomake it possible to easily recognize a typical object
that has not been separated.

5. Select theOriginal and Preview preview function. Now, the same image segment
will be displayed twice in the preview area of the image processing dialog box.
The one shown on the left is the source image. The one on the right is the image
that results when the current parameters are used.

6. For this example, select theStep option in theSettings group.
7. Move the Fine / Coarse andSmoothness slide controls and observe the effect in

the dialog box's preview. Start with the small values. Small values generally result
in a lot of separation lines.
In this example, the objects are separated well using the Fine / Coarse = 1 and
Smoothness = 3 parameters.

8. Select whether the filter is to take 4 or 8 neighboring pixels into account in each
case, then observe the effect this has in the dialog box's preview. Select the
parameter that does the best job of separating the touching objects.
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9. In this example, select theBurn white option. The separation lines are now white
and so don't interfere with the setting of the threshold values for the dark objects.

After theSeparate Objects filter is applied white separation lines separate the touching
objects.

10. In the Filter: Separate Objects dialog box, click theOK button to apply the filter.
l Note: The contents of the image will be changed. Youmay have to check the
threshold value settings for the next object analysis.

l Depending on the size of the image, applying theSeparate Objects filter can
take a long time.Watch the progress bar located in the status bar.

Carrying out an object analysis
11. In theCount andMeasure tool window, click theCount andMeasure button to

perform the object analysis and output the results.

The image on the left shows the original image before the objects were separated.
The image on the right shows the separated objects after theSeparate Objects filter
has been applied. The numbers are the objects' IDs. All objects with the same color
belong to the same size class. Before the object was separated, it was so large that it
couldn't be assigned to a size class. That's why it was cross hatched.
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Separating touching objects without changing the original image
Task: In this example, objects that haven't been correctly separated by the
segmentation process, are to be separated by using theSeparate Objects
morphological filter. This doesn't change the original image.

Showing the segmentation image
Usually, the segmentation image is not shown in theDimension Selector tool window.
You have to activate it first.

1. In theCount andMeasure tool window, click theCount andMeasure Options
button, and select theCount andMeasure > Segmentation entry in the tree view.

2. Select theShow 'Segment' button check box, and clear theDelete segmentation
after detection check box.

3. Close theOptions dialog boxwithOK.

Starting an object analysis
4. Load the image you want to analyze and set the thresholds.
5. Then click theSegment button in theCount andMeasure tool window to create

the segmentation image.
l You can now see the segmentation image in the image window. The
segmentation image is a binary image in which all of the objects that are
defined by the thresholds that have been set are displayed in red. The
segmentation image belongs to the original image and is added to the original
image in its own image layer. Use theDimension Selector tool window to
toggle between the source image and the segmentation image.

l The subsequent separation of the objects takes place in the segmentation
image.

Separating objects in the segmentation image
6. Use theProcess > Morphological Filters > Separate Objects command to

separate objects in the segmentation image.
l The Filter: Separate Objects dialog box opens.

7. Select theBoundary shape > Dark option, if you want to separate bright objects
that have a dark background.

8. Select theBurn black option, if you want to separate bright objects that have a
dark background.

9. Set a value between 1 and 10 with the Fine / Coarse slide control and observe the
effect in the dialog box's preview. Select the parameter that does the best job of
separating the touching objects.

10. Choose theApply on > Selected frames and channels option. Now, theSeparate
Objects filter works exclusively on the segmentation image. The source image
remains unchanged.

11. In the Filter: Separate Objects dialog box, click theOK button to apply the filter.
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l The object analysis that now follows is performed exclusively on the changed
segmentation image.

The image on the left shows an object when the segmentation has taken place. The
object was falsely detected as joined up, although there are actually two touching
objects. In the image on the right, one can see the correctly separated objects, after
theSeparate Objects filter has been applied.

Carrying out an object analysis
12. In theCount andMeasure tool window, click theCount andMeasure button to

perform the object analysis and output the results.
l After you have performed the object analysis, take a look at the unchanged
source image with the analysis results in the image window.

Displaying the segmentation image
13. Use theView > ToolWindows > Dimension Selector command to show the

Dimension Selector tool window.
l You can toggle between the source image and the segmentation image there.

The source image (1) and the segmentation image (2) are displayed in theDimension
Selector tool window. Click the eye icon in front of one of the images to hide it in the
image window. Click on the empty cell without an eye icon tomake the corresponding
image reappear.

Note: Use theDimension Selector tool window to show or hide the segmentation
image.
Use the Layers tool window to show or hide the results of the object analysis in the
image window.

00514
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11. Reports
11.1. Overview

You can create reports with your software to document the results of your work and to
make them available to third parties. You can share reports as files or as printed
documents.

Two programs are always involved in the creation of reports: Your image analysis
software and aMicrosoft Office application program.

You can use the followingMicrosoft Office application programs to create reports:

l Microsoft Word 2010, 2013, 2016, 2019 or the Office 365Word Desktop app

l Microsoft Excel 2010, 2013, 2016, 2019 or the Office 365 Excel Desktop app

l Microsoft PowerPoint 2010, 2013, 2016, 2019 or the Office 365 PowerPoint
Desktop app

Examples of reports in different file formats

The illustration displays one report in MS-Word format and one inMS-PowerPoint
format.
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This illustration shows a report in MS-Excel format. The report displays an image with
measurements on it and an Excel sheet with themeasurement results.

Different ways of generating reports
The requirements for working with reports are very different depending on the user
and the way you are working. There are different procedures for creating reports.

1) Creating MS-Word reports using the "Report Composer" tool
window
For users who regularly create reports that aremade up in the samewaywith a lot of
images and who require these inMS-Word format.

For this, your image analysis program should be open in the foreground. In theReport
Composer tool window, open or create a report instruction (RCI file) in which you
specify which images and which page layout the report should contain. Then you
create a report which is displayed inMS-Word at the touch of a button. In MS-Word
you now only undertake small corrections of the report.

Note: With theReport Composer tool window, it isonly possible to create reports that
can be opened with theMS-Word application program.

2) Creating and editing reports using the Olympus MS-Office Add-in
For users who require reports in MS-PowerPoint format.

For users that want to insert images or documents that were created with the image
analysis program into new or existingMS-Excel documents.

For users that want to insert images or documents that were created with the image
analysis program into new or existingMS-Word documents. Also for users who want
to processMS-Word reports that were created using theReport Composer tool
window.

When you use theOlympusMS-Office add in, your image analysis program opens in
the background. You can use theOlympusMS-Office add-in to insert images,
workbooks or charts from your software into anMS-Word, MS-Excel, or MS-
PowerPoint document. You use what are called templates to do this. With MS-Word
reports, you definePage Templates in the DOC or DOCX file format. With MS-
PowerPoint reports, you defineSlide Templates in the PPT or PPTX file format. With
MS-Excel reports, you defineExcel templates in the XLTX file format.
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3) Creating MS-Excel reports from the software
For users who require reports in MS-Excel format, for example, because theywant to
analyze the data andmeasurement results gained in the image analysis program
further in MS-Excel. The table with themeasurement results is inserted into theMS-
Excel document aswhat is known as an Excel sheet.

For this, your image analysis program should be open in the foreground. Let’s assume
you'vemade some lengthmeasurements on an image and now click theCreate Excel

Report button in theMeasurement and ROI tool window. In theCreate Excel
Report dialog box, you select the Excel template to be used for the report. Clicking the
OK button now starts theMS-Excel application programwhere the report is displayed.

Procedure 1: Report generation using the "Report Composer" tool
window

1. New report instruction
Switch to theReporting layout and create or open a report instruction. Place

the documents you want in it.

2. Creating a report
Create a report.

3. Working with the Olympus MS-Word add-in
In MS-Word: Have a look at the report andmake small changes, if

necessary.

4. Saving the report and the report instruction
If you want, print the report or create a PDF file. Save the report instruction

(and the report as well, if needed).

Procedure 2: Report generation using the Olympus MS-Office add-in
1. Creating a new PPTX, XLSX or DOCX file
Create a new file or open an existing document.

2. Working with the Olympus MS-Office add-in
In MS-Word, MS-Excel, or MS-PowerPoint: Use the functions on the

Olympus tab to add documents to the report.

3. Working with the Olympus MS-Office add-in
Use the functions on theOlympus tab to layout the report (info stamp, detail

zoom and border, for example).
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4. Saving the report
Save the report. If you want, print it or create a PDF file.

Procedure 3: Creating MS-Excel reports from the software
1. Measuring and saving an image

Open or create an image and carry out several measurements on it. Save the
image.

2. Selecting the Excel template and the data to be used for the report and starting the
report creation

Click theCreate Excel Report button andmake the necessary settings in the
Create Excel Report dialog box. Click theOK button to start MS-Excel.

3. Working with the Olympus MS-Office add-in
Use the functions on theOlympus tab to layout the report (info stamp, detail

zoom and border, for example).

4. Saving the report
Save the report. If you want, print it or create a PDF file.

00112 24012020
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11.2. Working with the report composer
TheReport Composer tool window supports you when you are creating and updating
report instructions. In this tool window, you also find theCreate button that is used to
start the report creation.

Note: Two programs are involved in the creation of reports using theReport
Composer tool window: Your software and theMS-Word application program. You
can use the following versions for working with reports: Microsoft Word 2010, 2013,
2016, 2019 or theWord Desktop app of Office 365.

Note: With theReport Composer tool window, it isnot possible to create a report that
can be opened with theMS-PowerPoint or MS-Excel application programs.

Should theReport Composer tool window be hidden, use theView > ToolWindows >
Report Composer command tomake it appear.

Creating a new report instruction
To create a report, first create a new report instruction in your software. You can also
use a saved report instruction.

Note: The report instruction has to contain at least one registered page template.

1. Switch to theReporting layout.
2. Click theNew Report Instruction button. You find this button in theReport

Composer tool window.
l A new document of the report instruction type will be created in the document
group. This document is at the same time the workspace in which you put the
report together.

3. If no default document template has been defined: Drag the document template
you want onto the upper part (1) of the report instruction. You find a list of the
available document templates in the upper part (2) of theReport Composer tool
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window.
l If a default document template has been defined, it will be automatically
inserted in the upper part of the new report instruction.

l Creating a report is also possible when you leave the upper part of the report
instruction empty. In this case, the default MS-Word document template is
used.

4. Drag the page templates you want onto the lower part of the report instruction (3).
You find a list of the available page templates in the lower part (4) of theReport
Composer tool window.
l Every report has to contain at least one page template.

l Make sure that the page templates contain the correct placeholders for the
document types that you want to drag onto the report instruction. Accordingly, if
your report is to contain an image and a chart, select a page template that
contains one placeholder for an image and another for a chart.

l If you want to use workbooks in your reports, MS-Excel must be installed on
your PC. TheminimumMS-Excel version required isMS-Excel 2010.

l The placeholder for a workbook can also be used for anMS-Excel file. To do
so, select theMS-Excel file in the File Explorer tool window and drag it onto the
report instruction. In the report instruction, MS-Excel files are shownwith this
icon:

5. Drag the documents you want onto the lower part of the report instruction (3).
l In theReporting layout, theDatabase,Gallery and File Explorer tool windows
are arranged to the left of the document window. In each of the tool windows
you can select one or more documents and drag them onto the report
instruction. If you use the File Explorer tool window, the documents do not
need to be open for this. If you use theDatabase tool window, the documents
don't have to be open. It is sufficient to open the database. However, the
Gallery tool window only allows you to select documents that are currently
open in your software.

l You can also integrateMS-Word files (e.g., background information regarding
the project) into your MS-Word reports. MS-Word file don't need a placeholder
in the report instruction. Select theMS-Word file in the File Explorer tool
window and drag it directly onto the report instruction. In the report instruction,
MS-Word files are shownwith this icon:

l The documentsmust have been saved, because unsaved documents cannot
be included in a report.
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The illustration shows an example of a report instruction. In the report, two different
page templates are to be used. The first page template contains a single placeholder
for an image, the second page template contains two placeholders for an image. After
the page template, the images that are to be inserted in the report page are displayed.

6. Check the report instruction now. Youmay still edit it and, e.g., delete or shift
documents or select another page template.

Creating a report
1. Click theCreate button. You find this button in theReport Composer tool window.

l The report will be created. Creating a report can take some timewhen large
reports with many images and documents are involved. Pay attention to the
progress bar that is shown. TheMS-Word application programwill open
automatically and display the new report. In the example shown below, the
report has three pages. (The fact that the first page template only contains one
image placeholder and two images have been added to the report instruction,
automatically leads to the creation of two report pages.)

2. If you want to, you can still make additional changes in theMS-Word application
program. To do so, use the add-in fromOlympus.

3. If you want to, save the report instruction and the report.

Editing a report instruction
You canmake the changes described below to a report instruction. These changes do
not apply to reports the have already been created on the basis of this report
instruction. Therefore youmust create a new report in order to see the changes you
made. This will generate a new MS-Word document. Any changes that youmay have
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made in the first version of the report is not be contained in the newly createdMS-
Word file.

Exchanging the document template
1. Load the report instruction that you want to edit.

l Report instructions have the file extension RCI.

2. To delete a document template, select it and press the [Del] key on your keyboard.
3. Drag the new document template onto the upper part of the report instruction.

l By doing so, the document template is exchanged. Please note that a report
instruction can only contain one document template.

l A report instructionmust not contain a document template at all. When you
leave the upper part of the report instruction empty, theMS-Word default
document template will be taken.

Changing the page templates
1. Load the report instruction that you want to edit.
2. In the report instruction, select the page template you want to exchange.
3. Use the [Del] key on your keyboard to delete the selected page template from the

report instruction.
l By doing so, you only deselect the page template, no file will be deleted.

4. Drag the new page template to the position in the report instruction, where the
deleted page template had been located.
l Every report has to contain at least one page template.

Shifting the page templates
1. To shift a page template to another place in the report instruction, select it and,

with the left mouse button depressed, drag it to a new position (Drag&Drop).
l In certain cases, thismay change the appearance of the report considerably.
All documents that come after this page template in the report instruction will
use this page template in the report.

Deleting documents
1. Load the report instruction that you want to edit.
2. In the report instruction, select the documents that you want to delete.
3. Use the [Del] key on your keyboard to delete all of the selected documents in the

report instruction.
l By doing so, you only undo the document selection, no file will be deleted.

Adding documents
You can add new documents to an existing report instruction at any time.

1. Load the report instruction that you want to edit.
2. Simply drag the new documents onto the position you want in the report

instruction.
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l Dragging & dropping images onto the report instruction is possible from the
Database,Documents, File Explorer andGallery tool windows.

l Please note the page templatesmust be placed before the images.

Moving documents
You can change the order in which the selected documents are arranged in the report
instruction at any time.

1. Load the report instruction that you want to edit.
2. Select an image, and with the left mouse button depressed, drag it to another

position (Drag&Drop).
00153 24012020

11.3. Working with the Olympus MS-Office add-in
Note: The language on theOlympus tab corresponds to the language set in your
image analysis software. This language can differ from the language in which theMS-
Word, MS-Excel or MS-PowerPoint application program is shown.

11.3.1. The add-ins' functions
This add-in assists you with very different tasks:

1. Inserting a document that is currently open in your image analysis program, into
anMS-Word, MS-Excel, or MS-PowerPoint document. In order for this to work,
the document must have been saved. Unsaved documents can’t be inserted.

2. Inserting a document that is saved locally, or is in your image analysis program's
database, into anMS-Word, MS-Excel, or MS-PowerPoint document.

3. Inserting a field that contains information that is saved in your image analysis
program into your MS-Word, MS-Excel, or MS-PowerPoint document. This
makes sense, for example, when you want to see the acquisition date of a certain
image.

4. You add one or more detail zooms to an image.
5. You change the image properties and set, for example, whether or not the info

stamp and the scale bar should be shown.
6. You change the resolution of one or all images of the report. If you want to share

the report, it may be sensible to reduce the resolution, thereby also reducing the
file size.

7. You update all placeholders in your report. Thismakes sense, for example, when
you'vemade changes to the documents in your image analysis software that the
report doesn't contain yet.

8. Inserting anMS-Word, MS-Excel, or MS-PowerPoint document into the
software's database. This command is only available if your software supports the
database functionality.

9. Defining templates that you want to use for your work with reports. With MS-Word
reports, you define page templates in the DOC or DOCX file format. With MS-
PowerPoint reports, you define slide templates in the PPT or PPTX file format.
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WithMS-Excel reports, you define Excel templates in the XLTX file format.
10. You can insert an additional table placeholder into theMS-Excel report to view the

contents of an additional worksheet.
10404 04032019

11.3.2. Creating MS-Excel reports
When your image analysis software is installed, an Olympus add-in is added to the
MS-Excel application program.When you openMS-Excel and see theOlympus tab,
this indicates that the add-in has been installed. With the help of this add-in, you can
create reports in MS-Excel that contain images, workbooks and charts from your
image analysis program.

Creating reports using theMS-Excel application program is an alternative to creating
reports using theMS-Word application program or theMS-PowerPoint application
program.

MS-Excel reports are particularly useful for users who want to analyze the data and
measurement results gained in the image analysis program further in MS-Excel.

Creating anMS-Excel report that contains an image andmeasurement results
Editing the data in anMS-Excel report
Displaying the contents of an additional worksheet in anMS-Excel report

Creating an MS-Excel report that contains an image and
measurement results

Example: Let’s say that you want to makemeasurements on theSeal.tif example
image and to output themeasurement results together with the image into a simple
MS-Excel report. TheMS-Excel report will be created using the predefined "1 Image 1
Table.xltx” Excel template.

To do so, proceed as follows:

1. Load theSeal.tif example image.
2. Switch to theProcessing layout andmake ameasurement on the image. You can

measure the diameter of a circle and the area of the rectangle, for example.
l Themeasurement results will be shown in theMeasurement and ROI tool
window.

3. Save the image. Unsaved images cannot be inserted into a report.
4. Click theCreate Excel Report button, located in theMeasurement and ROI tool

window's toolbar.
Note: This toolbar also has a button calledExport to Excel. This button saves the
measurement results, but not the image, straight away to anMS-Excel file. But
because these step-by-step instructions are for creating anMS-Excel report that uses
a default Excel template, theExport to Excel button is not relevant for this example.

l TheCreate Excel Report dialog box opens. All of the Excel templates in the
directory that is currently selected in thePath field are displayed in the left-hand
part of this dialog box. By default, the right-hand part displays the current image
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along with one or more tables with the current measurement results from this
image.

Note: If you changed the default settings, all of the imageswith measurements that are
open in the document group can be displayed in the right-hand part of the dialog box.
In this case, youmust first select the images and documents that you want theMS-
Excel report to contain.

5. For this example, select the default Excel template "1 Image 1 Table.xltx" from the
left-hand part of the dialog box. Select theSeal.tif image and its associated table
with themeasurement results from the right-hand part of the dialog box.

6. If theUse only data of selected images in tables check box is displayed, leave it
clear for this example. This check box is only relevant when you want to output the
results of ameasurement onmore than one image to a singleMS-Excel sheet.

7. Click theOK button.
l TheMS-Excel application program opens. TheMS-Excel report is displayed.

l The table with themeasurement results is inserted into theMS-Excel
document aswhat is known as an Excel sheet. Excel sheets enable you to
manage the data that they contain independently of all of the other data in the
worksheet.

8. If required, you can change the width of the columns or the height of the rows in
the Excel sheet. You can also hide rows or columns. You can do this usingMS-
Excel’s standard functions.

9. Save theMS-Excel report.

Editing the data in an MS-Excel report
TheOlympusMS-Office add-in gives you different ways of editing the report. For
example, you can edit the image properties, change the image resolution, or insert a
detail zoom.

In addition, you can analyze the data in the Excel sheet using all of MS-Excel’s
functions. You can findmore information about this in theMS-Excel documentation.

Technical restrictions when using the Olympus MS-Office add-in in MS-
Excel
Please note the following two technical restrictionswhen you use theOlympusMS-
Office add-in to edit anMS-Excel report.

Note: MS-Excel’sUndo andRedo functions cannot be used for all of the OlympusMS-
Office add-in’s commands. These buttons therefore become inactive as soon as you
use any of the OlympusMS-Office add-in commands.

Note: Cutting and pasting or copying data only works properly within the same
worksheet. Therefore, don’t copy data from oneMS-Excel worksheet to another
worksheet (or from oneMS-Excel workbook to another workbook).
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Displaying the contents of an additional worksheet in an MS-Excel
report

Example: You havemademeasurements on an image in your software and have
created a workbook that has two worksheets. The first worksheet contains a summary
of themeasurement results and the second worksheet contains the individual results
for all of themeasurements. You now want to change an existingMS-Excel report so
that the content of the second worksheet is shown aswell.

To do so, proceed as follows:

1. Open theMS-Excel report that contains the image with measurements on it and
an Excel sheet that displays the contents of the first worksheet.

2. Use the Insert Table Placeholder command to insert a second table placeholder.
You can find this command in the Templates group on theOlympus tab.

3. In the Insert Document dialog box, select the workbook and click theReplace
button.Workbooks have theOWB file format.
l Theworkbook is inserted into theMS-Excel report as an Excel sheet. The
contents of the first worksheet is displayed again.

4. Place the cursor anywhere in the second Excel sheet and open the Table
Properties dialog box. To do this, click the Table Properties button. This button is
on theOlympus tab.

5. Set the value in theSelect the worksheet to be displayed field to 2.
l The contents of the second worksheet is now displayed in the second Excel
sheet.

l The report now contains the image with measurements on it and two Excel
sheets. The first Excel sheet shows the summary of themeasurement results
and the second Excel sheet shows the individual results for all of the
measurements.

00414 29062017

11.4. Editing a report
There are several options for editing reports that contain images and data from your
image analysis program. To do so, use the add-in fromOlympus.

This add-in always offers the same functionality, nomatter whether you use theMS-
Word, MS-Excel, or MS-PowerPoint application program for editing the report.

Activate theOlympus tab to view all of the buttons that you can use when working with
reports.

Changing the image properties
Adjusting documents
Changing image resolution
Update Placeholders
Inserting a document
Inserting a field
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Considerations for users who created the MS-Word report using the
"Report Composer" tool window
If you want to make some changes to a report you created using theReport Composer
tool window, before doing so, you should decide whether it will be better to make the
changes in the report (i.e., in MS-Word) or in the report instruction (i.e., in your
software).

Often, it is advisable to change the report instruction first and then create a new report.
Changes youmake in the report instruction are valid for every subsequent report that
you create with this report instruction. There are numerous changes that you can
anyway, onlymake in the report instruction, for example, the selection of other page
templates. However, changes that youmake in a report are only valid for that
particular report.

Changing the image properties
When images are transferred to a report, the image link is transferred aswell. This
makes it possible to change the image display in a report (for example, to scroll the
image segment).

1. Double click the image in the report to open the Image Properties dialog box.
2. In theDisplay group, select the check boxes for the elements that you want the

report to contain. The following elements are there to choose from:Scale bar if
calibrated,Color bar if available, Info stamp andBorder.
l The properties of these elements can be defined in theOptions > Image
Information dialog box. Click theOptions button to open this dialog box.

3. In theSize group, select one of the options that specify how large the image is to
be displayed in the report.

4. If your settings should apply for all future images, click theSet asDefault button.
5. Click theOK button.

l The Image Properties dialog box closes. The changed image properties will be
shown in the report now.

Adjusting documents
In the report, you can select a document of the "image" or "chart" type and select the
Adjust Document button on theOlympus tab. You will then change over to the image
analysis software, where you can edit the document and then automatically change
back to the report.

Example: You are editing a report that contains a lot of images in theMS-Word, MS-
Excel, or MS-PowerPoint application program.With a certain image you notice that an
important measurement ismissing.With theAdjust Document button, you switch over
to the image analysis software, add themissingmeasurement and then switch back to
MS-Word, MS-Excel, or MS-PowerPoint in order to continue editing the report.

Adjusting an image
1. Open the report and select the image that you want to adjust.
2. On theOlympus tab, click theAdjust Document button.
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l You switch to the image analysis software. If it was closed, it will be started and
displayed in the foreground.

l The image that you want to adjust is also opened. In case it is from a database
that is currently closed, the database will be opened in the background.

Note: The image analysis software is now in a special "adjust-document" mode. In this
mode, you can onlymake certain adjustments to the image. This is why a lot of other
functions are hidden.

3. Make the required change.
4. If the image information was changed: Save the image in the image analysis

software.
l Some changesmade to an image don't have to be saved, e.g., when you select
another frame in amulti-dimensional image. Other changes have to be saved,
e.g., adding ameasurement. The fact that a change has to be saved will be
indicated by an asterisk shown behind the file name in the document group.

5. Click theUpdate Report button. You find this button in theAdjust Document
message box that is shown in the foreground.

l MS-Word, MS-Excel or MS-PowerPoint will now be shown in the foreground
again. The edited image will be displayed. You can now continue to edit the
report.

l If your image analysis software was closed before you clicked theAdjust
Document button, it is closed again. If any images or databases had to be
opened for this command, theywill be closed aswell.

Editing a workbook

Editing a workbook in MS-Word or MS-PowerPoint
Your software supports the handling of workbooks. A workbook is created, for
example, when you open theMeasurement and ROI tool window and export a results
sheet.

Note: If you want to use workbooks inMS-Word or MS-PowerPoint reports, MS-Excel
must be installed on your PC. You requireMicrosoft Excel 2010, 2013, 2016, 2019 or
the Office 365 Excel Desktop app.

Apart from the Image andChart document type, reports can also contain workbooks.
A workbook is imported as anMS-Excel object into MS-Word or MS-PowerPoint. You
can further edit it in the report.

1. In the report, double click on the workbook.
l Youwill change into the edit mode. You can recognize it by the fact that now
the column headers and the row numbers are shown. In edit mode, you also
can see all worksheets, if several worksheets are available.
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2. If need be, select the worksheet that you want to edit.
3. Make the required change.

l When you want to format individual cells differently, select the cell and use the
Format Cells command in the context menu.

l When you want to format the complete worksheet differently, (e.g., other font
or other background color), select the complete worksheet (e.g., with the
keyboard shortcut [Ctrl + A]), then select the Format Cells command in the
context menu.

l When you want to hide a column, click on the column's header, then select the
Hide command in the context menu.

4. Exit edit mode by clicking on any point in the report, outside the workbook.

Editing a workbook in an MS-Excel report
You can also insert the sameworkbook that you have created in your image analysis
program into anMS-Excel report instead of anMS-Word or anMS-PowerPoint
report.
If the sameworksheet is selected, the same data is displayed inMS-Excel and inMS-
Word or MS-PowerPoint. Because the data is inserted intoMS-Excel as what is called
an Excel sheet (and not as a linkedMS-Excel object like in MS-Word or MS-
PowerPoint), significantlymore functions for filtering, sorting, laying out, and analyzing
the data in the sheet are available in MS-Excel.

For this reason, MS-Excel reports are particularly useful for users who want to analyze
the data andmeasurement results gained in the image analysis program further in
MS-Excel.

Changing image resolution
By default, all images in a report are transferred to reports with a resolution of 192 dpi.
In certain cases, it canmake sense to change the resolution of individual or all images
in a report For example, if you want to print the report, you can raise the resolution.
Alternatively, if you want to publish the report on the Internet, you can reduce the
resolution.

1. Open the report in MS-Word, MS-Excel or MS-PowerPoint. Decide whether you
want to change the resolution of all images or just certain images

2. If you only want to change the resolution of one individual image, select that
image. If you want to change the resolution of all images, you don't have to select
any.

3. On theOlympus tab, click theChange Image Resolution button.
l TheChange Image Resolution dialog box opens.

4. Select the option you want in theApply to group. You can choose between
Selected images andAll images in report.
l TheSelected images option is inactive if no imageswere selected when the
button was clicked.

5. Specify in the Image Resolution group how you want to change the image
resolution. If you choose theUser-defined option, you can enter any resolution of
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your choice between 96 and 600 dpi into theDPI field.
6. Click theOK button to change the image resolution.
7. Checkwhether you are satisfied with the changed image resolution. If not, change

the image resolution anew.
l You can first reduce the image resolution, then save the report and then
increase the image resolution again. This is possible because each time that
you click theChange Image Resolution button, the image is transferred from
your software toMS-Word or MS-PowerPoint again.

8. Once you are satisfied with the changes to the image resolution, save the report.
Take a look at the new file size in theWindowsExplorer.

Updating placeholders
TheUpdate Placeholder buttonmakes it easy to have any changesmade to the
images after the report has been created also shown in the report. Please note that all
the changesmade in your software have to be saved if they are to be displayed when
theUpdate Placeholder button is clicked.

Example: In MS-Word, MS-Excel, or MS-PowerPoint, you open a report that you
created some time ago. In themeantime, you had changed a lot of images in your
image analysis software (e.g., addedmeasurements). Now, the report is to be
updated so that it shows the newest version of all of the images.

1. If you only want to update one placeholder, select just that one.
2. On theOlympus tab, click theUpdate Placeholder button.

l TheUpdate Placeholders dialog box opens.

3. In theUpdate Placeholders dialog box, specify whether or not all placeholders
should be updated.

4. Select theUpdate fields linked with placeholder(s) check box if your report
contains fields which should also be updated.

5. Click theOK button.
l The placeholders will be updated.

Inserting a document
You can insert a document at any position in a report. If you have, for example, created
a report using theReport Composer tool window, and while you are viewing it, notice
that you've forgotten an image, you can retroactively insert it into the report.

1. Position themouse pointer on the location in the report where you want to insert a
document.

2. On theOlympus tab, click the Insert Document button.
l The Insert Document dialog box opens.

3. In the area on the left, select the source the document comes from. You have the
following possibilities:
l Select theOpenDocuments entry if you want to insert a document that is
currently opened in your software.
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l Select theDatabase entry if you want to insert a document that is part of the
currently selected database folder. For this purpose, the databasemust be
opened in your software. Should you work with a version of the software that
doesn't support databases, theDatabase entry is hidden.

l Select the File Explorer entry if you want to insert a document that is stored on
your PC or in your network.

4. Select the required document in the document preview. Click the Insert button.
l The required document will be inserted into the report.

l The Insert Document dialog box remains open.

5. Insert further documents now or close the dialog box.
l The path of all documents that you inserted will be saved. That enables you to
later update the inserted documents by using theUpdate Placeholder button
(in case the documents were changed after they have been inserted into the
report).

Inserting a field
You can insert a field into a report that describes the image inmore detail. All of the
values that have been saved in your image analysis software for this image can be
displayed in this field.

1. Select the image in the report to which you want to insert a field.
2. On theOlympus tab, click the Insert Field button.

l The Insert Field dialog box opens.

l In thePlaceholder list, the name of the image into which you want to insert a
field appears.

3. In theAvailable fields list, select the field that is to be inserted. The entries in this
list are arranged hierarchically. Click the plus sign to expand the list.
l Two types of field are available.
TheDocument Properties list contains fields that are, by default, in your
software, managed for this document type.
TheDatabase fields list contains all of the fields that are available in the
database for the selected placeholder. For this purpose, a databasemust have
been opened.

4. Keep the Insert Field dialog box open. Position themouse pointer on the location
in the report where you want to insert the field.

5. In the Insert Field dialog box, click the Insert button.
l The field contents will be displayed in the report.

6. If necessary, add further fields. To do this, repeat the last 3 steps.
7. Close the Insert Field dialog box.
8. Save the report.
Note: Should you want to have the contents of a specific field regularly shown in your
reports, you can already insert this field, (that is to say a placeholder for this field) into
the page or slide template. Then this field will be automatically filled out in every report.
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11.5. Creating and editing a new template
Creating a template and adding a placeholder for a document
Adjusting the insertion order
Inserting a placeholder for a field
During the installation of your image analysis software, some predefined templates
were installed too. In addition to this, you can define your own templates too.

WithMS-Word reports, you definePage Templates in the DOC or DOCX file format.
With MS-Excel reports, you defineExcel templates in the XLTX file format.
With MS-PowerPoint reports, you defineSlide Templates in the PPT or PPTX file
format.

Note: You can also create a template from an existing report that suits your
requirements. To do this, place themouse pointer in each document in the report and
select theRemove Document fromPlaceholder command. Then save the file under a
different name and, if required, in a different file format.

The contents of a template
In a template, placeholders are set up for the documents that the report is to contain.
There are placeholders for images, charts, fields and workbooks (for MS-Word
reports andMS-PowerPoint reports) or tables (for MS-Excel reports). If, for instance,
you want the report to contain pages that have an image at the top and a chart below
the image, you should set up a template which has a placeholder for an image and a
placeholder for a chart.

Note: For technical reasons, a templatemust consist of precisely one page. For this
reason, create several separate files if you require several self-defined template
pages.

Creating a template and adding a placeholder for a document
Note: The procedure for creating a template is largely the same, regardless of whether
you are creating a page template, an Excel template, or a slide template. For this
reason, you can carry out these step-by-step instructionswith either MS-Word, MS-
Excel, or MS-PowerPoint open.

1. In theMS-Word, MS-Excel, or MS-PowerPoint application program, select the
File tab and select theNew entry.

2. Select theBlank document option (MS-Word),Blankworkbook option (MS-Excel)
or Blank Presentation option (MS-PowerPoint).

3. Activate theOlympus tab.
4. Decide whether to insert an image placeholder, a chart, or a workbook (for MS-

Word reports andMS-PowerPoint reports) or a table (for MS-Excel reports). On
theOlympus tab, click one of these buttons: Insert Image Placeholder, Insert
Chart Placeholder, Insert Workbook Placeholder, Insert Table Placeholder.
These buttons are part of the Templates group.
l The placeholder you've selected will be inserted.
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5. If necessary, you can change the size of the placeholder. To do so, grab a handle
with themouse and drag it in the required direction. The length/width ratio
remains unchanged, so that the objects won't be distorted by this action.

6. Double click a placeholder for an image, to change the default settings for its
appearance.

7. If required, insert additional placeholders for images, charts, tables, or workbooks.
Make sure that your template isn't longer than a page.

8. If you want to, you can insert a placeholder for a field. Additional information about
a placeholder can be shown in this field, for example, the name, or the date it was
set up. You will find additional information on inserting placeholders for fields
further down.

9. Save your template under a descriptive name. If you want to view a thumbnail of
the template tomake it easier to select the right template, activate the thumbnail
preview. The procedure for activating the thumbnail preview is a little different for
different file types. For this reason it's best if you look up the precise procedure in
the online help for theMicrosoft Office package.
For MS-Word reports andMS-PowerPoint reports: As a storage location, select
the same directory that is set for your user templates or workgroup template in the
software.
For MS-Excel reports: You can save the file anywhere you want. If you want to
create a report later on that is based on your new template, open the Templates
Locations dialog box from theCreate Report from Template dialog box and
navigate to this storage location.

10. Close the file.

Adjusting the insertion order
The placeholders are numbered in the order in which theywere inserted. Should you
have initially set up placeholders for two images, have then decided to put a
placeholder for a chart right at the top of the page, the insertion order would be that
shown in the example on the left.

1. In this case, click theAdjust Insertion Order button on theOlympus tab, to have
the insertion order numbered serially from top to bottom (see example).
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Inserting a placeholder for a field
1. In the template, select the placeholder into which you want to insert a field.
2. On theOlympus tab, click the Insert Field Placeholder button. You can find this

button in the Templates group.
l The Insert Field dialog box opens.

l In thePlaceholder list, the name of the placeholder into which you want to
insert a field appears.

3. In theAvailable fields list, select the field that is to be inserted. The entries in this
list are arranged hierarchically. Click the plus sign to expand the list.
l Two types of field are available.
TheDocument Properties list contains fields that are, by default, in your
software, managed for this document type.
TheDatabase fields list contains all of the fields that are available in the
database for the selected placeholder. For this purpose, a databasemust have
been opened.

4. Keep the Insert Field dialog box open. Position themouse pointer on the location
in the report where you want to insert the field.

5. In the Insert Field dialog box, click the Insert button.
l The placeholder for a field will then be displayed. You can recognize it by the
curly bracket, and by the field name shown.

6. If necessary, add placeholders for further fields. To do this, repeat the last 3 steps.
7. Close the Insert Field dialog box.
8. Save the template.

00402 04032019

OLYMPUS Stream UserManual 304




	1.  Before you start
	1.1.   Which documentation comes along with your software?
	1.2.   Online help for your software
	1.3.   About your software

	2.   User interface
	2.1.   Overview - Layouts
	2.2.   Document group
	2.3.   Tool Windows
	2.4.   Working with documents

	3.  System configuration
	3.1.   Overview - System Configuration
	3.2.   Configuring the system

	4.  Image Acquisition
	4.1.   Overview - Acquisition processes
	4.2.   Acquiring a snapshot
	4.3.   Acquiring HDR images
	4.4.   Acquiring an image without halation
	4.5.   Acquiring movies and time stacks
	4.6.   Acquiring Z-stacks
	4.7.   Acquiring an EFI image
	4.8.   Creating stitched images

	5.  Image processing
	5.1.   Commenting on images
	5.2.   Processing images

	6.  Analyzing images using deep learning
	6.1.   Working with deep learning

	7.  Interactive measurements
	7.1.   Overview
	7.2.   Measuring images
	7.3.   Measuring welds

	8.  Images containing height information
	8.1.   Creating an EFI image and a height map from a Z-stack
	8.2.   Creating a height map while acquiring an EFI image
	8.3.   Displaying a height map in the image window
	8.4.   Creating the 3D-surface
	8.5.   Changing the appearance of the 3D-surface
	8.6.   Creating an image of the 3D-surface
	8.7.   Creating and measuring height profiles
	8.8.   Measuring heights interactively

	9.  Materials Science Analysis
	9.1.   Tool Window - Materials Solutions
	9.2.   Chart Comparison
	9.3.   Intercept Analysis
	9.4.   Grains Planimetric
	9.5.   Layer Thickness Measurement
	9.6.   Cast Iron analysis
	9.7.   Non-metallic inclusions
	9.8.   Throwing Power Measurement
	9.9.   Porosity Measurement
	9.10.   Phase Analysis
	9.11.   Particle Distribution
	9.12.   Automatic Measurement
	9.13.   Coating Thickness
	9.14.   Dendrite Arm Spacing

	10.  Counting and measuring objects
	10.1.   Overview
	10.2.   Carrying out an automatic image analysis
	10.3.   Carrying out an automatic image analysis on ROIs
	10.4.   Editing objects
	10.5.   Enhancing the segmentation

	11.  Reports
	11.1.   Overview
	11.2.   Working with the report composer
	11.3.   Working with the Olympus MS-Office add-in
	11.4.   Editing a report
	11.5.   Creating and editing a new template


